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Areas Covered

Before Reading This Manual

This section explains the notes for your safety and conventions used in this manual. Make sure to read this 

section.

Chapter 1 Overview

This chapter explains component names and basic operations of this server, as well as an 

overview of the software provided with this server. In addition, the workflow, from placing 

the server to starting the operation, is also described.

Chapter 2 Checking before OS Installation

This chapter explains the preparation on the server and cautions necessary before OS 

installation. Please read this chapter before starting installation.

Chapter 3 OS Installation Using ServerStart

This chapter explains how to install the OS in the server using ServerStart.

Chapter 4 Manual OS Installation

This chapter explains how to install the OS in the server without using ServerStart.

Chapter 5 Operations after OS Installation

This chapter explains the operations to be performed after OS installation. Be sure to perform 

those operations before operating the server.

Chapter 6 High Reliability Tools

For stable PRIMERGY server operations, we recommend that high reliability tools be 

installed. This chapter explains the installation and necessary settings of high reliability tools.

Chapter 7 Installing Internal Options

This chapter explains how to install internal options on this server.

Chapter 8 Hardware Configuration/Utilities

This chapter explains how to make the environment settings necessary to operate the server.

Chapter 9 Operation and Maintenance

This chapter explains the operations necessary after starting to use this server as well as daily 

care and maintenance.

Appendix
This appendix explains the specifications for the server and internal options. It also covers 

how to recycle the products. 
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Before Reading This Manual

■ Trademarks

VGA and PS/2 are registered trademarks of IBM Corporation.
Intel, Pentium, and Celeron are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the USA                 
and other countries.
Microsoft, Windows, Windows NT, and Windows Server are trademarks or registered trademarks of Microsoft             
Corporation in the USA and other countries.
Linux is a trademark or registered trademark of Linus Torvalds in the USA and other countries.
Red Hat and all Red Hat-based trademarks and logos are trademarks or registered trademarks of Red Hat, Inc. in the                   
USA and other countries.
Other product names used are trademarks or registered trademarks of their respective manufacturers.
Other products are copyrights of their respective manufacturers.

All Rights Reserved, Copyright© FUJITSU LIMITED 2005

Screen shot(s) reprinted with permission from Microsoft Corporation.

For Your Safety...

This manual contains important information, required to operate the server safely.

Thoroughly review the information in this manual before using the server. Especially note the points under "Safety Precautions," and only                   

operate the server with a complete understanding of the material provided.

This manual and "Safety Precautions" should be kept in an easy-to-access location for quick reference when using this server.

Data Backup

To protect data stored in this device (including basic software such as the operating system and application software), perform backup and                    

other necessary operations. Note that data protection is not guaranteed when repairs are performed. It is the customer's responsibility to                   

maintain backup copies in advance.

In case of data loss, Fujitsu assumes no liability for data maintenance or restoration and damages that occur as a result of the data loss for any                          

reason, except for items covered under warranty.

High Safety

The Products are designed, developed and manufactured as contemplated or general use, including without limitation, general office use,                 

personal use, household use, and ordinary industrial use, but are not designed, developed and manufactured as contemplated for use                  

accompanying fatal risks or dangers that, unless extremely high safety is secured, could lead directly to death, personal injury, severe physical                    

damage, or other loss (hereinafter "High Safety Required Use"), including without limitation, nuclear reaction control in nuclear facility,                 

aircraft flight control, air traffic control, mass transport control, medical life support system, missile launch control in weapon system. You                   

shall not use this Product without securing the sufficient safety required for the High Safety Required Use. If you wish to use this Product for                        

High Safety Required Use, please consult with our sales representatives in charge before such use.

Problems may occur with this device in the event of an instantaneous voltage drop of the power supply due to lightning, etc. To prevent an                        

instantaneous voltage drop of the power supply, we recommend that you use an uninterruptible power supply system.
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Remarks

■ Warning Descriptions

Various symbols are used throughout this manual. These are used to emphasize important points for your 

safety and that of others. The following are the symbols and their meanings:

The following symbols are used to indicate the type of warning or caution being described.

■ Symbols

Symbols used in this manual have the following meanings:

■ Key Descriptions / Operations

Keys are represented throughout this manual in the following manner:

E.g.: [Ctrl] key, [Enter] key, [→] key, etc.

The following indicate pressing several keys at once:

E.g.: [Ctrl] + [F3] key, [Shift] + [↑] key, etc.

■ Entering Commands (Keys)

Command entries are displayed in the following way: 

• In the areas of the "↑" mark, press the [Space] key once.
• When the operating system is Windows, commands are not case sensitive.

• CD-ROM drive names are shown as [CD-ROM drive]. Enter your drive name according to your 

environment.

[CD-ROM drive]:\setup.exe

Ignoring this symbol could be potentially lethal.

Ignoring this symbol may lead to physical injury and/or damage the server or hardware options.

The triangle mark emphasizes the urgency of the WARNING and CAUTION. Details are 

detailed inside the triangle and above it.

A barred circle ( ) warns against certain actions (Do Not). These actions are detailed inside 

the circle and above it.

A black circle indicates actions that must be taken. These actions are detailed inside the black 

circle and above it.

These sections explain prohibited actions and points to note when using this device. Make 

sure to read these sections.

These sections explain information needed to operate the hardware and software properly. 

Make sure to read these sections.

→ This mark indicates reference pages or manuals.



4

■ Screen Shots and Figures

Screen shots and figures are used as visual aids throughout this manual. Windows, screens, and file 

names may vary depending on the OS, software, or configuration of the server used. Figures in this 

manual may not show cables that are actually connected for convenience of explanation.

■ Consecutive Operations

Consecutive operations are described by connecting them with arrows (→).

■ Abbreviations

The following expressions and abbreviations are used throughout this manual.

■ Server Types

Server types are described as follows.

Example: Procedure of clicking the [Start] button, pointing to [Programs], and clicking [Accessories]

↓
Click [Start] → [Programs] → [Accessories].

table: Abbreviations of Product Names

Product name Expressions and abbreviations

PRIMERGY RX100 S2 This server or the server

Microsoft® Windows Server™ 2003, Standard Edition Windows Server 2003, Standard Edition 

or Windows Server 2003

Windows

Microsoft® Windows® 2000 Server Windows 2000 Server

Microsoft® Windows® Preinstallation Environment Windows PE

Microsoft® Windows® XP Professional Windows XP Professional

Microsoft® Windows® 2000 Professional Windows 2000 Professional

Microsoft® Windows NT® Workstation Operating 

System 4.0
Windows NT

Microsoft® Windows NT® Server Network Operating 

System Version 4.0
Windows NT Server 4.0

Microsoft® Windows NT® Server, Enterprise Edition 

4.0

Red Hat® Enterprise Linux® ES (v.3 for x86) Linux

Microsoft® Windows® 2000 Service Pack 4 Windows 2000 Service Pack 4
Service 

Pack
Microsoft® Windows Server™ 2003, Service Pack 1 Windows Server 2003 Service Pack 1

table: Server Types

Type Expressions and abbreviations

Servers without an internal hard disk unit Diskless type
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Reference Information

■ Software Manuals

Software Manual contains other reference information and cautions for ServerStart not described in this 

manual. Please read it before using ServerStart.

Software Manual is contained as a "README.TXT" file in the root directory on the ServerStart CD-

ROM. Use a text editor to read it.

■ Latest Information about Software Provided with This Server

For the latest information regarding ServerStart and other software provided with this server, refer to the 

Fujitsu PRIMERGY website (http://primergy.fujitsu.com). 

Warning and Caution Labels

Warning and caution labels are found on the server.

Do not remove or stain these labels.

http://primergy.fujitsu.com
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Chapter 1 

Overview

This chapter explains an overview of the system 

hardware and software. In addition, the workflow, 

from placing the server to starting the operation, 

is also described.

1.1 RX100 S2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

1.2 Supplied Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

1.3 Component Names and Functions . . . . . . . . . . . . . . . . . . 22

1.4 Standard Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

1.5 Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
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1.1 RX100 S2

This server has the following features. 

■ High Reliability

● Disk Array System Configuration

A disk array system (RAID 0/1) can be configured using an optional RAID card.

● Hardware and Software Designed for Data Security

The locks on the rack and security (password) setting in the BIOS Setup Utility protect hardware and 

data assets in the server against theft, ensuring data security with high reliability. 

● Proactive Fan Function

When a fan fails or the ambient temperature rises, the system fan speed is increased automatically to 

avoid increase in temperature in the server, ensuring stable server operation.

● High Reliability Tools

High reliability tools offer stable system operation. For information about high reliability tools, refer to 

"1.2.2 High Reliability Tools" (�pg.19).

■ High-speed Processing

● Intel® Pentium® 4 processor or Intel® Celeron® D processor has been 
installed.

An Intel® Pentium® 4 processor or an Intel ® Celeron® D processor has been installed to allow high-

speed data processing.

● High-speed Bus Clocks

The server uses the PC3200-compliant memory and PCI buses with a maximum data transfer speed of 

533MB/sec.

● Ultra320 SCSI/Ultra160 SCSI

The Ultra 320 SCSI-compliant RAID card or the Ultra 160 SCSI-compliant SCSI card is installed to 

allow high-speed data transfer.

■ Compact Design and Scalability

● Space Saving 1U Design

This server is slim, with a thickness of 1U. The server, display device, keyboard, and external SCSI 

options fit in a 19-inch rack, which saves the installation space.
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● Maximum Memory Size of 4GB

In addition to the preinstalled 256MB memory, the system supports up to 4GB memory.

● Maximum Hard Disk Size of 293.6GB

Up to two internal hard disk units can be installed in the 3.5-inch storage bays. The hard disk size can be 

increased up to 293.6GB.

● Internal CD-ROM Drive Unit

One optional CD-ROM drive unit can be installed on the server.

● Two PCI Slots

The server has two 64-bit, 66MHz PCI slots.
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1.2 Supplied Software

ServerStart for supporting setup and high reliability tools for avoiding problems during 

server operation are supplied with this server.

1.2.1 Setup Support Tool - ServerStart

ServerStart is a setup support tool that helps to install PRIMERGY. 
It offers easy server installation and proper installation of recommended drivers.

■ Installing ServerStart

The following outlines the ServerStart installation.

User definition, access privileges, network settings

Install

ServerStart

Auto setup

Installing ServerStart

Not using ServerStart

Using ServerStart

&
Setup

It is necessary to input successively for installation, 
resulting in more mistakes and longer time

Example:
Operations such as setting IP address, 
creating users, and registering computer 
name are required

Auto installation of recommended drivers (SCSI, LAN, 
etc.) enables high reliable installation
High reliability tools can be installed 
automatically *1

Example:
Operations during OS installation is automated *2

High reliability tools are software with comprehensive strength for stable 
system operation of the server management

Some input (License window, etc.) and media repositioning are excluded

*1

*2

Complicated hardware configuration (RAID configuration, etc.)

Automatic RAID configuration is possible
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● Configuration File (SerStartBatch.ini)

A configuration file stores the server setup and client information configured in ServerStart. To create a 

configuration file, use the ServerStart floppy disk supplied with this server. Store only one file on each 

floppy disk. Do not set the ServerStart floppy disk to the write-protected state.

You can use any name for the configuration file. However, the file must be installed in the server as 

"SerStartBatch.ini". When installing the file, make sure to save it as "SerStartBatch.ini" on the 

ServerStart floppy disk.

Start up ServerStart, insert the ServerStart floppy disk containing "SerStartBatch.ini", and click [Start] to 

install the server.

■ Intuitive User Interface

The intuitive user interface allows you to easily set the necessary information.

● Main Window

When ServerStart is started, the following window appears. The window and tool bar differ depending 

on the mode.
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● Toolbar

In Guided Mode / Expert Mode

� While the wizard is running, do not click the  icons on the tool bar to move to the previous or 

next window. To move to a different window, click the [Previous], [Up], or [Next] button at the bottom of 

the wizard window.

● Wizard Window

Clicking a wizard displays a wizard window.

Set items in the wizard window. To move to a step in the next wizard window, click the operation button 

at the bottom of the window. Clicking [help] displays a tip for setting the item.

■ Network Configuration

ServerStart can configure a network at server installation. 
For details on available network patterns, refer to "Using ServerStart to configure the Network".

Brings you to 
the next page.

Brings you up
one tier.

Brings you to 
the main screen.

Ends ServerStart. Changes the size 
of icons.

Brings you to 
the previous page.

Resets the status 
function.

ON/OFF of the tree display is set.
It doesn't support, and never click.
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■ Automatic Driver Installation

Recommended drivers for automatically recognized expansion cards are installed with the server. This 

prevents possible mistakes in driver installation, such as installation of an older version or drivers which 

were not supplied with this server.

■ Automatic RAID Configuration

When a RAID card is used, specify the RAID type and the number of hard disk units before starting 

installation. A disk array can be configured without starting the RAID utility.

■ Remote Installation

ServerStart can store resources necessary for installation, such as the OS and Service Pack, in a different 

server on the network and install the OS via the network. This method is used when the server does not 

have a CD-ROM or floppy disk drive.

SystemcastWizard Professional (optional) is a useful tool for extracting a lot of files in a short time.

1.2.2 High Reliability Tools

High reliability tools are a comprehensively useful set of software for stable system operations of the 

server. The following tools have respective roles to manage normal operations or recovery from errors:

• Server Monitoring Tools

• System Diagnosis Support Tools

• LAN driver Advanced Setting Tools

■ Server Monitoring Tools

The server monitoring tools monitor the hardware status on behalf of the administrator and notify him/

her in the event of an error.

● Detecting a Server Failure Early [ServerView]

ServerView is software to monitor that the server hardware is in a normal state to protect important 

server resources. When using ServerView, the server hardware is monitored all the time. If an error that 

could cause trouble is detected, the administrator is notified in real-time. This allows the server 

administrator to remove a system error early and avoid trouble.

● Detecting a Disk Failure Early [RAID Management Tool]

RAID Management Tool is software that monitors the disk array. RAID Management Tool runs as a 

Windows Server 2003/Windows 2000 Server system service. When an event occurs, it leaves an event 

log in the event viewer's application logs. At the same time, a pop-up window indicates a hard disk 

failure, rebuild status, etc.
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■ System Diagnosis Support Tools

The system diagnosis support tool is for supporting system diagnosis during normal operation or in the 

event of trouble.

● Solving Problems Early [DSNAP]

DSNAP is a command line utility that collects all the failure investigation information. System file 

configuration information, major registry settings, and event logs can be collected easily from the 

command line. 
DSNAP is used to allow maintenance personnel to understand your system software configuration and 

settings correctly and ensure smooth investigations when a problem occurs in your Windows Server 

2003/Windows 2000 Server system. Pass the information along with memory dumps to your 

maintenance personnel.

■ LAN Driver Advanced Setup Tools

LAN Driver Advanced Setup Tool sets details on the LAN, including the use of the Teaming function 

and VLAN configuration.

● Intel®  PROSet

Intel® PROSet is a tool for setting details on the LAN card when it is used with another LAN card or the 

onboard LAN for using the Teaming function or when it is used for configuring a VLAN. 
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1.2.3 Installing High Reliability Tools

You can install all high reliability tools provided with PRIMERGY by specifying them in "Application 

Wizard" when the OS is installed with ServerStart.

The following high reliability tools are installed.

A: Installed in any case

S: Installed if selected

*1: Not installed if no RAID controller has been installed.

� Linux does not support batch installation with ServerStart.

� When the high reliability tools are installed at once with ServerStart: 

ServerView must be configured after installation. Refer to "Chapter 6 High Reliability Tools" (�pg.155).

In case where the operating system has been installed with ServerStart, if a high reliability tool is not 

installed or the OS has been manually installed, use a standard installer for each tool. For the installation 

procedure with the standard installers, refer to "Chapter 6 High Reliability Tools" (�pg.155).

table: High reliability tool installation

High Reliability Tools Batch installation with ServerStart

RAID Management Tool A*1

ServerView S

DSNAP S

Intel® PROSet A
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1.3 Component Names and Functions

This section explains the component names and functions of the server.

1.3.1 Server (Front View)

a Internal CD-ROM drive unit (optional)

Reads data or programs from a CD-ROM.

b Floppy disk drive unit

Writes/reads data to/from a floppy disk.

c 3.5-inch storage bay

Contains an internal hard disk unit. This server can have up to two internal hard disk units.

d USB connector ( )

Connects peripheral equipment conforming to the USB standard (2.0 or 1.1).

e Reset switch ( )

Pressing this switch resets and restarts the system. 

� Do not reset when the hard disk access LED is lit. Data in the hard disk may be damaged.

f System identification LED button ( )

When pressing this button, the front and rear system identification LEDs are lit blue so that the 

locations of devices being maintained can be determined.

g Power switch ( )

� Do not turn the server off when the hard disk access display LED is blinking.

Data in the hard disk may be damaged.

h Maintenance switch ( )

This switch is used only by maintenance personnel. Do not touch this.

a db c e

h

f g

i
j
k
l

RST

ID

NMI
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i System identification LED ( )

This LED is used for maintenance. When pressing this button, the front and rear system 

identification LEDs are lit blue so that the locations of devices being maintained can be 

determined. Also, the [System Identification LED Display] button of ServerView can be used to 

light them.

j Hard disk access display LED ( )

This LED lights green when data is being written to or read from the hard disk.

k Front maintenance LED ( )

This LED lights or blinks in amber when an error is detected on the server components.

If this LED lights or blinks, contact an office listed in the "Contact Information" of "Start Guide".

l Power LED ( )

This LED is lit green when the server is turned on. 

This is lit amber when the server is not turned on (standby mode).

This does not light when the power cable is unplugged from the outlet.

1.3.2 Server (Rear View)

a Inlet

AC power cables are plugged in.

b Keyboard connector (6 pin) ( )

A keyboard is plugged in. 

c Mouse connector (6 pin) ( )

A mouse is plugged in. 

d Serial port (9 pin) ( )

Cables of peripheral devices conforming to the RS-232C standard such as modems are plugged 

in. 

e Display connector (15 pin) ( )

A display cable is plugged in. 

ID

a b d

ij

c e f g h
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f LAN connector A ( )

An Unshielded Twisted Pair (UTP) cable is plugged in. For 1000Mbps connection, a cable 

conforming to category 5 enhanced is required.

As LAN connector A uses the Communication Streaming Architecture (CSA) port, its data 

transfer speed may be higher than that of LAN connector B.

The meanings of the two LED are shown in the table below.

g LAN connector B ( )

This is a PCI port. The applicable cable and meanings of the LEDs are the same as those for LAN 

connector A.

h USB connector ( )

Connects peripheral equipment conforming to the USB standard (2.0 or 1.1).

i Rear maintenance LED ( )

This LED lights or blinks in amber when an error is detected in the server components.

If this LED lights or blinks, contact an office listed in the "Contact Information" of "Start Guide".

j System identification LED ( )

This LED is used for maintenance. When pressing this button, the front and rear system 

identification LEDs are lit blue so that the locations of devices being maintained can be 

determined. Also, the [System Identification LED Display] button of ServerView can be used to 

light them.

table: LAN connector LED

LED 

location
LED status LAN Status

Left Lights green Link is being established.

Blinks green Data is being transferred. 

Off Link is not established.

Right Lights amber Connection is established at 

1000Mbps.

Lights green Connection is established at 100Mbps.

Off Connection is established at 10Mbps.

ID
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1.3.3 Server (Internal)

a System fan

Contact an office listed in the "Contact Information" of "Start Guide" for the system fan 

replacement.

b PCI slots

Expansion cards with the PCI bus interface can be installed in the PCI slots.

c CPU

One fan is installed by default on this server. 

d Memory slots

Contains memory.

a

b
c

d
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1.3.4 Baseboard

a Memory slots

b Power control connector

The power unit cable is plugged in.

c ATX power connector

The power unit cable is plugged in.

d ATX12V power connector

The ATX12V power unit connector cable is plugged in.

e Fan 6/7 connector

The system fan 6/7 cable is plugged in.

f Fan 3/4 connector

The system fan 3/4 cable is plugged in.

g Front panel connector

The front panel cable is plugged in.

h CPU socket

i Fan 1/2 connector

The system fan 1/2 cable is plugged in.

j JP2 (Fixed)

k IDE connector for CD-ROM drive

An IDE cable for the optional CD-ROM drive is plugged in.

a

e

d

b

c

m

n
o

q

g fhj ikl

p

[Rear]

[Front]
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l Floppy disk drive connector

m Power connector for CD-ROM drive

The power cable for the optional CD-ROM drive is plugged in.

n JP3 (Fixed)

o JP4 (Fixed)

p Card locking frame connector

An expansion card locking frame is installed.

q JP1

Used to clear the CMOS storage data. For more details, refer to "8.1 Jumper Pin Settings" 

(�pg.190).
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1.4 Standard Operations

This section explains standard server operations, including how to turn the server on/

off and to insert/eject a floppy disk.

1.4.1 Opening the Rack Door 

This section explains how to open the front and rear doors of the 40U standard rack. 

Refer to the manual included with the rack for procedures on opening other rack doors.

■ Opening the Front Door 

1 Turn the rack key and pull the rack handle up. 
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2 Turn the handle in the direction of the arrow and pull it forward. 

■ Opening the Rear Door 

1 Turn the rack key and pull the rack handle up. 

Turn and then pull
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2 Turn the handle in the direction of the arrow and pull it forward. 

� Unless you are inserting/removing media or turning the power on/off, keep the rack door closed. Doing 

so blocks electric waves from cell phones, etc.

� Do not lose the keys. If the key is lost, contact an office listed in the "Contact Information" of "Start 

Guide".

1.4.2 Turning On the Server

1 Open the rack door.

2 Make sure that the floppy disk drive and CD-ROM drives are empty.

• Do not move, strike, or shake the server when it is turned on. This can damage               

the hard disk in the server and cause data loss.

• Turn the server on when the temperature is in its operating environment range            

(10–35°C). For details on the operating environment, refer to "Start Guide" and           

"Safety Precautions".

When operating the device outside of this operating environment, the server          

may operate improperly, damage data etc.

Furthermore, Fujitsu cannot be held responsible for any related damage,         

malfunction, or loss of data, etc.

• The fans rotate at high speed immediately after the server is turned on, but this              

is not defective. When the temperature is in the server's operating environment           

range (10–35°C), they start to rotate at normal speed later.

• Be sure to wait for 10 seconds or longer after shutdown before turning the             

server on.

Turn and then pull
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3 Press the power switch of the monitor and peripheral devices.

4 Press the power switch on the front of the server.

The server's power LED is lit green. When the power is turned on, the server Power On Self Test 

(POST). If any abnormalities are detected by POST, error messages are displayed.

�"9.2.2 Error Messages" (pg.226)

� The time to turn off the server can be set with the ASR setting (on the [Power On/Off] tab) using 

ServerView supplied with this server. For details, refer to "3.2 Settings for Server Monitoring" in 

"ServerView User's Guide" on the PRIMERGY Document & Tool CD (Disc 2).

1.4.3 Turning Off the Server

1 Make sure that the floppy disk drive and CD-ROM drives are empty.

2 Shut down the OS. 

In the following cases, the server is turned off after the OS is shut down (Step 3 is not necessary).

• Windows OS

• When ServerView is installed

In other cases, shut down the OS and make sure that the floppy disk and hard disk access LEDs 

are off.

• In the event of smoke or sparks, immediately unplug the power cord from the             

receptacle. Failure to do so could lead to a fire or electrocution.

• When turning off the server, be sure to follow the procedures described in this             

section. Data can be lost if these procedures are not followed correctly.

• Be sure to wait for 10 seconds or longer after shutdown before turning the             

server on.

The server's 
power LED is 
lit green 

Power switch
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3 Press the power switch on the front of the server.

The server's power LED is lit amber.

4 Turn off the display and peripheral devices.

� The time to turn off the server can be set with the ASR setting (on the [Power On/Off] tab) using 

ServerView supplied with this server. For details, refer to "3.2 Settings for Server Monitoring" in 

"ServerView User's Guide" on the PRIMERGY Document & Tool CD (Disc 2).

■ Cautions for Turning the Power On/Off (for a Windows OS)

For the server power switch, you can specify the following operation modes depending by OS settings.

• For Windows Server 2003

"Do Nothing", "Prompt Input", "Standby", "Hibernation", or "Shutdown" (normally, "Shutdown" is 

specified). 

• For Windows 2000 Server

"Standby", "Hibernation", "Power Off" (Normally "Power Off")

On this server, functions corresponding to "Standby" and "Hibernation" are supported as BIOS and 

hardware functions. However, some drivers and software installed in the server do not support these 

functions. For this reason, functions corresponding to "Standby" and "Hibernation" are unavailable on 

this server.

When the operating mode is set to "Standby" or "Hibernation", the system may operate improperly or 

hard disk data may be corrupted. 

For details about operating mode settings, refer to the manual supplied with the OS.

Power switchThe server's 
power LED is 
lit amber
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1.4.4 Inserting and Ejecting a Floppy Disk

■ Cautions

When using a floppy disk, note the following points.

• Do not expose the disk to any fluids.

• Do not open the shutter of the floppy disk and touch the disk surface.

• Do not bend the floppy disk or place heavy objects on it.

• Do not expose the floppy disk to strong magnetic fields.

• Do not drop the floppy disk on hard surfaces.

• Do not store the disk in extremely hot or cold conditions.

• Do not put layers of labels on the floppy disk.

• Keep the disk away from condensation or water droplets.

■ Inserting the Floppy Disk

Insert the floppy disk into the floppy disk drive from the shutter side.

When clicking into place, the floppy disk eject button pops out.

■ Ejecting the Floppy Disk

Make sure that the floppy disk access LED is off. Press the floppy disk eject button.

The floppy disk is ejected.

• Do not eject the floppy disk while the floppy disk access LED is on. The data               

stored on the floppy disk may be damaged.

Floppy disk eject button

Label side up

Shutter

Floppy disk access LEDOff

Floppy disk eject button
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1.4.5 Inserting and Ejecting a CD-ROM

CD-ROM drive is available as an option for this server. 

■ Cautions for Handling CD-ROM Drive

• Use the drive in a dry place with low airborne dust levels. Entry of water, a paper clip, or other liquids 

or metal objects can cause electric shock or failures.

• Do not use the drive in a place exposed to shocks or vibration.

• Do not insert any object other than the specified CD-ROMs.

• Do not pull or push the CD-ROM tray forcibly.

• Do not disassemble the CD-ROM drive.

• Clean the CD-ROM tray before use. Use a dry, soft cloth for cleaning.

• When the CD-ROM drive is not used for a prolonged period, eject the CD-ROM to prevent accidents. 

To avoid dust or particles, keep the CD-ROM tray closed (in a loaded position).

• This server supports CD-ROMs with the following logo. Do not use CD-ROMs without the logo. 

Doing so may cause failures. 

■ Cautions for Handling CD-ROMs

• When removing the disk from the case, pull the disk up while pressing the center holder of the case as 

shown in the figure below.

• Hold the CR-ROM on its edge to avoid contact with the disk surface.

• Do not contaminate the CD-ROM surface with fingerprints, oil, or dust. If the disk is dirty, wipe it 

from the center to the edge with a dry, soft cloth. Do not use benzine, thinner, water, record sprays, 

antistatics, or silicone clothes.

• Be careful not to scratch the CD-ROM surface.

• Avoid heat.

• Do not bend the floppy disk or place heavy objects on it.

• Do not use a ball-point pen or pencil on the label (printed) side.

• Do not apply stickers to the label side. Abnormal vibration can occur due to eccentricity.

• When the CD-ROM is moved from a cold place into a warm place, dew condensation may occur, 

resulting in data read errors. If this is the case, wipe droplets away with a dry, soft cloth and let the 

unit dry naturally. Do not use a hair dryer.

• To avoid dust, scratches, or deformation, store CD-ROMs in the case whenever not in use.

• Do not store CD-ROMs in areas of high temperature exposed to direct sunlight for many hours or 

near heating appliances.
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■ Inserting the CD-ROM

1 Make sure the server is turned on and press the CD-ROM eject button.

The CD-ROM tray comes out a little.

2 Pull the CD-ROM tray out.

3 Place the CD-ROM at the center of the tray.

While supporting the CD-ROM tray, push the tray until it clicks into position.

� If the CD-ROM is placed improperly when the tray is pushed into the unit, the CD-ROM or the                 

drive may be damaged.

� Be careful not to touch the lens of the CD-ROM drive.

4 Move the tray back. 

Push the tray gently until it clicks into position. 

CD-ROM eject button

CD-ROM tray

CD-ROM tray

Label side up

CD-ROM tray
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■ Ejecting the CD-ROM

To eject the CD-ROM, press the CD-ROM eject button (EJECT) in the same way as steps 1 to 2 in "■ 

Inserting the CD-ROM" (�pg.35).
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1.5 Workflow

Use the following workflow from server installation to start of operation.

Installing the server
Referring to "Safety Precautions" and "Start Guide",  install the server to a suitable place.

Preparing the server

- Install Internal options
- Set hardware
Referring to "2.1 Preparation on the server", "Chapter 7 Installing Internal Options", and 
"Chapter 8 Hardware Configuration/Utilities", prepare the server.

Selecting the installation method

Referring to "2.2 Selecting the Installation Method", decide what installation method to use.
ServerStart, a software that enables everything from OS installation/setup to the installation of high 
reliability tools to be performed in one operation, comes with this server. It is recommended that 
ServerStart is used to perform installation.

Checking precautions on installation
Before installing the OS, check the precautions on installation by referring to "2.3 Precautions on Installation".

Procedures before operation
Before operating the server, refer to "Chapter 5 Operations after OS installation".

High reliability tool installation

Start operations

Installing Internal options
Referring to "Chapter 7 Installing Internal Options", install the Internal options.

Using ServerStart
Referring to "Chapter 3 OS Installation Using 
ServerStart", perform OS installation.

Manual installation
Referring to "Chapter 4 Manual OS 
Installation", perform OS installation.

OS installation

When the OS is installed manually, it is necessary to install high reliability tools. ServerView requires
settings before server operation. For installation method and details about each high reliability tool, refer 
to “Chapter 6 High Reliability Tools”.
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Chapter 2 

Checking before OS  
Installation

This chapter explains the preparation on the 

server and cautions necessary before OS 

installation. Please read this chapter before 

starting installation. 

2.1 Preparation on the Server  . . . . . . . . . . . . . . . . . . . . . . . . 40

2.2 Selecting the Installation Method . . . . . . . . . . . . . . . . . . . 43

2.3 Precautions on Installation . . . . . . . . . . . . . . . . . . . . . . . . 44

2.4 Preparation for Using ServerStart on a Client Computer . . 48
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2.1 Preparation on the Server

Before starting installation, install internal options to the server and perform 

necessary hardware settings. 

2.1.1 Installing Internal Options

Internal options are classified into those that must be installed before the OS installation and those that 

must be installed after the OS installation. 
For installation procedures, refer to "Chapter 7 Installing Internal Options" (�pg.161).

● Internal options that must be Installed before the OS installation

• Memory Modules

• Expansion cards

● Internal options that must be Installed after the OS installation

• Optional SCSI devices

• Internal hard disk units where the Operating System is not installed

� If an internal option device that must be installed after the OS installation has been already installed, 

remove the device, install the OS, then reinstall the device.

■ Cautions for Installing an Expansion Card

When using an expansion card, read the notes on the expansion card. 

■ Cautions for Installing an Optional SCSI Device

When adding an optional SCSI device (DAT, etc.) using a SCSI card, connect it after installing the OS. 

Connecting it before OS installation may result in improper drive letter assignment.

■ LAN Cable

Be sure to connect the LAN cable when the server is not connected to the Internet. If the OS is installed 

or applications are automatically installed without connecting the LAN cable to the LAN card, an error 

may be recorded in the event viewer after setup completes.

� Connecting to the Internet during setup can cause security problems. Do not connect to the Internet 

until the setup completes.
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2.1.2 Hardware Settings

Before starting installation, set up necessary hardware configurations using the BIOS Setup Utility.

■ BIOS Setup Utility

The BIOS Setup Utility must be set in the following cases. For details on how to set the BIOS Setup 

Utility, refer to "8.2 BIOS Setup Utility" (�pg.191). 

● Performing Remote Installation

Before performing remote installation of ServerStart, use the following procedures to enable network 

startup (PXE). In addition, check the MAC address.

1 Take the following steps in the BIOS Setup Utility.

1. Start the BIOS Setup Utility.

�"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.191)

2. Select the [PCI Configuration] submenu from the [Advanced] menu, then [Ethernet 

on Board]. Press the [Enter] key. 

The [Ethernet on Board] submenu window appears.

3. Set the following items to [Enable].

• When using LAN connector A: 

[Option ROM Scan] of [PCI Device, Embedded Ethernet A].

• When using LAN connector B: 

[Option ROM Scan] of [PCI Device, Embedded Ethernet B].

"■ Ethernet on Board Submenu" (�pg.203)

4. From the [Exit] menu, select [Save Changes & Exit] to exit the BIOS Setup Utility.

5. Start the BIOS Setup Utility again. 

6. Select the [Boot Option] submenu from the [Main] menu. Press the [Enter] key. 

The Boot Option submenu window appears. 

7. Change the [Boot Sequence] setting as shown below. 

8. Exit the BIOS Setup Utility and turn off the server. 

2 Check the MAC address. 

After BIOS setup, start up the server from the network.

The MAC address is displayed as shown below. 

The MAC address is required for remote installation. Write it down. 

1 IBA GE Slot 0208 v1217 (when LAN connector A is 

used)  
 IBA GE Slot 0430 v1217 (when LAN connector B is 

used)  
2 CD-ROM 
3 Removable Device 
4 Hard Drive

CLIENT MAC ADDR: ** ** ** ** ** **
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3 Exit the BIOS Setup Utility and turn off the server. 

� You can turn the power on from a client (via a LAN) by utilizing the Wakeup on LAN (WOL) function. 

Refer to "5.5.5 Turning the Power On via a LAN" (�pg.148). 

� Be sure to install ServerView to control the power supply via a LAN.
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2.2 Selecting the Installation Method

When installing the OS for the first time, there are multiple installation methods. Refer 

to the following to decide on the method.

� To set up multiple servers with the same model and configuration, refer to "3.5 Installation on Multiple 

(the Second and Subsequent) Servers" (�pg.103). 

■ Installation Using ServerStart

When an OS is installed using ServerStart, the driver for the expansion card that is automatically 

recognized will be installed automatically. In addition, high reliability tools and array controller 

administrative tools are installed automatically. Installation using ServerStart is recommended under 

special circumstances.  
For features of ServerStart, refer to "1.2.1 Setup Support Tool - ServerStart" (�pg.16).

■ Installation While Maintaining the Established RAID Environment

In guided mode or preconfiguration mode, select [Use existing array] for [Configuration mode] at 

[RAID Wizard] (in the [RAID Configuration] window) and install the OS. 

■ Installation Using ServerStart While Maintaining the Existing 
Partitions

Use the Expert mode of ServerStart. In expert mode, start up "Disk Manager", format the installation 

partition, and install the OS. 

Refer to "3.1 Guided Mode" and perform installation.

* If you follow the wizard, setup will be performed 
correctly.

Linux

Windows Server 2003
/Windows 2000 Server 

Installation is performed manually. 
Refer to "4.2 Starting Manual Installation" 
and perform installation.

When setting setup information in advance on 
the client computer, refer to "3.2 Preconfiguration 
Mode" and perform installation.

What OS will you use?

Will you use ServerStart?
No

Yes

For the use of Linux, refer to the Fujitsu PRIMERGY
website (http://primergy.fujitsu.com).
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2.3 Precautions on Installation

Read the following notes before starting OS installation. 

2.3.1 Installation Partition Size

For installation using ServerStart, the installation partition size can be set as follows, depending on the 

OS to be installed and format. 

● Notes

• When you want to set the OS and BOOT partitions in different partitions, specify the partition size 

directly. 

(The BOOT partition is the partition for startup. Minimum information required for startup, such as 

"ntldr", is stored. The OS partition is the partition for installing the OS.)

• In either of the following cases, specify a partition size less than 2TB.

• When the same partition is specified as the OS and BOOT partitions

• When different partitions are specified as the OS and BOOT partitions

• The OS cannot be installed in a partition larger than 2TB. 

2.3.2 Notes on Configuring RAID

Take the following notes when you configure a RAID system.

■ Hardware Configuration

• Only internal hard disk units can be used. 

• Be sure to use hard disk units of the same model and with the same capacity.

• Up to two hard disk units can be installed on the server. Do not set the number of units more than the 

maximum. 

■ Array Configuration

Configure RAID0 or RAID1 using two hard disk units connected to channel 1.  
For more details, refer to "PRIMERGY ServerBooks" supplied with the server, and "Supplement" 

supplied with the RAID card. 

table: Installation Partition Size

 Available size Windows Server 2003 Windows 2000 Server

Minimum 2,200MB 2,048MB

Maximum 2 TB 2 TB
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■ Checking before OS Installation

• When removing the hard disk unit 

If you configure the RAID with ServerStart, use the Background Initialization function for the arrays. 

Before removing the hard disk unit, make sure that the disk has already been initialized by the RAID 

Management Tool or others. For more details, refer to "PRIMERGY ServerBooks" supplied with the 

server, and "Supplement" supplied with the RAID card. 

• Number of disk units

If the number of actually installed units is smaller than the setting for the number of units (+1 when a 

hot spare is specified), installation using ServerStart is aborted because of an error. 
When the number of installed disk units is greater than the setting, the disk units are set up according 

to the setting. Extra units will be configured as standby disk units. You can add a physical pack later. 

For more details, refer to "PRIMERGY ServerBooks" supplied with the server, and "Supplement" 

supplied with the RAID card. 

2.3.3 Notes on a multiple LAN adapter configuration

Using the OS installation wizard of ServerStart, you can configure multiple LAN adapters (network 

adapters) on the system. However, there are the following limitations.

● Adapter Numbers

To configure multiple LAN cards, select the adapter numbers in order of Adapter 1 and Adapter 2, and 

enter settings for each adapter. Note that the order of adapter numbers is not necessarily the same as the 

order of slots for the installed LAN adapters. This means that the setting for Adapter 1 is not always 

applied to the onboard LAN. After installing the OS, check the LAN adapters to make sure that they are 

configured as intended. 

2.3.4 Cautions for Using ServerStart

■ Operating ServerStart

Most ServerStart operations are performed with the mouse. Items may not be moved with the [Tab] key 

or cursor keys. Be sure to use the mouse when operating ServerStart.

■ Ejecting the CD-ROM 

Do not eject the ServerStart CD-ROM while ServerStart is running. If the ServerStart CD-ROM is 

ejected and inserted again, ServerStart starts up in multiple windows, and settings you have made can be 

lost.

■ Exiting ServerStart

After operation in guide mode or expert mode, exiting ServerStart restarts the system. Ejecting disks 

from the floppy disk and CD-ROM drives and click [OK]. When the display on the screen disappears, 

turn off the system.
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■ License for Use of System for ServerStart

"License for Use of System for ServerStart" linked from the ServerStart startup window is a license for 

use of Windows PE contained in the ServerStart CD-ROM. Windows PE for starting up ServerStart can 

be only used for installing Windows Server 2003 or Windows 2000 Server provided under a separate 

legal license.

■ Setting Up the Printer

ServerStart does not support setup of printers. Perform installation after setup is completed.

2.3.5 Expansion Cards Supported by ServerStart 

ServerStart supports automatic driver installation for the following expansion cards.

table: Automatic Expansion Card Driver Installation

Name Model name Bus

Onboard FDD/IDE  -  -

RAID Ctrl 1-Channel 64MB PG-141C1L PCI

Onboard LAN  - PCI/CSA

Onboard VGA  - PCI

LAN cards PG-1852 PCI

PG-1862 PCI

PG-1882L PCI

PG-1892L PCI

SCSI Ctrl U160 lp PG-130L PCI
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2.3.6 Cautions for Manual Installation

■ Notes on Using a RAID Card

In addition to the completion of RAID card configuration, the hard disk under the RAID card must be 

initialized before the OS is installed. To check the RAID card configuration, start up WebBIOS. For 

more details, refer to "PRIMERGY ServerBooks" supplied with the server, and "Supplement" supplied 

with the RAID card. 

■ Free Space Required for Installation

The partition where the OS is installed must have enough free space for obtaining memory dump. For 

more details, refer to "5.1 Memory Dump/Paging File Setting" (�pg.126).

■ Cautions on Restarting

In the course of installation, a message appears to indicate that the setup program restarts. Wait until it 

restarts.  
For background operations, refer to "PRIMERGY ServerBooks" supplied with the server, and 

"Supplement" supplied with the RAID card. 
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2.4 Preparation for Using ServerStart 
on a Client Computer

When using the preconfiguration mode for setting installation information in advance 

or when creating a driver disk using the FloppyBuilder function, install ServerStart on 

the client computer.

● System Requirements for Client Computers

Client computers must satisfy the following requirements. 

2.4.1 Installing ServerStart

� If a different version of ServerStart has been installed, uninstall it. The FloppyBuilder function or 

installation wizard may not operate properly on a different version.

For details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" (�pg.51).

1 Insert the ServerStart CD-ROM into the client computer's CD-ROM drive.

The [ServerStart Launcher] window appears.

When the [ServerStart Launcher] window does not appear, execute "Launcher.exe" in the CD-

ROM.

2 Confirm that the [Install Fujitsu ServerStart] is checked, then click [OK]. 

The Windows installer starts and the Setup window appears.

Hardware Personal computers operated with Windows NT, Windows XP Professional, or Windows 

2000 Professional 
(A CD-ROM drive and 10MB or more of free space are required.)

Software Microsoft® Internet Explorer 5.5 or later
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3 Click [Next].

The [License Agreement] window appears.

4 Select [I accept the license agreement] and click [Next].

The [User Information] window appears.

5 Enter the user information of the software and click [Next].

The [Installation Folder] window appears.

6 Specify the installation folder and click [Next]. To change the installation folder, 

click [Browse] and select the folder.

The [Select Features] window appears.

7 Set [ServerStart - remote installation] to "Disable this function" and click [Next].

The [Ready to Install the Application] window appears. 
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8 Specify whether or not to copy the contents of the CD.

When you select [Yes] for "enable the use of ServerStart without CD.", you can start the 

preconfiguration mode on the client computer without using the CD-ROM. 
If you select [Yes], specify the target folder. The target folder must have enough free space to 

copy the contents of the CD-ROM.

� On WindowsNT, the CD-ROM is not copied. You must click [No]. The ServerStart CD-ROM is              

required to start ServerStart.

9 Click [Next].

Installation is executed.

� If a message prompting you to restart the system appears before or after installation, eject the 

CD-ROM and restart the system according to the message. When the system restarts, insert 

the ServerStart CD-ROM and start installation again. 
If like the following message "This program stops responding." appears during startup, click 

[Exit] to continue the restart operation. 

When the installation is completed, the completion window appears.

10 Click [Exit].

ServerStart has been installed to the client computer.
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2.4.2 Uninstalling ServerStart 

Perform the following procedure to uninstall ServerStart from the client computer.

1 Click [Start] → [Settings] → [Control Panel].

2 Double-click [Add or Remove Applications] ([Add or Remove Programs] on 

some operating systems).

3 Select [Fujitsu ServerStart] and click [Remove] (or [Modify]).

When the uninstallation is executed successfully, Fujitsu ServerStart is deleted.

If [ServerStart - remote installation] has been installed using ServerStart, "FjPXEServer" seems 

undeleted. Leave it and complete the operation.

� On Windows 2000 Professional clients, "Add or Remove Applications" may become unable to respond 

during uninstallation. If this occurs, log off from the system.
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Chapter 3 

OS Installation Using  
ServerStart

This chapter explains how to install the OS in the 

server using ServerStart.

3.1 Guided mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

3.2 Preconfiguration Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . 71

3.3 Expert Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

3.4 Remote Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

3.5 Installation on Multiple (the Second and Subsequent) Servers  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
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3.1 Guided mode

In guided mode, follow the wizard to specify hardware configuration and the OS to be 

installed, save the information necessary for installation in a configuration file, and 

install the OS.

3.1.1 Starting Up the Guided Mode

Start up the guided mode.

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk supplied with the server. Make sure that 

"Removable media" and "A:" are selected and click [Create].

� Set the ServerStart floppy disk in the write-enabled state.
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The network setting window for remote installation appears.

3 Click [OK].

The [Initialization of ServerStart core running] window appears and unattended installation will 

be started. Depending on the hardware configuration, this process may take a few minutes.

When the process is completed, the [Create a ServerStart Floppy Disk] window appears.
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4 Click [Build a ServerStart Floppy Disk].

Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy disk has 

been created." message appears. 

5 Click [OK]. 

"Please Select your keyboard" window appears. 

6 Select your keyboard language from the drop-down list and click [OK].

The subsequent start procedure may take several minutes. The [Welcome to ServerStart] window 

appears. 

7 Click [Click here to prepare and/or initiate an operating system installation].

The [Select the operating system to be installed] window appears. 
Click [Special Hints on Operating System Installation] and read the contents. Important 

information such as limitations on disk configuration is described.

8 Click [MS Windows Operating Systems].

The [Microsoft Windows Operating System Installation] window appears.

9 Click the OS to install.
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10 Click [Prepare & initiate an unattended installation of (OS)].

The guided mode for the selected OS starts up.

Start up the wizards to set items in the following procedures.

Exiting the wizard returns the display to the guided mode window.

Open/create configuration file

OS installation wizard

Application wizard

Close/save configuration file

Starting OS installation

RAID wizard

Disk wizard 
(connected disks are displayed)
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3.1.2 Open/create a Configuration File

Open a configuration file. Or create a new file.

1 Click [Start here to create a complete configuration file].

The [Open ServerStart Configuration File] window appears.

� Once a configuration file is opened, another file cannot be opened until you click [Close and               

save Configuration File].

2 Select the configuration file and click [Create].

The next wizard starts up automatically.

If the array controller is installed or if the Preconfiguration mode is selected

The RAID Wizard starts up. Go to "3.1.3 RAID Wizard" (�pg.59). 

If an array controller is not installed

The Disk Wizard starts up. Go to "3.1.4 Disk Wizard" (�pg.60). 
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3.1.3 RAID Wizard

Configure RAID. In the guided mode, the RAID wizard is displayed only when a RAID card is installed. 

� When changing the RAID card, delete the physical pack beforehand. For details on how to delete a 

physical pack, refer to "PRIMERGY ServerBooks" supplied with the server, and "Supplement" supplied 

with the RAID card. 

1 Click [RAID Wizard: Setting for the RAID system].

The [RAID Configuration] window appears.

Only array controllers already installed are displayed.

The number of hard disk units connected to the array controller is displayed.

� If you open a configuration file that has been created before, displayed settings may differ from               

the previously set values. Be sure to check the settings.

2 Set items and click [leave wizard].

The RAID wizard closes.



60

Chapter 3  OS Installation Using ServerStart

3.1.4 Disk Wizard

Create and format hard disk partitions.

� The disk wizard starts up with the default settings. Be sure to click [MODIFY] to check the settings. 

Change them as necessary.

1 Click [Disk Wizard: Hard disk partitioning and formatting].

The [Disk Overview] window appears.

� When the installation disk has partitions, check [Erase all existing partitions on all displayed             

disks].

� When other disks than the installation disk have an active partition, create a partition on the               

disks with an active partition and check [Erase all existing partitions on all displayed disks].
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2 Add, remove, or modify partitions as necessary.

� Partition size of the FAT file system

When "FAT" is selected in [File system] and a value equal to or more than 4095MB or "Auto-                 

matic setting" is specified in [Partition size], the size of created partitions will be 4095MB.

� Restrictions of volume label characters

The following limits apply to the volume label length. A volume label longer than the limit may                

be used. However, it can cause installation failure. Enter a volume label within the limit.

•FAT: Up to 11 byte characters

•NTFS: Up to 32 byte characters

Add a partition

1. Click [Add].

The [Disk Configuration] window appears.

2. Set items and click [continue].

The new partition is added to the partition list.

Remove a partition

1. Select the partition to remove and click [REMOVE].

The partition is removed.

Modify the partition configuration

1. Select the partition to modify and click [MODIFY].

The [Disk Configuration] window appears.

2. Change items and click [continue].

The partition is modified.

3 Click [leave wizard] after settings are completed.

The disk wizard closes.
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3.1.5 OS Installation Wizard

Set computer information, user information, and the network protocol. 
ServerStart can configure multiple network patterns. When configuring a domain controller, refer to 

"Using ServerStart to configure the Network".

� The setting window differs depending on the OS to be installed. The following describes operations on 

Windows Server 2003.

1 Click [Windows Server 2003 setup configuration Wizard].

The [Windows Installation] window appears.

2 Enter the password in [Password for Administrator account] and click [Next]. 

� If the Windows Server 2003 is running, be sure to enter the Administrator's password. 

The [Computer Identification] window appears.
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3 Set items and click [Next].

The [Installation Directory and Time Zone] window appears.

4 Set items and click [Next].

The [User Name] window appears.

5 Set items and click [Next].

The [Display Settings] window appears.
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6 Set items and click [Next].

The [Network Protocol] window appears.
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7 Set items and click [Next].

The [Software Components] window appears.
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8 Set items and click [Next].

The [Services] window appears.

9 Set items and click [leave wizard].

The OS installation wizard closes.
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3.1.6 Application Wizard

Specify installation of supplied applications such as high reliability tools.

1 Click [Application Wizard: Select additional software components].

The application wizard appears. 

2 From the [Installable applications] list, select applications to be installed and 

click [>>].

Set all applications to be installed on the [Selected applications] list.

3 Click [leave wizard].

The application wizard closes.
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3.1.7 Close/save the Configuration File

When settings in all wizards are completed, save the configuration file.

1 Click [Close and save Configuration File].

The [Save ServerStart Configuration File] window appears.

2 Click [Save As].

The configuration file is saved.

� You can specify any name for the configuration file. However, OS installation is possible only              

when it is saved as "SerStartBatch.ini". When installing the OS, make sure to save it as "Ser-                

StartBatch.ini" on the ServerStart floppy disk.

3.1.8 Starting OS Installation

Install the OS to the server. 
During installation, do not use the mouse or keyboard unless it is necessary for installation operations. 

Otherwise, installation may fail. 

1 Click [Click here, to Start the Installation of (OS)].

The [ServerStart Unattended Mode] window appears.
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2 Click [Start].

� Clicking [Start now] deletes all disk contents and starts installation. Click [Stop] when you do              

not perform installation.

After 10 seconds, installation starts automatically.

• When RAID has been configured, the system restarts.

• If a message prompting you to insert the Service Pack CD-ROM appears, insert the CD-ROM 

and click [OK].  

This message does not appear when Service Pack is not selected.

• If a message prompting you to insert the ServerView CD-ROM appears, insert the 

PRIMERGY Document & Tool CD (Disc 1) and click [OK].

This message does not appear when ServerView will not be installed or the PRIMERGY 

Document & Tool CD (Disc 1) has been inserted already.

• If a message prompting you to insert the ServerStart CD-ROM appears, insert the CD-ROM 

and click [OK].

3 When a message prompting you to insert the OS CD-ROM appears, insert the 

CD-ROM and click [OK].

After files are copied, a message prompting you to insert the ServerStart CD-ROM appears.

4 Insert the ServerStart CD-ROM and click [OK].

The License Agreement window appears.

5 Click [I agree].

After files are copied, a message prompting you to eject the CD-ROM and floppy disk appears.

6 Eject the CD-ROM and floppy disk and click [OK].

Then the system is restarted. 
The system continues the installation operation after restart. 
OS GUI setup, LAN utility installation, Service Pack installation, and Active Directory 

installation are performed automatically.

7 When a confirmation message to restart appears, click [Restart].

The system restarts and installs high reliability tools automatically. 

8 When a message on installation completion appears, press any key.

9 Restart the system.

Click [Start] → [Shutdown]. Select [Restart] and click [OK].

The system restarts.

10 When the system restarts, log on to the server using the Administrator account 

for the local computer.
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The server setup and OS installation have been completed.  
Refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform necessary procedures 

before starting server operations. 
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3.2 Preconfiguration Mode

In preconfiguration mode, set and save the information necessary for installation in a 

configuration file on a client computer (with a CD-ROM drive and 10MB or more of 

free space). Set the saved configuration file on the server for installation.

If ServerStart is not installed in the client computer where the preconfiguration mode is executed, refer 

to "2.4 Preparation for Using ServerStart on a Client Computer" (�pg.48) to install ServerStart. If a 

different version of ServerStart has been installed, uninstall it and install the proper version. For details 

on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" (�pg.51).

� If ServerStart is started up on a computer where a different version of ServerStart is installed, the 

installation wizard may not operate properly. Make sure to uninstall a different version of ServerStart.

3.2.1 Starting Up the Preconfiguration Mode

Start up the preconfiguration mode.

1 Start up ServerStart.

If ServerStart has already been started, it is not necessary to restart it. If it has not, start it up 

according to the following procedures:

When the CD has been copied on Windows 2000 Professional/Windows XP 

Professional

1. Click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart].

ServerStart starts up and the [Welcome to ServerStart] window appears.

When Windows NT is used, or if the CD has not been copied

1. Insert the ServerStart CD-ROM into the client computer's CD-ROM drive.

ServerStart starts up and the [Welcome to ServerStart] window appears.
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2 Click [FloppyBuilder].

The [ServerStart FloppyBuilder] window appears.

3 Click [ServerStart Status Diskette].

A message prompting you to insert the floppy disk appears.

4 Insert the ServerStart floppy disk supplied with the server and click [OK].

� Set the ServerStart floppy disk in the write-enabled state.

Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy disk has 

been created." message appears. 

5 Click [OK].

6 Click [  (HOME)] on the tool bar. 

The display returns to the [Welcome to ServerStart] window.

7 Click [Click here to prepare an operating system installation for a PRIMERGY 

Server]. 

The [Prepare the installation of an operating system for PRIMERGY Servers] window appears. 

� Before starting installation, click [Cautions for Installation] and read the contents. Important           

information such as limitations on disk configuration is described.

8 Click [Creation of a ServerStart Configuration file for the installation of an 

Microsoft Windows Operating System].

The [Microsoft Windows Operating System Installation] window appears.
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9 Select the OS to install.

The [Preparing Installation] window appears.
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3.2.2 Configure Settings in Wizards

Click the wizards to set items in the following procedures. For setting procedures, refer to description on 

guided mode wizards ("3.1.2 Open/create a Configuration File" (�pg.58) to "3.1.6 Application Wizard" 

(�pg.67)). 
Exiting a wizard returns the display to the preconfiguration mode window.

Open/create configuration file

OS installation wizard

Application wizard

Close/save configuration file

Starting OS installation

RAID wizard

Activate ServerStart in the server

Disk wizard
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3.2.3 Close/save the Configuration File

When settings in all wizards are completed, save the configuration file.

1 Click [Close and save Configuration File].

The [Save ServerStart Configuration File] window appears.

2 Click [Save As].

The [ServerStart Session IP Settings] window appears.

3 Set items when performing remote installation.

4 Click [Set].

The configuration file is saved.

� You can specify any name for the configuration file. However, OS installation is possible only when it is 

saved as "SerStartBatch.ini". When installing the OS, make sure to save it as "SerStartBatch.ini" on 

the ServerStart floppy disk.
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3.2.4 Starting OS Installation

Install the OS to the server using the created configuration file.

During installation, do not use the mouse or keyboard unless it is necessary for installation operations. 

Otherwise, installation may fail. 

1 Turn on the server and insert the ServerStart CD-ROM immediately.

A message prompting you to insert the ServerStart floppy disk appears.

2 Insert the ServerStart floppy disk containing the created configuration file and 

click [OK].

� Set the ServerStart floppy disk in the write-enabled state. If it is write protected, installation will               

fail. 

The [ServerStart Unattended Mode] window appears.
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3 Click [Start].

Installation starts.

• When RAID has been configured, the system restarts.

• If a message prompting you to insert the Service Pack CD-ROM appears, insert the CD-ROM 

and click [OK]. 

This message does not appear when Service Pack is not selected.

• If a message prompting you to insert the ServerView CD-ROM appears, insert the 

PRIMERGY Document & Tool CD (Disc 1) and click [OK]. This message does not appear 

when ServerView will not be installed or the PRIMERGY Document & Tool CD (Disc 1) has 

been inserted already.

• If a message prompting you to insert the ServerStart CD-ROM appears, insert the CD-ROM 

and click [OK].

4 When a message prompting you to insert the OS CD-ROM appears, insert the 

CD-ROM and click [OK].

After files are copied, a message prompting you to insert the ServerStart CD-ROM appears.

5 Insert the ServerStart CD-ROM and click [OK].

The License Agreement window appears.

6 Click [I agree].

After files are copied, a message prompting you to eject the CD-ROM and floppy disk appears.

7 Eject the CD-ROM and floppy disk and click [OK].

The system restarts. The system continues the installation operation after restart. OS GUI setup, 

LAN utility installation, Service Pack installation, and Active Directory installation are 

performed automatically.

8 When a confirmation message to restart appears, click [Restart].

The system restarts and installs high reliability tools automatically.

9 When a message on installation completion appears, press any key.

10 Restart the system.

Click [Start] → [Shutdown]. Select [Restart] and click [OK]. The system restarts.

11 When the system restarts, log on to the server using the Administrator account 

for the local computer.

The server setup and OS installation have been completed. Refer to "Chapter 5 Operations after OS 

Installation" (�pg.125) and perform necessary procedures before starting server operations.
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3.3 Expert Mode

In expert mode, start up Disk Manager, format the installation partition, and install the 

OS.  
Use the expert mode only when you want to perform installation while maintaining the 

existing partitions. Use the guided mode for normal installation.

3.3.1 Starting Up the Expert Mode

Start up the expert mode.

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk supplied with the server. Make sure that 

"Removable media" and "A:" are selected and click [Create].

The network setting window for remote installation appears.

� Set the ServerStart floppy disk in the write-enabled state.

3 Click [OK].

The [ServerStart FloppyBuilder] window appears.

4 Click [Build a ServerStart Floppy Disk].

Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy disk has

been created." message appears. 

5 Click [OK].

"Please Select your keyboard" window appears. 

6 Select your keyboard language from the drop-down list and click [OK]. 

The subsequent start procedure may take several minutes. The [Welcome to ServerStart] window 

appears.

7 Click [Click here to prepare and/or initiate an operating system installation].

The [Select the operating system to be installed] window appears. 
Click [Special Hints on Operating System Installation] and read the contents. Important 

information such as limitations on disk configuration is described.

8 Click [MS Windows Operating Systems].

The [Microsoft Windows Operating System Installation] window appears.

9 Select the OS to install.
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10 Click [Install MS Window Server 2003 interactively (expertise required)].

The expert mode starts.

Start up the configuration tools to set items in the following procedures. Exiting a tool returns to 

the display to the expert mode window.

OS installation wizard

Application wizard

Starting OS installation

Disk manager
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3.3.2 Disk Manager

Start up Disk Manager and format the installation partition.

1 Click [Use Disk Manager to partition and format your disk drives].

Disk Manager starts up.

2 Format the OS installation partition. Select the OS installation partition and click 

the [Partition] menu → [Format].

The [Format Partition] window appears.

� Be sure to specify the active partition on drive C.

� Partitions equal to or larger than 4096MB cannot be FAT formatted.

3 Set items and click [Format].

The partition is formatted.

4 When the formatting is completed, click the [File] menu → [Exit].

Disk Manager closes and the display returns to the expert mode window.
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3.3.3 OS Installation Wizard

Set computer information, user information, and the network protocol.

ServerStart can configure multiple network patterns. When configuring a domain controller, refer to 

"Using ServerStart to configure the Network".

� The setting window differs depending on the OS to be installed. The following describes operations on 

Windows Server 2003.

1 Click [Installation Wizard for MS Windows Server 2003].

A message prompting you to specify the configuration file appears.

2 Click [No].

The [Windows Installation] window appears.

3 Enter the password in [Password for Administrator account] and click [Next]. 

The [Computer Identification] window appears.

4 Set items and click [Next].

The [Installation Directory and Time Zone] window appears.

5 Set items and click [Next].

The [User Name] window appears.

6 Set items and click [Next].

The [Display Settings] window appears.

7 Set items and click [Next].

The [Network Protocol] window appears.

8 Set items and click [Next].

The [Software Components] window appears.

9 Set items and click [Next].

The [Services] window appears.

10 Set items and click [leave wizard].

The display returns to the expert mode window.
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3.3.4 Application Wizard

Specify installation of supplied applications such as high reliability tools.  
For details on the application wizard, refer to "3.1.6 Application Wizard" (�pg.67).

3.3.5 Starting OS Installation

Install the OS to the server.

� When the installation partition is not empty, a confirmation message appears. If it does not matter, click 

[OK] to continue the installation procedure.

� If an incorrect setting (such as the CD key) is found during installation, an error window will appear. 

Enter the correct value in the window to continue the installation procedure. However, corrections 

made here are not reflected to the configuration file.

1 Click [Click here, to Start the Installation of (OS)].

A confirmation window asking whether you want to save the current settings appears.

2 Click [Yes].

The following window appears.
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3 Enter the file name and click [Save As].

Installation starts automatically.

• If a message prompting you to insert the Service Pack CD-ROM appears, insert the CD-ROM 

and click [OK]. 

This message does not appear when Service Pack is not selected.

• If a message prompting you to insert the ServerView CD-ROM appears, insert the 

PRIMERGY Document & Tool CD (Disc 1) and click [OK]. This message does not appear 

when ServerView will not be installed or the PRIMERGY Document & Tool CD (Disc 1) has 

been inserted already.

• If a message prompting you to insert the ServerStart CD-ROM appears, insert the CD-ROM 

and click [OK].

4 When a message prompting you to insert the OS CD-ROM appears, insert the 

CD-ROM and click [OK].

After files are copied, a message prompting you to insert the ServerStart CD-ROM appears.

5 Insert the ServerStart CD-ROM and click [OK].

The License Agreement window appears.

6 Click [I agree].

After files are copied, a message prompting you to eject the CD-ROM and floppy disk appears.

7 Eject the CD-ROM and floppy disk and click [OK].

Then the system is restarted. 
The system continues the installation operation after restart. 
OS GUI setup, LAN utility installation, Service Pack installation, and Active Directory 

installation are performed automatically.

8 When a confirmation message to restart appears, click [Restart].

The system restarts and installs high reliability tools automatically. 
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9 When a message on installation completion appears, press any key.

10 Restart the system.

Click [Start] → [Shutdown]. Select [Restart] and click [OK].

The system restarts.

11 When the system restarts, log on to the server using the Administrator account 

for the local computer.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform necessary procedures 

before starting server operations.
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3.4 Remote Installation

ServerStart supports remote installation.

� Before performing remote installation, be sure to read "Cautions for Remote Installation" in the online 

help.

3.4.1 Overview of Remote Installation

Remote installation is a method to save resources necessary for installation, such as the OS and Service 

Pack, in a different server on the network and install them via the network. 
If a remote resource server is configured, you can install the same resources to multiple servers. This 

method is useful in configuring multiple servers.

● Target Server and Remote Resource Server/PXE Server

A server to which resources are installed is called a "target server". A server that stores resources 

necessary for remote installation is called a "remote resource server". A server that can start up a target 

server through network startup (PXE) is called a "PXE server".

■ Installation Method

Remote installation uses a PXE or a remote resource server.
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● Remote Installation Using a PXE Server

In remote installation using a PXE server, the network startup (PXE) function of the PXE server starts 

up the target server and performs installation in preconfiguration mode. This method is used when the 

target server does not have a CD-ROM or floppy disk drive.

In addition to the PXE server, a "remote resource server" that stores remote resources and a "DHCP 

server" that performs the DHCP service are required for remote installation using a PXE server. When 

you have only one server, store remote resources on the PXE server to install the DHCP service. When 

you have multiple servers, select one for performing the DHCP service and another for storing remote 

resources.

● Remote Installation Using a Remote Resource Server

In remote installation using a remote resource server, ServerStart starts up on the target server. 

Procedures for starting installation are the same as those in normal installation (preconfiguration mode, 

guided mode, and expert mode). Once installation started, resources necessary for installation are 

provided from the remote resource server. Thus, procedures such as inserting a CR-ROM are not 

necessary.

Installation
using ServerStart

PXE serverTarget server

Activated by IP address/
boot image

1)

Request resources2)

3) Supply resources

- OS
- Service Pack
- Application  
 etc.

Target server Remote resource server

Active ServerStart 
and start installation 1) Request resources

Supply resources2)

- OS
- Service Pack
- Application
  etc.
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3.4.2 System Requirements for Remote Resource/PXE 
Servers

Because remote installation is performed via a network, the environment must have at least one 

Windows server and a local area network. 
In addition, the following environment is required.

■ Remote Resource/PXE Server Requirements

Notes on the PXE server

� Check that no other PXE server exists on the same LAN.

� Servers installed with software with the PXE function such as SystemcastWizard/SystemcastWizard 

Professional, Quick Recovery Manager, or the Microsoft RIS function cannot be used as a PXE server.

■ Checking Server Free Space

Decide a server to use as a remote resource server / PXE server and check it for enough free space for 

storing resources.

● Checking the Number of Servers

• When you have only one server, use it as the remote resource server, PXE server, and DHCP service 

server. Check it for the required amount of free space.

• When you have multiple servers

• Check if a server performing the DHCP service exists. If not, decide a server for the DHCP 

service.

• When there are multiple resources, they can be divided and stored in multiple remote resource 

servers.

table: System Requirements for Remote Resource/PXE Servers

PXE server Remote resource server

OS Windows 2000 Server SP2–4 Windows Server 2003 
Windows 2000 Server 
Windows NT Server 4.0

Memory 

Modules

256MB or more

Operating 

environment

• DHCP server function (required on the same 

network)

• File sharing function (required)

• Display screen size: XGA (1024 by 768 

pixels) or more

• File sharing function (required)



88

Chapter 3  OS Installation Using ServerStart

● Checking Server Free Space

The following table shows the amount of free space required for each installation resource.

Calculate the total resource size. Check that the remote resource server / PXE server has enough free 

space (free space greater than the space required for the resources). When the amount of free space is 

insufficient, you must use more remote resource servers.

3.4.3 Preparation of the PXE Server (When the PXE Server 
is Used)

When performing remote installation using a PXE server, preparatory procedures, such as installing 

ServerStart, are required. 
Perform the following procedures to prepare the PXE server.

■ Starting the DHCP Service

Check that the DHCP service is running on the same network. 
If the DHCP service function is not installed, perform the following procedures (for Windows Server 

2003) to install the DHCP service.

1 Click [Start] → [Control Panel] → [Add or Remove Applications].

table: Free Space Required for Resources

Resource
Required free 

space

ServerStart About 650MB

Windows Server 2003 644MB

Windows 2000 Server 472MB

Windows 2000 Service Pack 4 433MB

Starting the DHCP Service

Installing ServerStart

Checking Services

Setting TFTP

Preparation of Resources
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2 Click [Add or Remove Windows Components]. Click the [Dynamic Host 

Configuration Protocol (DHCP)] service from [Network Services].

The DHCP service is installed.

3 Create and configure a DHCP scope so that the IP address can be distributed.

■ Installing ServerStart

1 Insert the ServerStart CD-ROM into the PXE server.

The [ServerStart Launcher] window appears. 
When the [ServerStart Launcher] window does not appear, execute "Launcher.exe" in the CD-

ROM.

2 Confirm that the [Install FSC ServerStart as application] is checked, then click 

[OK]. 

The Windows installer starts and the Setup window appears.

3 Click [Next].

The [License Agreement] window appears.

4 Select [I accept the license agreement] and click [Next].

The [User Information] window appears.

5 Enter the user information of the software and click [Next].

The [Installation Folder] window appears.
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6 Select the installation folder and click [Next].

To change the installation folder, click [Browse] and select the folder. 
The [Select Features] window appears.

Configure [ServerStart - remote installation] so that it will be installed.

Clicking [Disk Cost] displays the following widow where you can check the amount of free 

space.
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7 Click [Next].

The [contents tree] window appears.

8 Configure the ServerStart image necessary for network startup (PXE) and click 

[Next].

The [User account for access to the contents tree] window appears.
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9 Specify the user account for the content tree and click [Next].

The [PXE Server] window appears.

10 Select [yes] when the PXE server performs the DHCP service or select [no] 

when the DHCP and PXE servers are configured separately. Then click [Next].

The [PXE Server] window appears.

11 When there are multiple LAN ports, click [select], select the LAN controller on 

the LAN controller selection screen, and click [Next].

The [Important hint] window appears.

12 Click [Next].

The [Ready to Install the Application] window appears. 
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13 Click [Show Readme file].

The [Readme] window appears. Read the text. When you finish, click [ ] in the upper-right 

corner of the window to close the [Readme] window.

14 Click [Next].

The image file is copied.

The image file copying process takes about 10 to 20 minutes.

The installation complete when the installation completion window appears.

15 Click [Start] → [Shutdown]. Select [Restart] and click [OK].

The system restarts.

■ Checking Services

● Checking [PXE Services] and [TFTP Service]

1 Right-click the [My Computer] icon and click [Manage].

2 Select [Services] from [Services and Applications].

On the Services list, check that PXE Services and TFTP Service have been installed and started.
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● Checking the DHCP Service

Perform the following check only when the PXE server performs the DHCP service.

1 On the PXE server, click [Start] → [Programs] → [Administrative Tools] → 

[DHCP] to start up the DHCP administrative tool.

2 Click [Server Options] and check that the "060 ClassID" server option is added.

■ Setting TFTP

TFTP is an FTP service function that requires no authentication. In remote installation, the TFTP service 

is used to distribute the boot image required for startup. 
For the TFTP path, set the appropriate access rights for the Guest account to obtain the image via 

network startup (PXE).

1 Click [Start] → [Programs] → [Accessories] → [Windows Explorer] and move to 

the TFTP path (the default is C:\Program 

Files\FujitsuSiemens\DeploymentService\tftp).

2 Right-click the TFTP folder and click [Properties].
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3 Click the [Security] tab, add the Guest account, and set the "Read and 

execute", "View folder contents list", and "Read" access permissions.

The preparation of the PXE server has been completed. 
Then, perform "3.4.4 Preparation of Remote Resources" (�pg.95).

3.4.4 Preparation of Remote Resources

Store resources to be installed on the remote resource server (PXE server) before starting installation.

� For sharing resources, log on to the remote resource/PXE server with the Administrator account.

1 Prepare resources required for installation.

• CD-ROM for the OS to be installed

• Service Pack CD-ROM for the OS to be installed

• ServerStart floppy disk

• PRIMERGY Document & Tool CD (Disc 1) (for installing ServerView)

• Others

2 Create a shared folder for storing resources.

Create a shared folder for each CD prepared in Step 1.

E.g.:E:\W2K3Sv for Windows Server 2003

3 Extract the resources.

Using Windows Explorer, copy the CD-ROM for the resource to the shared folder.
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3.4.5 Starting Remote Installation Using a PXE Server

Perform remote installation using a PXE server in the following procedures.

■ Checking the Network Startup (PXE) Setting

Remote installation using a PXE server is performed via the onboard LAN. Enable the network startup 

(PXE) of the target server.  
For more details on network startup, refer to "2.1.2 Hardware Settings" (�pg.41).

■ Checking the MAC Address of the Onboard LAN

In remote installation, target servers are identified according to the MAC address. MAC addresses are 

unique information to LAN cards. Check it for each target server. Check and write down the MAC 

address of the onboard LAN on each target server. For details on how to check the MAC address of an 

onboard LAN, refer to "2.1.2 Hardware Settings" (�pg.41). 

■ Creating a Configuration File

You can create a configuration file on a client computer before starting installation. For the procedure, 

refer to "3.2.1 Starting Up the Preconfiguration Mode" (�pg.71) and "3.2.2 Configure Settings in 

Wizards" (�pg.74). 
When creating a configuration file on the PXE server, start installation.

� Specify the shared name prepared instead of the local CD-ROM as installation information.

■ Starting Installation

1 On the PXE server, start up ServerStart.

If ServerStart has already been started, you do not have to restart it. 
If it is not started, click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart]. 
The [Welcome to ServerStart] window appears.

Checking the Network Startup (PXE) Setting

Checking the MAC Address

Starting remote Installation

Creating a Configuration File
(Setting of remote installation)
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2 Click [Click here to prepare an operating system installation for a PRIMERGY 

Server]. 

The [Prepare the installation of an operating system for PRIMERGY Servers] window appears. 

3 Click [Creation of a ServerStart Configuration file for the installation of an 

Microsoft Windows Operating System].

The [Microsoft Windows Operating System Installation] window appears.

4 Click the OS to install.

The [Preparing the Installation] window appears. 
If a configuration file has already been created, go to Step 6.

5 Set items in wizards to create a configuration file.

Refer to "3.2.2 Configure Settings in Wizards" (�pg.74). Set items in wizards and save the 

configuration file.  
Exiting a wizard returns to the preconfiguration mode window.

6 Click [Click have to initiate the Remote Installation Process].

The [Configure Remote Installation Target Server] window appears.
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7 Configure remote installation.

1. Enter the "MAC address of the target system".

2. Select the "PRIMERGY model type".

3. Specify the "Configuration file" containing the installation settings.
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8 Click [Start Installation].

Installation starts. All disk contents on the target server are deleted.

The [ServerStart Boot Manager] window appears. 
Check that the status is "Waiting for client".

9 Turn on the target server.

It is started up via the network (PXE) and installation starts.

When the resources have been copied, the "Preparation for automatic OS installation has 

completed." message appears. 

Subsequent installation is performed automatically.

When the installation is completed, an installation completion message appears on the target 

server.

10 Press any key on the target server.

11 Restart the system on the target server.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform necessary procedures 

before starting server operations.
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3.4.6 Starting Remote Installation Using a Remote 
Resource Server

In remote installation using a remote resource server, installation is performed using shared resources on 

the remote resource server. 
Perform "3.4.4 Preparation of Remote Resources" (�pg.95) before starting installation.

■ Configuring a Remote Floppy

A remote floppy is a shared folder for storing and using a configuration file on the network, instead of 

loading it from the ServerStart floppy disk. When the server does not have a floppy disk drive and 

installation is performed in guided mode or expert mode, use a remote floppy.

1 Create a new folder in the shared folder on the remote resource server.

E.g.: C:\export\ServerStart\Floppy

2 Create a "ServerStart Floppy Disk" tag file for the ServerStart floppy disk. Start 

up Command Prompt and enter the following command.

C:\>copy nul C:\export\ServerStart\Floppy\"ServerStart Floppy Disk"

� If you wish to use the remote OS installation with the remote installation floppy disk, you need to install 

512MB or more memory on the target server. 

■ Checking Remote Resources

Check that the remote resource server is shared properly.

1 Start up "Command Prompt" on the remote resource server. Enter the following 

and press the [Enter] key.

prompt:>net share

Check that the created shared folder is displayed properly.

For the net command, refer to Windows Help.

■ Starting Installation

Start installation from the target server.

● In Guided Mode / Expert Mode

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Create a ServerStart floppy disk.

When the ServerStart floppy disk supplied with the server is used

1. Insert the ServerStart floppy disk supplied with the server. Make sure that 

"Removable media" and "A:" are selected and click [Create].

The network startup setting window for remote installation appears.
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2. Click [OK].

The [Initialization of ServerStart core running] window appears and unattended installation

will be started. Depending on the hardware configuration, this process may take a few 

minutes. When the process is completed, the [Create a ServerStart Floppy Disk] window 

appears.

3. Click [Build a ServerStart Floppy Disk].

Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy

disk has been created." message appears. 

When the remote floppy is used

1. Select "Remote (media)" and click [OK].

The [Network Startup Setting] window for remote installation appears.

2. Click [OK].

The [Specify Drive] window appears.

3. Enter [Remote path], [User name], and [Password] and click [OK].

The [Initialization of ServerStart core running] window appears and unattended installation

will be started. Depending on the hardware configuration, this process may take a few 

minutes. When the process is completed, the [Welcome to ServerStart] window appears.

3 Click [Click here to prepare and/or initiate an operating system installation].

The [Select the operating system to be installed] window appears. 
Click [Special Hints on Operating System Installation] and read the contents. Important 

information such as limitations on disk configuration is described.

4 Click [MS Windows Operating Systems].

The [Microsoft Windows Operating System Installation] window appears.

5 Select the OS to install and the mode.

6 Set items in wizards and save the configuration file.

For settings in wizards, refer to "3.1 Guided mode" (�pg.54) or "3.3 Expert Mode" (�pg.78). 
Set items in wizards and save the configuration file. When using the remote floppy, specify the 

path to the shared folder for the remote floppy as the configuration file saving location.

� Specify the shared name of the prepared shared folder instead of the local CD-ROM as instal-               

lation source information.

7 Click [Click here, to Start the Installation of (OS)].

Installation starts. At steps where the CD-ROM for resources such as the OS to be installed is 

necessary, the resource is automatically acquired from the resource server via the network.

When the installation is completed, an installation completion message appears on the target 

server.

8 Press any key on the target server.

9 Restart the system on the target server.



102

Chapter 3  OS Installation Using ServerStart

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform necessary procedures 

before starting server operations.

● In Preconfiguration Mode

1 Create a configuration file.

For the creation procedure, refer to "3.2 Preconfiguration Mode" (�pg.71).

� Specify the shared name of the prepared shared folder instead of the local CD-ROM as instal-               

lation source information.

2 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

3 Set the created configuration file and click [OK].

The [ServerStart Unattended Mode] window appears.

4 Click [Start].

Installation starts. At steps where the CD-ROM for resources such as the OS to be installed is 

necessary, the resource is automatically acquired from the resource server via the network.

5 Eject the CD-ROM and floppy disk and click [OK].

The system restarts. When the installation is completed, an installation completion message 

appears on the target server.

6 Press any key on the target server.

7 Restart the system on the target server.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform necessary procedures 

before starting server operations.
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3.5 Installation on Multiple (the 
Second and Subsequent) Servers

This chapter explains how to perform installation on multiple servers using 

ServerStart. 
By editing the configuration file created for installation on the first server, you can use 

it for installation on other servers of the same model and configuration. This reduces 

the setup time. However, installation on the first server must be performed using 

ServerStart in guided mode or preconfiguration mode.

� Check that ServerStart supplied with the first server is of the same version as that supplied with the 

other servers. If the version is different, this installation method will not work.

3.5.1 Preparation for Installation

■ Required Software

The following software is required for installation on the second and subsequent servers. Be sure to have 

these items close at hand.

• CD-ROM for the OS to be installed

• ServerStart CD-ROM

• ServerStart floppy disk

A: ServerStart floppy disk containing the configuration file used for installation on the first server

B: ServerStart floppy disks supplied with the ServerStart CD-ROMs for the second and subsequent 

servers 
If ServerStart floppy disks are not supplied, prepare as many floppy disks as there are servers.

• PRIMERGY Document & Tool CD (Disc 1) (for installing ServerView)

• Windows Service Pack CD-ROM 

■ Preparatory Procedure

Perform the following procedure before installation. 
Using Explorer or Command Prompt, copy the ServerStart floppy disk (A) to the ServerStart floppy disk 

(B).



104

Chapter 3  OS Installation Using ServerStart

3.5.2 Installation in Guided Mode

Edit the configuration file and perform installation in guided mode.

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk copied in the preparatory procedure into the 

floppy disk drive and click [Create].

The network setting window for remote installation appears.

3 Click [OK].

The [ServerStart FloppyBuilder] window appears.

4 Click [or Insert a ServerStart Floppy Disk to Start ServerStart].

The [Welcome to ServerStart] window appears.

5 Click [Click here to prepare and/or initiate an operating system installation].

The [Select the operating system to be installed] window appears. 

6 Click [MS Windows Operating Systems].

The [Microsoft Windows Operating System Installation] window appears.

7 Click the OS to install.

8 Click [Prepare & initiate an unattended installation of (OS)].

The guided mode starts.

9 Click [Start have to create a complete configuration file].

The [Open ServerStart Configuration File] window appears.

10 Specify "SerStartBatch.ini" on drive A and click [Create].

The display returns to the guided mode window.

For procedures from setting wizards to completion of installation, refer to "3.1 Guided mode" 

(�pg.54). 
When performing remote installation, refer to "3.4 Remote Installation" (�pg.85).
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Settings values in wizards

� Setting items in wizards are set to the values set on the first server. For installation on subse-                 

quent servers, you must change the following items in the "OS installation wizard". For other              

items, change the settings as necessary. You do not need to start up wizards where no settings                

will be changed.

� If the settings for the first server are not reflected to wizards, perform the procedures from               

copying the floppy disk over again.

3.5.3 Installation in Preconfiguration Mode

Edit the configuration file and perform installation in preconfiguration mode.

If ServerStart is not installed in the client computer where the preconfiguration mode is executed, refer 

to "2.4 Preparation for Using ServerStart on a Client Computer" (�pg.48) to install ServerStart. If a 

different version of ServerStart has been installed, uninstall it and install the proper version. For details 

on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" (�pg.51).

� ServerStart starts up when it is installed. However, be sure to follow these installation procedures. 

"3.2.1 Starting Up the Preconfiguration Mode" (�pg.71) Performing the procedure deletes the contents 

of the ServerStart floppy disk, making the disk unavailable for installation on multiple servers. 

1 Start up ServerStart.

If ServerStart has already been started, it is not necessary to restart it. If it has not, start it up 

according to the following procedures:

When the CD has been copied on Windows 2000 Professional/Windows XP 

Professional

1. Click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart].

ServerStart starts up and the [Welcome to ServerStart] window appears.

When Windows NT is used, or if the CD has not been copied

1. Insert the ServerStart CD-ROM into the client computer's CD-ROM drive.

ServerStart starts up and the [Welcome to ServerStart] window appears.

2 Select the OS to install.

The preconfiguration mode starts up.

table: Settings to be Changed for Installation on Subsequent Servers

Window 

name
Setting item name Remarks

User 

Information

Computer name The setting must be changed when the second 

and subsequent servers are on the same 

network as the first server.

Product ID/CD key The setting must be changed.

Network 

Protocol

IP address The setting must be changed when the second 

and subsequent servers are on the same 

network as the first server.
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3 Insert the ServerStart floppy disk copied in the preparatory procedure into the 

floppy disk drive and click [Start here to configuration file].

The [Open ServerStart Configuration File] window appears.

4 Specify "SerStartBatch.ini" on drive A and click [Create].

The display returns to the preconfiguration mode window.

For procedures from setting wizards to completion of installation, refer to "3.2 Preconfiguration 

Mode" (�pg.71). 
When performing remote installation, refer to "3.4 Remote Installation" (�pg.85).

Settings values in wizards

� Setting items in wizards are set to the values set on the first server. For installation on subse-                 

quent servers, you must change the following items in the "OS installation wizard". For other              

items, change the settings as necessary. You do not need to start up wizards where no settings                

will be changed.

� If the settings for the first server are not reflected to wizards, perform the procedures from               

copying the floppy disk over again.

table: Settings to be Changed for Installation on Subsequent Servers

Window 

name
Setting item name Remarks

User 

Information

Computer name The setting must be changed when the second 

and subsequent servers are on the same 

network as the first server.

Product ID/CD key The setting must be changed.

Network 

Protocol

IP address The setting must be changed when the second 

and subsequent servers are on the same 

network as the first server.
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Manual OS Installation  

This chapter explains how to install the OS 

without using ServerStart. 

4.1 Creating Driver Disks  . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

4.2 Starting Manual Installation  . . . . . . . . . . . . . . . . . . . . . . . 113

4.3 Installing the LAN Driver  . . . . . . . . . . . . . . . . . . . . . . . . . 120
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4.1 Creating Driver Disks

When installing the server manually, it is necessary to create driver installation disks 

beforehand. Also, driver disks must be created when you add an expansion card 

during server operation.

■ Preparation for Creating Driver Disks

You need floppy disks for driver disks. A floppy disk is necessary for each driver. 
Driver disks are created using the ServerStart FloppyBuilder function. The FloppyBuilder can be used 

under environments such as:

• Starting up the system from the ServerStart CD-ROM on the server

• Starting up the ServerStart system on a client computer (Recommended)

� When creating the tools on a client computer, it is necessary to install ServerStart on the client 

computer beforehand. Install it according to"2.4 Preparation for Using ServerStart on a Client 

Computer" (�pg.48). 
If a different version of ServerStart has been installed, uninstall it and install the proper version. For 

details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" (�pg.51).

� The FloppyBuilder function may not operate correctly if you start up ServerStart while ServerStart of a 

different version is installed in the computer. Make sure to uninstall a different version of ServerStart.

4.1.1 Required Driver Disks

The driver disks to be created differ depending on the OS to be installed.

■ For Windows Server 2003

*1: Created from the ServerStart CD-ROM 

table: Drivers Required for Installing Windows Server 2003

Expansion card / onboard controller Driver

Chipset Intel Chipset E7210 Ver5.1.0.1008

Graphic controller Standard driver provided with the OS

Onboard LAN PG-1852/1862/188x/189x LAN Driver for Windows 

2003 Ver8.3*1LAN card (PG-1852/PG-1862/ 
PG-1882L/PG-1892L)

RAID Ctrl 1-Channel 64MB (PG-141C1L) PG-141C (LSI Logic MegaRAID 320-1 Step2) Driver 

for Windows 2000/2003 V3.0L10 *1

SCSI Ctrl U160 lp (PG-130L) Standard driver provided with the OS

Other expansion cards Driver supplied with the expansion card
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■ For Windows 2000 Server 

*1: Created from the ServerStart CD-ROM 

� The latest drivers, refer to the Fujitsu PRIMERGY website (http://primergy.fujitsu.com).

4.1.2 How to Create Driver Disks

Driver disks are created from the ServerStart CD-ROM using the ServerStart FloppyBuilder function. 
If ServerStart has already been started, it is not necessary to restart it. If it has not, start it up according to 

the following procedures:

■ Starting ServerStart

● When Creating a DOS Floppy Disk on a Client Computer

When the CD has been copied on Windows 2000 Professional/Windows XP          

Professional

1 Click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart].

ServerStart starts up and the [Welcome to ServerStart] window appears.

table: Drivers Required for Installing Windows 2000 Server

Expansion card / onboard controller Driver

Chipset Intel Chipset E7210 Ver5.1.0.1008

Graphic controller RX100 S2 Onboard VGA Driver Ver5.0.2195.5005

Onboard LAN PG-1852/1862/188x/189x LAN Driver for Windows 

2000 Ver8.3 *1LAN card (PG-1852/PG-1862/ 
PG-1882L/PG-1892L)

RAID Ctrl 1-Channel 64MB (PG-141C1L) PG-141C (LSI Logic MegaRAID 320-1 Step2) Driver 

for Windows 2000/2003 V3.0L10 *1

SCSI Ctrl U160 lp (PG-130L) Standard driver provided with the OS

USB2.0 driver USB2.0 EHCI Driver V3616 for Windows 2000

Other expansion cards Driver supplied with the expansion card 

http://primergy.fujitsu.com
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When Windows NT is used, or if the CD has not been copied

1 Insert the ServerStart CD-ROM into the client computer's CD-ROM drive.

ServerStart starts up and the [Welcome to ServerStart] window appears.

● When Creating a DOS Floppy Disk on the Server

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Insert the attached "ServerStart floppy disk" into the server's floppy disk drive. 

Then make sure "Removable media" and "A:" are selected and click [Create].

A network setup window for remote installation appears.

� If a configuration file already exists in the ServerStart floppy disk and [OK] is clicked without               

clicking [Create], the [ServerStart Unattended Mode] window appears. Make sure to click           

[Exit]. The [Welcome to ServerStart] window appears.

If [Start] is clicked in the [ServerStart Unattended Mode] window, the installation of the server              

will start and all disk contents will be deleted.

3 Click [OK].

The [ServerStart FloppyBuilder] window appears.
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4 Click [or Insert a ServerStart Floppy Disk to Start ServerStart].

The [Welcome to ServerStart] window appears.

5 Eject the ServerStart floppy disk.



112

Chapter 4  Manual OS Installation

■ Creating Driver Disks

Start up ServerStart and confirm that the [Welcome to ServerStart] window is displayed.

1 Click [FloppyBuilder].

The [ServerStart FloppyBuilder] window appears.

2 Click [Drivers Diskettes].

The [FloppyBuilder Driver Disk] window appears.

3 Click the type of the driver you want to create.

4 Click the driver disk you want to create.

Follow the message and insert a floppy disk.

5 Perform the subsequent operations according to the messages on the window.

The floppy disk will be formatted automatically and file copying will start. 
The driver disk is automatically created. When a message appears indicating that the disk is 

created, click [OK] and eject the disk.
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4.2 Starting Manual Installation

This section explains the procedures for installing the OS manually.

4.2.1 Installing Windows Server 2003

1 Create driver disks.

Prepare necessary drivers before installing Windows Server 2003.

Some drivers are created from the ServerStart CD-ROM. For how to create driver disks, refer to 

"4.1 Creating Driver Disks" (�pg.108). 

2 If a RAID card is installed, configure the MegaRAID disk array. 

Turn the server power on. When the following message appears, press the [Ctrl] key and the [H] 

key. 

When the utility has started, configure the RAID0 or RAID1 disk.  
After configuring the array, turn the server off. 

3 Insert the Windows Server 2003 CD-ROM.

Turn on the server and insert the Windows Server 2003 CD-ROM immediately into the CD-ROM 

drive. Check there are no floppy disks in the floppy disk drive. When the active area is specified 

on the hard disk, the following message appears.

Pressing any key while this message is displayed boots the system from the CD-ROM.

Press <Ctrl-H> for WebBIOS

Press any key to boot from CD....
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4 The [Windows Server 2003 Setup] window appears.

The procedure differs depending on the connection of the installation hard disk. 

When installing the OS on a hard disk connected via the RAID card: 

Immediately, the following message appears at the bottom of the window. Press the [F6] key.

� This message will be displayed for a short time after the setup window (blue screen) appears.               

Press the [F6] key immediately after the window turns blue.

When installing the OS on a hard disk connected via the SCSI card: 

Proceed to Step 6. 

5 Install the RAID drivers manually. 

1. When the following message appears, press the [S] key.

2. When the "Please insert the disk labeled Manufacturer-supplied hardware support 

disk into Drive A:" message appears, insert the driver disk created from the 

ServerStart CD-ROM and press the [Enter] key. 

The following message appears.

3. Select the following and press the [Enter] key.

4. When the following message appears, press the [S] key.

5. Follow the window instructions to perform installation. 

When a message prompting you to insert a floppy disk appears, insert the driver disk 

created from the ServerStart CD-ROM and press the [Enter] key. 

6 Follow the instructions from the setup program to continue the installation 

procedures.

If a message indicating that the driver has failed in the Windows logo test for validating the 

compatibility with Windows appears, select [Yes] to continue the installation procedure.

Press F6 if you need to install a third party 

SCSI or RAID driver...

To specify additional SCSI adapters, CD-ROM drives, 
or special disk controllers for use with Windows 
, including those for which you have a device 
support disk from a mass storage device 
manufacturer, press S.

You have chosen to configure a SCSI Adapter for use with 

Windows, using a device support disk provided by an 

adapter manufacturer. 
Select the SCSI Adapter you want from the following list, 

or press ESC to return to the  
previous screen.

LSI MEGARAID Products for Windows 2003 (x86)

The driver you provided seems to be newer than the Win-

dows default driver.
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7 Install the chipset driver.

1. Insert the ServerStart CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.

2. Execute the following command on the ServerStart CD-ROM.

[CD-ROM drive]:\DRIVERS\ChipSet\Intel\E7210\Setup.exe

The installation wizard starts up.

3. Click [Next]. Follow instructions in the window to perform installation.

4. When the "InstallShield(R) wizard has completed." message appears, eject the 

ServerStart CD-ROM from the CD-ROM drive and click [Finish] to restart the 

system. 

8 Install the LAN driver.

Install the LAN driver using the driver disk created from the ServerStart CD-ROM. For more 

details, refer to "4.3.1 Installing the LAN Driver (Windows Server 2003)" (�pg.120).

9 Apply Windows Server 2003 Service Pack 1.

For details, refer to the description in the window.  
Drivers may be replaced with those in the Service Pack during Service Pack application. For 

more details, refer to the manual supplied with the hardware.

10 Install high reliability tools.

To ensure stable server operation, refer to "Chapter 6 High Reliability Tools" (�pg.155) and 

install high reliability tools. 

The installation of Windows Server 2003 has completed.

● Before Starting Operation

After OS installation, refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform the 

necessary procedures.
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4.2.2 Installing Windows 2000 Server

1 Create driver disks.

Prepare necessary drivers before installing Windows 2000 Server.

Some drivers used with Windows 2000 Server are created from the ServerStart CD-ROM. For 

how to create driver disks, refer to "4.1 Creating Driver Disks" (�pg.108). 

2 If a RAID card is installed, configure the disk array. 

Turn the server power on. When the following message appears, press the [Ctrl] key and press the 

[H] key. 

When the utility has started, configure the RAID0 or RAID1 disk.  
After configuring the array, turn off the server.

3 Insert the Windows 2000 Server CD-ROM.

Turn on the server and insert the Windows 2000 Server CD-ROM immediately into the CD-ROM 

drive. Check there are no floppy disks in the floppy disk drive. When the active area is specified 

on the hard disk, the following message appears.

Pressing any key while this message is displayed boots the system from the CD-ROM.

4 The [Windows 2000 Server Setup] window appears.

Immediately, the following message appears at the bottom of the window. Press the [F6] key. 

� This message will be displayed for a short time after the setup window (blue screen) appears.               

Press the [F6] key immediately after the window turns blue.

5 Install the RAID drivers manually.

1. When the following message appears, press the [S] key. 

Press <Ctrl><H> for WebBIOS

Press any key to boot from CD....

Press F6 if you need to install a third party SCSI or RAID 

driver...

To specify additional SCSI adapters, CD-ROM drives, 
or special disk controllers for use with Windows 
2000, including those for which you have a device 
support disk from a mass storage device 
manufacturer, press S.
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2. When the "Please insert the disk labeled Manufacturer-supplied hardware support 

disk into Drive A:" message appears, insert the driver disk created from the 

ServerStart CD-ROM and press the [Enter] key. 

The following message appears.

3. Select the following. 

4. When the following message appears, press the [S] key.

5. Follow the window instructions to perform installation.

When a message prompting you to insert a floppy disk appears, insert the driver disk 

created from the ServerStart CD-ROM and press the [Enter] key. 

6 Follow the instructions from the setup program to continue the installation 

procedures.

Cautions on Restarting

� In the course of installation, a message appears to indicate that the setup program restarts.              

Wait until it restarts automatically.

7 Install the chipset driver.

1. Insert the ServerStart CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.

2. Execute the following command on the ServerStart CD-ROM.

[CD-ROM drive]:\DRIVERS\ChipSet\Intel\E7210\Setup.exe

The installation wizard starts up.

3. Click [Next]. Follow instructions in the window to perform installation.

4. When the "InstallShield(R) wizard has completed." message appears, remove the 

ServerStart CD-ROM from the CD-ROM drive and click [Finish] to restart the 

system. 

8 Install the LAN driver.

Install the LAN driver using the driver disk created from the ServerStart CD-ROM. For more 

details, refer to "4.3.2 Installing the LAN Driver (Windows 2000 Server)" (�pg.123).

You have chosen to configure a SCSI Adapter for use 
with Windows 2000, using a device support disk 
provided by an adapter manufacturer. 
 Select the SCSI Adapter you want from the following  
list, or press ESC to return to the previous screen.

LSI MEGARAID Products for Windows 2000

The driver you provided seems to be newer than the Win-

dows default driver.
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9 Install the USB 2.0 driver.

The procedure differs depending on whether Service Pack 4 is applied to the CD-ROM for the 

OS used. 

When Service Pack 4 is applied

1. Insert the ServerStart CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.

2. Click [Start] → [Administrative Tools] → [Computer Management].

3. Click [Device Manager] from the displayed list.

4. Double-click [USB 2.0 Root Hub] under [Universal Serial Bus (USB) controller]. 

The properties window appears.

5. Click the [Driver] tab and click [Update Driver].

The [Device Driver Upgrade Wizard] window appears.

6. Click [Next].

7. Select [Find an optimum driver] and click [Next]. 

8. Select only [CD-ROM drive] and click [Next]. 

9. Select [Install another driver] and click [Next]. 

10. Select [USB 2.0 Root Hub] and click [Next]. 

When the installation is completed, a completion message appears. 

11. Click [Finish].

12. Click [Close] to close the properties window.

When Service Pack 4 is not applied

1. Insert the ServerStart CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.

2. Click [Start] → [Administrative Tools] → [Computer Management].

3. Click [Device Manager] from the displayed list.

4. Double-click [Universal Serial Bus (USB) controller] under [Other devices]. 

The properties window appears.

5. Click [Reinstall Driver] in the [General] tab window.

The [Device Driver Upgrade Wizard] window appears.

6. Click [Next].

7. Select [Install an optimum driver (Recommended)] and click [Next].

The [Identify Driver File] window appears.

8. Check [CD-ROM drive] and click [Next]. 

Detected drivers are displayed.

9. Click [Next].

Driver installation starts. When it is completed, a completion window appears.

10. Click [Finish].

11. Click [Close] to close the properties window.
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10 Install the display driver.

1. Insert the ServerStart CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.

2. Right-click the [My Computer] icon on the desktop and click [Manage] from the 

displayed menu.

3. Click [Device Manager] from the displayed list.

4. Double-click [ATI Technologies Inc. RAGE XL PCI] under [Display Adapter].

The properties window appears.

5. Click the [Driver] tab and click [Update Driver].

The [Start Device Driver Upgrade] window appears.

6. Click [Next].

The [Install Hardware Device Driver] window appears.

7. Select [Find an optimum driver (Recommended)] and click [Next].

The [Identify Driver File] window appears.

8. Select [CD-ROM drive] in [Search location options] and click [Next].

9. When a message indicating that the driver has been found appears in the [Find 

Driver File] window, click [Next].

When the installation is completed, a completion message appears.

10. Click [Finish].

11. Click [Close] to close the properties window.

12. Eject the ServerStart CD-ROM from the CD-ROM drive and restart the system to 

make the settings effective.

11 After driver installation, apply Windows 2000 Service Pack.

For details, refer to the description in the window.  
Drivers may be replaced with those in the Service Pack during Service Pack application. For 

more details, refer to the manual supplied with the hardware.

12 Install high reliability tools.

To ensure stable server operation, refer to "Chapter 6 High Reliability Tools" (�pg.155) and 

install high reliability tools. 

The installation of Windows 2000 Server has completed.

● Before Starting Operation

After OS installation, refer to "Chapter 5 Operations after OS Installation" (�pg.125) and perform the 

necessary procedures.

4.2.3 Installing Linux

For the use of Linux, refer to the Fujitsu PRIMERGY website (http://primergy.fujitsu.com). 

http://primergy.fujitsu.com


120

Chapter 4  Manual OS Installation

4.3 Installing the LAN Driver

This section explains the procedure for installing the driver. 
In addition to the case where the OS is installed manually, the driver must be installed 

when a LAN card is added.

4.3.1 Installing the LAN Driver (Windows Server 2003)

The LAN driver installation procedure differs depending on whether the network adapter was 

recognized during the OS installation.

� For the following LAN cards, the network adapter is recognized when the card is mounted during OS 

installation.

• PG-1852

• PG-1862

1 Click [Start] → [Administrative Tools] → [Computer Management].

2 Click [Device Manager].

On the Device Manager list, check if a recognized network adapter is present.

(Window example)

When a recognized network adapter is present, [Network adapters] appears.

Recognized 
network adapter

Unrecognized 
network adapter
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• When a recognized network adapter is present

Perform "■ Updating LAN Drivers" (�pg.121) on the LAN device name under [Network 

adapters], then "■ Installing the LAN Driver" (�pg.122) on [Ethernet controller] under [Other 

devices]. 

When the LAN driver is installed to [Other devices] before updating the driver for             

the network adapter recognized immediately after the OS installation

� When driver installation starts, the following window appears.

Clicking [Finish] displays the [Help and Support Center] window. Click [X] to close the window.

After installation, the "!" mark is displayed at the LAN device name in Device Manager. Device               

names are displayed properly when all LAN drivers are installed and the system is restarted.

• When a recognized network adapter is not present

Perform "■ Installing the LAN Driver" (�pg.122) on [Ethernet controller] under [Other 

devices]. 

■ Updating LAN Drivers

Perform the following procedures on all LAN device names under [Network adapters] in [Device 

Manager].

1 Double-click a LAN device name under [Network adapters].

� Names of the LAN devices are displayed as follows.

2 Insert the driver disk created from the ServerStart CD-ROM into the server 

according to the installed LAN device. 

3 Double-click the LAN device icon. 

The properties are displayed. 

table: LAN device name

LAN cards LAN device name

PG-1852 Intel(R) PRO/1000 MT Desktop Adapter

PG-1862 Intel(R) PRO/1000 MT Dual Port Server Adapter
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4 Click [Update Driver] in the [Driver] tab window.

The [Welcome to the Hardware Update Wizard] window appears.

5 Select [Install the software automatically] and click [Next].

The driver will be installed.

6 Click [Finish].

7 Click [Close].

■ Installing the LAN Driver

Perform the following procedures on each [Ethernet controller] under [Other devices] in [Device 

Manager].

1 Insert the driver disk created from the ServerStart CD-ROM into the server.

2 Double-click [Ethernet controller] under [Other devices].

The properties window for the Ethernet controller appears.

3 Click [Reinstall Driver] in the [General] tab window.

The [Device Driver Upgrade Wizard] window appears.

4 Select [Install the software automatically (Recommended)] and click [Next].

The driver will be installed.

5 Click [Finish].

6 Click [Close] to close the properties window.

7 Eject the driver disk and restart the system.

� Names of the LAN devices are displayed as follows.

table: LAN device name

LAN cards LAN device name

Onboard LAN (1000BASE-T) Intel(R) PRO/1000 CT NetWork Connection

PG-1852 Intel(R) PRO/1000 MT Desktop Adapter

PG-1862 Intel(R) PRO/1000 MT Dual Port Server Adapter

PG-1882L Intel(R) PRO/1000 MF Server Adapter (LX)

PG-1892L Intel(R) PRO/1000 MT Server Adapter
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4.3.2 Installing the LAN Driver (Windows 2000 Server)

1 Insert the driver disk created from the ServerStart CD-ROM into the server.

2 Right-click the [My Computer] icon on the desktop and select [Manage] from 

the displayed menu.

3 Click [Device Manager].

As many [Ethernet controller] items as the installed LAN ports are displayed under [Other 

devices].

Double-click each [Ethernet controller] item and perform the following Steps 4 to 11 on all LAN 

ports.

4 Double-click [Ethernet controller] under [Other devices].

The properties window for the Ethernet controller appears.

5 Click [Reinstall Driver] in the [General] tab window.

The [Device Driver Upgrade Wizard] window appears.

6 Click [Next].

7 Select [Install an optimum driver (Recommended)] and click [Next].

The [Identify Driver File] window appears.

8 Select [Floppy disk drive] in [Search location options] and click [Next].

Detected drivers are displayed.

9 Click [Next].

Driver installation starts. When it is completed, a completion window appears.

10 Click [Finish].

11 Click [Close].

� When [Ethernet controller] items are displayed under [Other devices], perform the above Steps            

4 to 11 on all [Ethernet controller] items.

12 Eject the driver disk and restart the system.

� The following window may appear at system startup after addition of a LAN card. Perform the               

appropriate procedure according to the displayed window.

•When the "New Hardware Detection Wizard" window appears

Insert the driver disk created from the ServerStart CD-ROM and perform Step 6 and             

subsequent steps.
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•When the [Insert Disk] window prompts you to insert the "Intel PRO Adapter CD-ROM or               

floppy disk" or "Intel® PRO/1000 Disk Driver".

Insert the driver disk created from the ServerStart CD-ROM and install the driver.

� The "Digital signature was not found" message may appear. If it appears, click [Yes] to con-               

tinue the operations.

� When the [Overwriting the Files] window appears, normally do not overwrite the files (select             

[Do not overwrite all files]).

� After LAN driver installation, names of the LAN devices are displayed as follows.

4.3.3 Latest Drivers

The latest drivers, refer to the Fujitsu PRIMERGY website (http://primergy.fujitsu.com).

table: LAN device name

LAN cards LAN device name

Onboard LAN (1000BASE-T) Intel(R) PRO/1000 CT NetWork Connection

PG-1852 Intel(R) PRO/1000 MT Desktop Adapter

PG-1862 Intel(R) PRO/1000 MT Dual Port Server Adapter

PG-1882L Intel(R) PRO/1000 MF Server Adapter (LX)

PG-1892L Intel(R) PRO/1000 MT Server Adapter

http://primergy.fujitsu.com


125

Chapter 5 

Operations after OS  
Installation

This chapter explains the operations to be 

performed after OS installation. Be sure to 

perform these operations before operating the 

server.

5.1 Memory Dump/Paging File Setting . . . . . . . . . . . . . . . . . . 126

5.2 Creating a Disk for System Recovery . . . . . . . . . . . . . . . . 135

5.3 Storing the System Setting Information  . . . . . . . . . . . . . . 137

5.4 Creating Maintenance Tools  . . . . . . . . . . . . . . . . . . . . . . 141

5.5 Notes Before Operating the Server  . . . . . . . . . . . . . . . . . 146

5.6 LAN Driver Advanced Setup  . . . . . . . . . . . . . . . . . . . . . . 150
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5.1 Memory Dump/Paging File 
Setting

Before start operating this server, configure the setting for obtaining memory dump. 

The setting procedure varies between Windows Server 2003 and Windows 2000 

Server.

● Memory Dump

If memory dump is set, debugging information will be automatically saved when a STOP error (fatal 

system error) occurs in the system. Using the saved memory dump, error cause can be analyzed. 
If the amount of installed memory is large, pay special attention when setting the memory dump file. 

The settings for obtaining memory dump should be configured after installing the files to be used for 

operations (OS, applications, etc.).

5.1.1 How to Obtain Memory Dump 
For Windows Server 2003

Check the following settings before starting configuration to obtain memory dump.

■ Checking Hard Disk Free Space

To obtain memory dump, sufficient hard disk capacity is required for creating paging files and memory 

dump files. 
The obtainable dump types and required hard disk capacity are as follows:

● Complete Memory (Full) Dump

When the system unexpectedly stops, contents of the whole system memory are recorded. The file is 

stored in the directory displayed in the [Dump file] box.

• Paging file: Installed physical memory + 11MB (Recommended: Installed physical memory x 1.5)

• Memory dump file: Same amount as installed physical memory

● Kernel Memory Dump

Information of only kernel memory space is recorded. The file is stored in the directory displayed in the 

[Dump file] box. Capacity required for kernel memory dump is as follows:

• Paging file: Depending on installed physical memory amount

For memory of 256 to 1,373MB - Installed physical memory × 1.5
For memory of 1,374MB or more - 32-bit system: 2GB + 16MB  
64-bit system: RAM size + 128MB

• Memory dump file: Depending on the used amount of kernel-mode address space during STOP
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● Small Memory Dump

Minimum amount of useful information for problem identification is recorded. If this option is specified, 

a new file is created each time the system unexpectedly stops. 
History of such files is stored in the directory displayed in [Small dump directory].

• Paging file: 2MB or more

• Memory dump file: 64KB or 128KB

■ Memory Dump File Setting

Set up the memory dump file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the memory dump file is to be stored.

Check the required amount of free space according to "■ Checking Hard Disk Free Space" 

(�pg.126).

If the drive has no free space, refer to "■ Cannot Collect the Memory Dump" (�pg.235).

3 Click [Start] → [Control Panel] → [System].

The [System Properties] window appears.

4 Click the [Advanced] tab and click [Settings] in [Startup and Recovery].

The [Startup and Recovery] window appears.
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5 Set as follows:

1. In the [Write debugging information] section, select the memory dump file type.

• Small memory dump (64KB)

Minimum information is recorded to the memory dump file.

Each time a fatal error occurs, a new file is created in the directory specified in [Small 

dump directory].

• Kernel memory dump

Only kernel memory is recorded to the memory dump file.

• Complete memory dump (Recommended)

The whole system memory information is recorded to the memory dump file.

2. In [Dump file] or [Small dump directory], specify the directory to save the memory 

dump file, with its full path.

In case of kernel memory dump or complete memory dump, if [Overwrite any existing file] 

is checked, debugging information is overwritten to the specified file every time.

6 Click [OK] to close the [Startup and Recovery] window.

7 Restart the system.

The setting is enabled after the system is restarted.

8 Click [OK] to close the [System Properties] window.

■ Paging File Setting

Set up the paging file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the system is installed.

Check the required amount of free space according to "■ Checking Hard Disk Free Space" 

(�pg.126).

If the drive has no free space, refer to "■ Cannot Collect the Memory Dump" (�pg.235).

3 Click [Start] → [Control Panel] → [System].

The [System Properties] window appears.

4 Click the [Advanced] tab and click [Settings] in [Performance].

The [Performance Options] window appears.
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5 Click the [Advanced] tab.

6 Click [Change] in the [Virtual memory] section.

The [Virtual Memory] window appears.

7 Specify the drive where the paging file is to be created.

In [Drive], select the drive where the system is installed.

The selected drive is displayed in [Drive] in [Paging file size for selected drive].
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8 Select [Custom size] and enter a value in [Initial size].

The value depends on the type of the set dump file.

Specify a value larger than the value shown in [Recommended] in [Total paging file size for all 

drives].

� When a smaller value is specified for the paging file size, performance may be affected. For               

maximum system efficiency, be sure to set [Initial size] with a value larger than the [Recom-               

mended] size described in [Total paging file size for all drives]. The recommended size is total               

memory installed in the system × 1.5. However, if a program consuming a large amount of               
memory is regularly used, set a larger size as required.

9 Enter a value in [Maximum size].

Specify a value larger than the [Initial size].

10 Save the settings.

Click [Set] in the [Paging file size for selected drive] section.

The settings are saved, and the value specified is displayed in [Paging File Size] of [Drive].

11 Click [OK] to close the [Virtual Memory] window.

12 Click [OK] to close the [Performance Options] window.

13 Click [OK] to close the [System Properties] window.

14 Restart the system.

The setting is enabled after the system is restarted.

5.1.2 How to Obtain Memory Dump 
(For Windows 2000 Server)

Check the following settings before starting configuration to obtain memory dump.

■ Checking Hard Disk Free Space

Once memory dump is obtained, a file containing contents of the whole physical memory installed in the 

system is created. Before storing the dump file, confirm that there is sufficient free space in the hard 

disk. 
The obtainable dump types and required hard disk capacity are as follows:

● Complete Memory (Full) Dump

When the system unexpectedly stops, contents of the whole system memory are recorded. If this option 

is selected, space to retain the paging file as large as the whole physical memory × 1.3 is required in the 
boot volume.

• Included information

Common header, all virtual address pages that are not paged out during STOP
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• Required size

Installed physical memory × 1.3

● Kernel Memory Dump

Information of only kernel memory space is recorded. When the system unexpectedly stops, the process 

that records information to the log file is speeded up. According to the amount of memory installed in 

the server, available area of 50 to 800MB is required for the paging file in the boot volume.

• Included information

Common header, summary dump header (complete memory dump) - (user process space page) - 

(cache region page) - (unused pool region page)

• Required size

Depending on the used amount of kernel-mode address space during STOP

● Small Memory Dump

Minimum amount of useful information for problem identification is recorded. In this option, a paging 

file of at least 2MB is required in the boot volume. Also, a new file is created each time the system 

unexpectedly stops. 
History of such files is stored in the directory displayed in [Small dump directory] (usually, 

C:\winnt\minidump).

• Included information

Common header, minidump header, kernel module, memory information, processor information, 

process information, thread information, stuck page, unloaded module information

• Required size

2MB or more

■ Memory Dump File Setting

Set up the memory dump file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the memory dump file is to be stored.

Check the required amount of free space according to "■ Checking Hard Disk Free Space" 

(�pg.130).

If the drive has no free space, refer to "■ Cannot Collect the Memory Dump" (�pg.235).

3 Click [Start] → [Settings] → [Control Panel].

4 Double-click the [System] icon.

The [System Properties] window appears.
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5 Click the [Advanced] tab and click [Startup and Recovery].

The [Startup and Recovery] window appears.

6 Set as follows:

1. In the [Write debugging information] section, select the memory dump file type.

• Small memory dump (2MB or more)

Minimum information is recorded to the memory dump file. 
Each time a fatal error occurs, a new file is created in the directory specified in [Small 

dump directory].

• Kernel memory dump

Only kernel memory is recorded to the memory dump file.

• Complete memory dump (Recommended)

The whole system memory information is recorded to the memory dump file.

2. In [Dump file] or [Small dump directory], specify the directory to save the memory 

dump file, with its full path.

In case of kernel memory dump or complete memory dump, if [Overwrite any existing file] 

is checked, debugging information is overwritten to the specified file every time.

7 Click [OK] to close the [Startup and Recovery] window.

8 Click [OK] to close the [System Properties] window.

9 Restart the system.

The setting is enabled after the system is restarted.
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■ Paging File Setting

Set up the paging file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the system is installed.

Check the required amount of free space according to "■ Checking Hard Disk Free Space" 

(�pg.130). If the drive has no free space, refer to "■ Cannot Collect the Memory Dump" 

(�pg.235).

3 Click [Start] → [Settings] → [Control Panel].

4 Double-click the [System] icon.

The [System Properties] window appears.

5 Click the [Advanced] tab and click [Performance Options].

The [Performance Options] window appears.

6 Click [Change] in the [Virtual memory] section.

The [Virtual Memory] window appears.
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7 Specify the drive where the paging file is to be created.

In [Drive], select the drive where the system is installed.

The selected drive is displayed in [Drive] in [Paging file size for selected drive].

8 Specify the [Initial size].

The value depends on the type of the set dump file.

Specify a value larger than the value shown in [Recommended] in [Total paging file size for all 

drives].

� When a smaller value is specified for the paging file size, performance may be affected. We               

recommend to specify the paging file size larger than the recommended value.

9 Specify the [Maximum size].

Specify a value larger than the [Initial size].

10 Save the settings.

Click [Set] in the [Paging file size for selected drive] section.

The settings are saved, and the value specified is displayed in [Paging File Size] of [Drive].

11 Click [OK] to close the [Virtual Memory] window.

12 Click [OK] to close the [Performance Options] window.

13 Click [OK] to close the [System Properties] window.

14 Restart the system.

The setting is enabled after the system is restarted.
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5.2 Creating a Disk for System 
Recovery

If the installation of the OS was performed manually, create a system recovery disk.

� If the system file, system configuration or environment setting change at startup, etc., are damaged, 

such data can be reconstructed using the recovery information stored in the created system recovery 

disk.

� To create a recovery disk, you need an unused formatted floppy disk. Prepare it in advance.

5.2.1 Creating the Automated System Recovery (ASR) Set 
For Windows Server 2003

After setting up Windows Server 2003, create a system recovery set. To do this, you need an unused 

formatted floppy disk and a medium to store back up files.

1 Click [Start] → [All Programs] → [Accessories] → [System Tool] → [Backup].

The [Backup or Recovery Wizard] window appears.

2 Click [Next].

The [Backup or Recovery] window appears.

3 Select [Create a backup of files and settings], and then click [Next].

The [Items to Create Backups] window appears

4 Select [All the information in this computer], and then click [Next].

The [Backup Type, Destination and Name of the Backup File] window appears.

5 Specify name and destination of the backup file, and then click [Next].

The [Backup or Recovery Wizard Complete] window appears.

6 Click [Finish].

Backup process starts.

7 If a message prompting you to insert a floppy disk appears, insert the floppy 

disk and click [OK].

Automated system recovery disk is created.
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8 When the process is completed, a message appears. Eject the floppy disk 

according to the message and put a label on it.

Label example: Windows Automated System Recovery Disk: Backup.bkf, Created at 12:00 04/

01/2005

9 Click [OK] to exit [Backup Utility].

10 Click [Close] to close the [Backup Progress] window.

An automated system recovery set has been created.

Store the automated system recovery set just created in a secure location.

5.2.2 Creating a System Recovery Disk 
For Windows 2000 Server

After setting up Windows Server 2000, create a system recovery disk. To do this, you need an unused 

formatted floppy disk.

1 Put a label showing "Windows 2000 system recovery disk" onto a floppy disk 

and insert it into the floppy disk drive.

2 Click [Start] → [Programs] → [Accessories] → [System Tools] → [Backup].

The backup window appears.

3 Click the [Wizard] tab and click [System Recovery Disk].

Create a system recovery disk by following the window instructions.
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5.3 Storing the System Setting 
Information

Before starting operations, store the configuration information of the BIOS setup 

utility. By storing this information, the system can be recovered with the stored 

information in case of a system failure (such as when the information is deleted due 

to the drain of the built-in battery). Use Server Management Tools for storing and 

recovering the system configuration information.

� Be sure to store the BIOS information after the following operations:

• When the information is changed with the BIOS setup utility

• When the hardware configuration of this server is changed (e.g. a CUP, memory, baseboard or 

expansion card is added/removed or changed)

� As the stored system configuration information will be used during maintenance, etc., send it to your 

maintenance personnel.

■ Preparation for Using Server Management Tools

Before using Server Management Tools, prepare the "Server Management Tools" disk supplied with the 

server at hand.

■ Notes

• Server Management Tools are for this server only. Do not use those tools on other systems. If it is 

used, the system can be damaged.

• Only the information that is configured with the BIOS setup utility can be stored/recovered with 

Server Management Tools. The BIOS information in internal SCSI devices or expansion cards 

cannot be stored/recovered.

• Make sure to start up the server with the "Server Management Tools" disk before running Server 

Management Tools. Do not run Server Management Tools on the server started from the hard disk or 

by the other floppy disks. Otherwise, the system may be corrupted.

• Do not eject a floppy disk while the floppy disk access LED is on. Such an action may lead not only 

to corruption of the floppy disk data but also an unstable state of the system.

• If an error message appears while running Server Management Tools, respond to the message 

according to "■ Server Management Tools Error Messages" (�pg.229).



138

Chapter 5  Operations after OS Installation

5.3.1 How to Store the BIOS Information

Store the BIOS information according to the following procedures:

� Before starting the operation, if the "OS Boot Monitoring" function of ServerView is enabled, disable it 

(it is disabled by default). 
If you start up the system while the "OS Boot Monitoring" function remains effective, the operation of 

the server may become unpredictable at such times as an abrupt power interruption or restart. 
If it is necessary to operate the server with the "OS Boot Monitoring" function enabled, enable the 

function after storing the BIOS information.  
For details of ServerView, refer to "ServerView User's Guide".

1 Turn on the server and insert the "Server Management Tools" disk into the 

floppy disk drive.

The window for selecting a keyboard appears.

2 Select a keyboard.

Select "1" for the Japanese keyboard or "2" for the English keyboard. The Japanese keyboard is 

selected by default.

3 When the DOS prompt window appears, enter the following command and 

press the [Enter] key.

A:\SMT>biossave.bat

� If storing has already been performed with Server Management Tools, the stored file must exist              

in the floppy disk. In this case, overwriting the file may lead to incompletion of BIOS information                

recovery. Move the file to another floppy disk, rename the file, or delete it by executing the fol-                 

lowing command. 
A:\SMT>deldat.bat [Enter]

4 If the BIOS information is stored correctly, the following message appears.

5 Check that the storing information file has been created.

Execute the following command to confirm that "*.SCS" (this file name varies depending on the 

BIOS version), "ONLINE.DAT," "OFFLINE.DAT," "LAN_CFG.DAT" and "MUX_CONF.DAT" 

files have been created.

A:\SMT>dir

Storing procedure is completed. The server can now be turned off safely.

Please select: 
   1 = JP Keyboard 
   2 = US Keyboard 
Your selection

NORMAL END
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5.3.2 Recovering the BIOS Information

If the information configured with the BIOS setup utility was deleted due to a drain of the built-in server 

battery, etc., restore the BIOS information according to the following procedures:

� Do not turn off the server during a program run.

� Before starting the system, check to see that the "OS Boot Monitoring" function of ServerView is 

disabled (default setting). 

If you start up the system while the "OS Boot Monitoring" function remains effective, the operation of 

the server may become unpredictable at such times as an abrupt power interruption or restart. 
If the "OS Boot Monitoring" function is needed, it should be reset to enabled before resuming normal 

server operation. For details of ServerView, refer to "ServerView User's Guide".

1 Turn on the server and insert the "Server Management Tools" disk into the 

floppy disk drive.

The window for selecting a keyboard appears.

2 Select a keyboard.

Select "1" for the Japanese keyboard or "2" for the English keyboard. The Japanese keyboard is 

selected by default.

3 When the DOS prompt window appears, execute the following command to 

check that the BIOS storing information file has been saved on the floppy disk.

Execute the following command to confirm that "*.SCS" (this file name varies depending on the 

BIOS version), "ONLINE.DAT," "OFFLINE.DAT," "LAN_CFG.DAT" and "MUX_CONF.DAT" 

files exist.

A:\SMT>dir

4 Enter the following command and press the [Enter] key.

A:\SMT>biosrest.bat

5 If the BIOS information is restored correctly, the following message appears.

Please select: 
   1 = JP Keyboard 
   2 = US Keyboard 
Your selection

NORMAL END



140

Chapter 5  Operations after OS Installation

6 If the following have been set in the BIOS Setup Utility, restart the system and 

repeat Steps 1 to 4.

The following settings when [Advanced] menu → [PCI Configuration] submenu → [Ethernet on 

Board] submenu → [PCI Device, Embedded Ethernet A] and [PCI Device, Embedded Ethernet 

B] are selected 

When checking the settings of the BIOS Setup Utility, refer to "8.2 BIOS Setup Utility" 

(�pg.191) and "■ Ethernet on Board Submenu" (�pg.203).

7 The BIOS information will be enabled after the next system restart. Restart the 

server.

Perform Step 1 to display the DOS prompt window. The restoration procedure has been 

completed. The server can now be turned off safely.

table: BIOS Setup Utility Setting

Item name Setting

Device Enabled

Option ROM Scan Enabled
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5.4 Creating Maintenance Tools

This section explains how to create tools for maintaining the server. 
Maintenance tools are created with the FloppyBuilder function of ServerStart.

With the FloppyBuilder function of ServerStart, you can create the following tools:

• DOS floppy disks

• Hardware Configuration Tools (such as Server Management Tools)

The FloppyBuilder can be used under environments such as:

• the system started on the server using the ServerStart CD-ROM

• the ServerStart system started on a client computer (recommended)

� When creating the tools on a client computer, install ServerStart on the computer beforehand. Install 

ServerStart according to "2.4 Preparation for Using ServerStart on a Client Computer" (�pg.48). 
If ServerStart of a different version is installed in the computer, make sure to uninstall the ServerStart. 

Then perform installation again. For details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling 

ServerStart" (�pg.51).

� The FloppyBuilder function may not operate correctly if you start up ServerStart while ServerStart of a 

different version is installed in the computer. Make sure to uninstall a different version of ServerStart.

5.4.1 Creating a DOS Floppy Disk

For DOS data stored into the floppy disk, refer to the file in the following folder of the ServerStart CD-

ROM.  
[CD-ROM drive]:\FreeDOS

To create a DOS floppy disk, you need an unused floppy disk. Prepare it in advance.

If ServerStart has already been started, it is not necessary to restart it. If it has not, start it up according to 

the following procedures:
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■ Starting ServerStart

● For Creation on a Client Computer

When the CD has been copied on Windows 2000 Professional/Windows XP          

Professional

1 Click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart].

ServerStart starts up and the [Welcome to ServerStart] window appears.

When Windows NT is used, or if the CD has not been copied

1 Insert the ServerStart CD-ROM into the client computer's CD-ROM drive.

ServerStart starts up and the [Welcome to ServerStart] window appears.

● For Creation on the Server

1 Turn on the server and insert the ServerStart CD-ROM immediately.

ServerStart starts up and a message appears prompting you to insert the ServerStart floppy disk.

2 Insert the attached "ServerStart floppy disk" into the server's floppy disk drive. 

Then make sure "Removable media" and "A:" are selected and click [Create].

A network setup window for remote installation appears.

� If a configuration file already exists in the ServerStart floppy disk and [OK] is clicked without               

clicking [Create], the [ServerStart Unattended Mode] window appears. Make sure to click           

[Exit]. The [Welcome to ServerStart] window appears.

If [Start] is clicked in the [ServerStart Unattended Mode] window, the installation of the server              

will start and all disk contents will be deleted.
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3 Click [OK].

The [ServerStart FloppyBuilder] window appears.

4 Click [or Insert a ServerStart Floppy Disk to Start ServerStart].

The [Welcome to ServerStart] window appears.

5 Eject the ServerStart floppy disk.
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■ Creating a DOS Floppy Disk

Start up ServerStart and confirm that the [Welcome to ServerStart] window is displayed.

1 Click [FloppyBuilder].

The [ServerStart FloppyBuilder] window appears.

2 Click [DOS Diskette].

Insert the prepared floppy disk by following the message.

3 Perform the subsequent operations according to the messages on the window.

The floppy disk will be formatted automatically and file copying will start.

The DOS floppy disk will be created automatically. When a message appears indicating that 

creating the disk is completed, click [OK] and eject the disk.
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5.4.2 Creating a Hardware Configuration Tool

This section explains how to create a Hardware Configuration Tool from the ServerStart CD-ROM.

Prepare floppy disks as many as the tools you want to create beforehand. 
Types of a Hardware Configuration Tool vary by model.

1 Start up ServerStart and click [FloppyBuilder].

For the procedure, refer to Steps 1 and 2 in "5.4.1 Creating a DOS Floppy Disk" (�pg.141).

2 Click [Hardware Configuration Tool].

3 Click the tool you want to create.

Insert the prepared floppy disk by following the message.

4 Perform the subsequent operations according to the messages on the window.

The floppy disk will be formatted automatically and file copying will start.

The respective tools will be created automatically. When a message appears indicating that 

creating the disk is completed, click [OK] and eject the disk.
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5.5 Notes Before Operating the 
Server

This section explains the settings required before starting to operate the server.

For the respective settings, refer to "First Step Guide".

• If a LAN card was added, install a driver according to "4.3 Installing the LAN Driver" (�pg.120).

• When connecting a SCSI optional device (such as a hard disk cabinet or DAT), connect it according 

to "Chapter 7 Installing Internal Options" (�pg.161).

• For the settings for the installed applications supplied with the product, refer to the manuals of each 

application.

5.5.1 Updating the System

■ Windows Update

The system being used must be updated to prevent potential problems in the system.

Executing Windows Update can automatically search the latest version of QFE applicable to the OS and 

update the system to the latest status. Execute Windows Update periodically. 
Executing Windows Update requires a network environment connectable to the Internet.

5.5.2 Auto-run Function from CD-ROM Drives

Perform the following procedures to change the settings of the auto-run function from the CD-ROM 

drives after server installation:

1 Make the registry editable, and change the value of AutoRun of the following 

registry key:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\CDRom

To enable auto-run, set the value of Autorun to "1", and to disable auto-run, set the value to "0".

2 Restart the system.

The setting is enabled after the system is restarted.
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5.5.3 Drive Letter Assignment in Expert Mode

In expert mode, you cannot specify a drive letter to a particular partition arbitrarily. Drive letters 

specified with Disk Manager in expert mode will be sequentially assigned from the first partition with 

"C, D, E..." when installation is completed, and an unused drive letter will be assigned to the CD-ROM 

drive. 
To change the drive letter, perform the following procedures after installation.

� You cannot change the drive letters for the system and boot drive.

■ For Windows Server 2003

1 Click [Start] → [Administrative Tools] → [Computer Management].

2 Click [Disk Management].

3 Right-click the partition to change the letter and click [Change Drive Letter and 

Path].

The [Change Drive Letter and Path] window appears.

4 Click [Edit].

The [Change Drive Letter or Path] window appears.

5 Change the drive letter.

■ For Windows 2000 Server 

1 Right-click [My Computer] icon on the desktop and select [Manage].

2 Click [Disk Management].

3 Right-click the partition to change the letter and select [Change Drive Letter 

and Path].

The [Change Drive Letter and Path] window appears.

4 Click [Edit].

The [Change Drive Letter or Path] window appears.

5 Change the drive letter.
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5.5.4 Notes on Advanced Uninterruptible Power Supply 
(UPS)

Note the following points when using an advanced uninterruptible power supply (referred to as UPS 

afterward).

■ UPS Shutdown Time Setting

Specify enough time for the UPS power-off time (time from the shutdown direction to the actual power-

off). If this time is set insufficiently, the power will be cut off before system shutdown, which may result 

in destruction of data. For more details, refer to the manuals for UPS and UPS management software.

■ Power Supply Control by UPS

Change BIOS settings as follows to power the server on automatically using the UPS management 

software (PowerChute Network Shutdown, PowerChute Business Edition) at power recovery or during 

scheduled operation. For details on how to set the BIOS Setup Utility, refer to "8.2 BIOS Setup Utility" 

(�pg.191).

1 Start the BIOS Setup Utility.

2 From the [Advanced] menu, select the [Power On/Off] submenu and press the 

[Enter] key.

The [Power On/Off] submenu window appears.

3 Set the [Power Failure Recovery] item to [Always ON].

�"8.2.9 Power On/Off Submenu" (pg.206)

5.5.5 Turning the Power On via a LAN 

You can turn the power on the server from a client (via a LAN) by utilizing the Wakeup on LAN (WOL) 

function.

� Be sure to install ServerView to control the power supply via a LAN.

� When the power cable is disconnected from the server or the server is powered off due to power 

interruption, restart the server. Unless the server is restarted, the WOL function will be disabled.

� The WOL function can be used if the LAN controller which is first recognized by the client supports the 

WOL function. Only the onboard LAN supports the WOL function on this server. Set the Onboard LAN 

Adapter Bind to [1]. 
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■ BIOS Setup Utility Setting

When power management is performed via a LAN, configure the settings as follows using the BIOS 

Setup Utility.

1 Start the BIOS Setup Utility.

�"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.191)

2 From the [Advanced] menu, select the [Power On/Off] submenu and press the 

[Enter] key.

The [Power On/Off] submenu window appears.

3 Set [Power On Source: LAN] to [Enabled].

�"8.2.9 Power On/Off Submenu" (pg.206)

� To start up the server via a LAN, refer to "●  Performing Remote Installation" (�pg.41).

5.5.6 Other Notes on Operation

■ Unnecessary Files

After OS installation is completed, folders named Runonce and Runonce 2 may be left in the drive 

where the OS is installed. Delete these folders since you do not need them for the system operation.

■ Notes on 24-hour Operation

● Automated System Operation

To provide an extra margin of safety against unintentional damage, introduce disaster-prevention 

measures in the office and keep disaster prevention personnel (such as a security guard or janitor) in the 

building.

● Unintentional Power-off Prevention

We recommend the installation of a special power supply device (such as a distribution board) to prevent 

unplanned power shut-offs.
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5.6 LAN Driver Advanced Setup

Use "Intel® PROSet" for LAN driver advanced setup.

5.6.1 Intel® PROSet

■ Intel® PROSet Installation

Usually, "Intel® PROSet" is installed with the driver. If Windows Server 2003 or Windows 2000 Server 

is installed using the floppy disk created from the ServerStart CD-ROM, "Intel® PROSet" will not be 

installed.

On Windows Server 2003/Windows 2000 Server, if [Intel® PROSet] is not displayed in the [Control 

Panel], install "Intel® PROSet" according to the following installation procedures:

1 Start the following EXE file contained in the ServerStart CD-ROM.

For Windows Server 2003

[CD-ROM drive]: \Tools\GENERAL\Intel\ProsetW2k3\Proset.exe

For Windows 2000 Server 

[CD-ROM drive]: \Tools\GENERAL\Intel\ProsetW2k\Proset.exe

2 Select [Automatic execution-runs setup immediately] and click [OK].

Perform the subsequent procedures by following the instructions.

■ Notes on Referring to the Intel® PROSet Help Topics

When referring to help topics, note the following points.

• Do not use the driver downloaded from the Intel Corporation online service page on this server.

• If the descriptions in the help and this manual vary, give priority to this manual.

• The name of LAN cards appears in the help texts corresponds to the cards as follows:

table: LAN cards appear in the help texts

LAN cards appear in the help text Corresponding LAN cards

PRO/1000 Desktop PG-1852

PRO/1000 Server PG-1862/PG-1882L/PG-1892L

PRO/1000 Adapter PG-1852/PG-1862/PG-1882L/PG-1892L

PRO/1000 Copper Adapter PG-1852/PG-1862/PG-1892L

PRO/1000 Fiber Adapter PG-1882L

82540-based Adapter PG-1852
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• The controllers of the onboard LAN and LAN cards are as follows:

5.6.2 Cautions for Onboard/PG-1852/1862/188x/189xLAN 
Driver V8.3

■ Event Log

Once a Team is setup, multiple identical logs from the same source that starts with the following log may 

be stored in the system log file of the event viewer at system start-up.

Since such event logs will be stored nonetheless even if the Teaming function is operated normally, 

ignore them.

5.6.3 Teaming (AFT/ALB/SFT) Function

■ Notes

When using the Teaming function, note the following points.

• You require Service Pack 2 or later for Windows 2000 Server.

• For AFT/ALB type, you can incorporate up to four (4) LAN ports into one team, and two ports for a 

SFT type team.

• Once a Team is created, virtual adapters (Intel® Advanced Network Service Virtual Adapter) will be 

created in the [Device Manager] and/or [Network and Dial-up Connections] of the system. Do not 

disable or delete a virtual adapter from the [Device Manager] or [Network and Dial-up Connections]. 

When deleting a virtual adapter, make sure to use "Intel® PROSet".

• When the Teaming function is being used, you can only use the following protocols:

• For AFT/SFT type: IP, NetBEUI, IPX (NCP), IPX (NetBIOS)

• For ALB type: IP, IPX (NCP)

• When the Teaming function is being used, you cannot use the hardware assist function of IPSEC. Do 

not use this function even if the function is installed in all cards in the team.

table: Controller being used

LAN cards Controller being used

Onboard LAN (1000BASE-T) Intel® 82547GI

PG-1852 Intel® 82540EM

PG-1862 Intel® 82546EB

PG-1882L/PG-1892L Intel® 82545GM

Source iANSMiniport

ID 11

Type Warning

Description The following adapter link is not connected: (Adapter name) 
 * (Adapter name) varies depending on the OS or hardware configuration.
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• When the Teaming function is being used, you cannot use Windows Load Balancing Service 

(WLBS) and Network Load Balancing (NLB).

• PG-1852 does not become a member of a Team.

� Only a link down error between a LAN card (onboard LAN) and the switch it connects with, and the 

equivalent errors lead to switching of the route. Therefore, if only the switch or LAN card (onboard 

LAN) is partially damaged and the route being used is sound at the link level, the route will not be 

switched in the team. However, the communication within the Team may become an error.

■ Teaming Configuration Procedure

1 Start up "Intel® PROSet". The procedure differs depending on the OS being 

used.

For Windows Server 2003

1. Click [Start] → [Control Panel] → [Intel(R) PROSet].

For Windows 2000 Server 

1. Click [Start] → [Settings] → [Control Panel].

The [Control Panel] window appears.

2. Start up "Intel(R) PROSet".

2 Select a card to incorporate in a Team and right-click it.

3 Click [Create New Team] in [Add to Team].

[Teaming Up Wizard] appears.

4 Select a Teaming type with which you want to create a Team.

Select [Adapter Fault Tolerance] for AFT type; select [Adaptive Load Balancing] for ALB type; 

and select [Switch Fault Tolerant] for SFT type.  
Do not use any other Teaming types. 

5 Select a LAN card to incorporate in the Team and click [Next].

6 Click [Finish].

7 Click [OK].

When the Teaming setting is completed, the following virtual adapter will be created.

• "Intel(R) Advanced Network Services Virtual Adapter"

Upper protocols will be bound with the main virtual adapter. 
You cannot bind them with the LAN card consisting of a Team. 
The IP address can be set in the main virtual adapter.
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5.6.4 VLAN

■ Notes

When using a VLAN, note the following points.

• You can only have "NetBIOS over TCP/IP" enabled for up to four VLANs in the whole system.

• On a VLAN, do not use protocols other than TCP/IP.

• You can only set ten or less VLANs to a LAN port.

• When adding or deleting a VLAN, always use "Intel(R) PROSet". Do not disable or delete a VLAN 

from the [Device Manager] or [Network and Dial-up Connections].

■ VLAN Setup Procedure

1 Start up "Intel® PROSet". The procedure differs depending on the OS being 

used.

For Windows Server 2003

1. Click [Start] → [Control Panel] → [Intel(R) PROSet].

For Windows 2000 Server 

1. Click [Start] → [Settings] → [Control Panel].

The [Control Panel] window appears.

2. Start up "Intel(R) PROSet".

2 Select a LAN card to setup a VLAN and right-click it.

3 Click [Add VLAN]. The following message may be displayed at the time. In such 

a case, click [Yes].

4 Specify [ID] and [Name]. Then click [OK].

The [ID] should be identical with the switch setting. 
The [Name] does not need to be identical with the switch setting.

5 Repeat Steps 3 through 5 to set respective VLANs.

6 Click [OK].

When setup of the VLAN is completed, the following virtual adapter will be created.

• "Intel(R) Advanced Network Services Virtual Adapter"

Upper protocols will be bound with the main virtual adapter. You cannot bind them with the LAN 

card consisting a VLAN. The IP address should be specified in the main virtual adapter.

You need to connect with the switch that supports IEEE 

VLANs (802.1Q). Do you want to enable QOS Packet Tagging?
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5.6.5 Local Address Setting

Specify a local address according to the following procedures.

1 Start up "Intel® PROSet". The procedure differs depending on the OS being 

used.

For Windows Server 2003

1. Click [Start] → [Control Panel] → [Intel(R) PROSet].

For Windows 2000 Server 

1. Click [Start] → [Settings] → [Control Panel].

The [Control Panel] window appears.

2. Start up "Intel(R) PROSet".

2 Select a LAN card to set the local address and click the [Advanced] tab.

3 Specify a local address in [Locally Managed Address].

5.6.6 Jumbo Frame

1000BASE-T/1000BASE-SX supports Jumbo frame. When using Jumbo frame, construct the Jumbo 

frame network using only devices that support Jumbo frame and apply the settings that will enable 

Jumbo frame.

Configure setting for Jumbo frame according to the following procedures.

1 Start up "Intel(R) PROSet" from [Control Panel].

2 Select a LAN card to perform configuration and click the [Advanced] tab.

3 Specify the maximum frame size in the [Jumbo Frame] tab.

■ Other Cautions

You cannot connect devices directly with a cross cable without connecting a hub switch or router in 

between.
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Chapter 6 

High Reliability Tools  

For stable PRIMERGY server operations, we 

recommend that high reliability tools be installed. 

This chapter explains the installation and 

necessary settings of high reliability tools.

6.1 RAID Management Tool (Global Array Manager)  . . . . . . . 156

6.2 Server Monitoring Tool [ServerView]  . . . . . . . . . . . . . . . . 158

6.3 Solving Problems Early [DSNAP] . . . . . . . . . . . . . . . . . . . 159
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6.1 RAID Management Tool (Global 
Array Manager)

RAID Management Tool is software that perform array configuration, disk initialization 

and disk array monitoring when using RAID card. For more details, refer to 

"PRIMERGY ServerBooks" supplied with the server, and "Supplement" supplied with 

the RAID card.

Batch installation using ServerStart

� When an OS is installed using ServerStart, RAID Management Tool is batch installed the OS and other 

high reliability tools. If manually installing the OS, install RAID Management Tool manually. 

6.1.1 Installing RAID Management Tool (Global Array 
Manager)

To install RAID Management Tool individually using the standard installer, following the procedures 

below.

� These tool can be installed only when the server has a RAID card.

� Before performing Global Array Manager, check that TCP/IP is installed and works properly.

1 Log on to the server with administrator privileges.

� Exit all programs before starting installation.

Installation will fail if "Event Viewer" or "Computer Management" is run.

2 Insert the ServerStart CD-ROM. Click [Start] → [Run...].

3 Enter a name in the [Open:] field as follows and click [OK].

[CD-ROM drive]:\PROGRAMS\GENERAL\LSI\GAM\install.bat

Installation starts and the wizard window appears.

For subsequent procedures, refer to "PRIMERGY ServerBooks" supplied with the server, and 

"Supplement" supplied with the RAID card.
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■ Error Window Appearing after Installation (Windows Server 2003 
only)

If Windows Server 2003 Service Pack 1 is applied,when restarting after installing/uninstalling RAID 

Management Tool (Global Array Manager) the pop up window that indicate SNMP service termination 

may appear.

This is no problem with operations. Click [Close message] to close the message.
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6.2 Server Monitoring Tool 
[ServerView]

ServerView constantly monitors the status of the servers' hardware in the network 

and provides a console with which the administrator can check the status of all the 

servers at a glance. In addition, if an error occurs, the administrator will be notified in 

real-time to take immediate action.

■ Installing ServerView

● When Installed Using ServerStart

If the OS is implemented and setup using ServerStart, ServerView will be installed at once with the OS 

and other high reliability tools.

● When Installed Manually

When installing ServerView individually, refer to "Chapter 2 Installing" in "ServerView User's Guide".

● For Linux

ServerView cannot be installed using ServerStart. To install ServerView into a Linux system, refer to 

"ServerView User's Guide".

� Be sure to install SNMP service before installing ServerView.

■ Error Window Appearing after ServerView Installation (on Windows 
Server 2003)

If Windows Server 2003 Service Pack 1 is applied, when restarting after installing/uninstalling 

ServerView the following message may appear.

This is no problem with operations. Click [Close message] to close the message.

■ Setting Required after Installation

Perform necessary operations after ServerView installation referring to "2.4 Checking after Installation" 

in "ServerView User's Guide".

■ Boot Monitoring Setting

We recommend enabling the "Boot Monitoring" function after ServerView is installed. For setting 

procedures and explanation on the function, refer to the [Restart Settings] Tab of "3.2.4 Serious Error 

Handling (ASR)" in "ServerView User's Guide".

Windows has terminated the following program(s) to protect your 

computer. 
Name: SNMP Service
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6.3 Solving Problems Early [DSNAP]

DSNAP is a tool for collectively acquiring failure investigation information such as 

server environment information.

OS installation using ServerStart

� When an OS is installed using ServerStart, DSNAP is batch installed the OS and other high reliability 

tools. If manually installing the OS, install DSNAP manually. 

■ Installing DSNAP

To install DSNAP separately, copy the "DSNAP.EXE" file stored in the 

"\PROGRAMS\Japanese\DSNAP" folder of the ServerStart CD-ROM into the server's hard disk.

■ How to Use

This topic is discussed in the "\PROGRAMS\Japanese\DSNAP\README.TXT" file in the ServerStart 

CD-ROM. Use a text editor to open it.
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Chapter 7 

Installing Internal Options  

This chapter explains how to install internal 

options on this server. Contact an office listed in 

the "Contact Information" of "Start Guide" 

regarding installation and removal of internal 

options.

7.1 Before Installing Internal Options . . . . . . . . . . . . . . . . . . . 162

7.2 Removing and Attaching the Top Cover . . . . . . . . . . . . . . 164

7.3 Installing Memory Modules  . . . . . . . . . . . . . . . . . . . . . . . 166

7.4 Installing Expansion Cards  . . . . . . . . . . . . . . . . . . . . . . . 170

7.5 Installing an Internal CD-ROM Drive Unit . . . . . . . . . . . . . 177

7.6 Installing an Internal Hard Disk Unit . . . . . . . . . . . . . . . . . 180

7.7 Connection of Optional Devices . . . . . . . . . . . . . . . . . . . . 187
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7.1 Before Installing Internal Options

The following types of internal options can be installed on this server.

� When installing or removing devices, make sure to use the removed screws on the same location and 

devices that were last installed or removed. Failure to do so can damage the device.

� The types of installable options described in this manual are subject to change without notice. 

� There is an air duct above the heat sink of the CPU. Also, a piece of foam is placed between the floppy 

disk drive or CD-ROM drive and the baseboard.

All of these parts must be placed in their positions when turning the server on. As the air duct and the 

foam assure smooth air flow inside the server unit, do not remove them.

• When installing/removing internal options to/from the server, turn off the server,          

all peripheral devices, and any other connected devices. Also unplug all power           

cables from the server. Failure to do so can cause electric shock (�"1.4.3            

Turning Off the Server" (pg.31)).

• Do not disassemble the PSU. Doing so can cause electric shock. 

• Do not install unauthorized third party internal options. Doing so may cause a            

device failure, fire, or electric shock. 

• Do not damage or modify internal cables or devices. Doing so may cause a             

device failure, fire, or electric shock. 

Memory modules

Expansion cards

Internal CD-ROM drive unit

Internal hard disk units
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• Devices inside the server remain hot after shutdown. Wait for a while after            

shutdown before installing or removing internal options.

• The circuit boards and soldered parts of internal options are exposed. They           

can be damaged by static electricity.

Before handling them, first touch a metal part of the server to discharge static             

electricity. 

• Do not touch the circuitry on boards or soldered parts. Hold the metallic areas             

or the edges of the circuit boards.

• If devices are installed using the methods other than those outlined in this            

chapter or disassembled, the warranty will be invalidated.
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7.2 Removing and Attaching the Top 
Cover

This section explains how to remove and attach the top cover. 

7.2.1 Removing and Attaching the Top Cover

■ How to Remove the Top Cover

1 Open the rack door.

�"1.4.1 Opening the Rack Door" (pg.28)

2 Turn off the server and peripheral devices and remove all cables (e.g., SCSI 

and LAN cables) from the server. 

�"1.4.3 Turning Off the Server" (pg.31)

3 Loosen the two screws on the front of the server.

• When removing or attaching the top cover, turn off the server and all peripheral             

devices. Also unplug all power cables from the server. Failure to do so can             

cause electric shock (�"1.4.3 Turning Off the Server" (pg.31)).

• Use tip preventive stabilizers when installing the rack. 
Pulling the server out of the rack without installing stabilizers may cause the            

rack to tip over.
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4 Slide the server. 

Pull the server out toward you until it clicks so that it locks in place on the rails on both sides. 

5 Loosen the screw on the rear of the server.

6 Slide the top cover slowly to the rear and lift it to remove from the server.

■ How to Attach the Top Cover

To attach the top cover, simply reverse the removal procedures.

� Make sure that no tools or unnecessary components were left inside the server before attaching the 

top cover back into place.

� When sliding the server backward, press the locks on both of the rails to unlock.

� Before turning on the server, make sure that the top cover is attached.

• When sliding the server or pushing it back, be careful not to pinch fingers or              

clothes. Failure to do so can cause injury.

Lock

Rear of the server

Top cover
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7.3 Installing Memory Modules

Additional memory will help to increase the amount of data to read at a time and 

improve the server processing capability.

• Before installation or removal, turn off the server and all peripheral devices.            

Also unplug all power cables from the server. Failure to do so can cause             

electric shock (�"1.4.3 Turning Off the Server" (pg.31)). 

• Do not install unauthorized third party memory modules. Doing so can cause           

electric shock, a fire, or failures.

• Wait for a sufficient period of time after server shutdown before installing or            

removing memory. Failure to do so can cause burns.

• When installing or removing memory modules, make sure to remove the          

screws on the specified points only. Failure to do so can cause injury or device              

failures. 

• Touch only the specified part of the printed circuit board.

Failure to do so can cause injury or device failures. 

• The circuit boards and soldered parts of internal options are exposed. They           

can be damaged by static electricity.

Before handling them, first touch a metal part of the server to discharge static             

electricity. 

• Do not insert and remove memory modules repeatedly. Doing so may cause           

failures. 

• Do not touch the circuitry on boards and soldered parts. Hold the metallic            

areas or the edge of the circuit boards.
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7.3.1 Where to Install Memory Modules

Install memory modules in the memory slots on the baseboard. 

A memory of this server contains a single Dual In-Line Memory Module (DIMM) and you can add a 

single memory module at a time.

■ Installation Order

Install DIMMs in DIMM slots in order of slot 1, slot 3, slot 2, and slot 4, starting with a DIMM with the 

least capacity.

7.3.2 Installable Memory Modules

The following memory module types can be used on this server. 

Package

� Before installing memory modules, refer to "Appendix B.1 Memory Specifications" (�pg.261) to check 

the contents of the package.

table: List of Installable Memory Modules

Product name Model name Remarks

Memory Module-256MB PG-RM25AD 256MB (256MB-DIMM × 1)

Memory Module-512MB PG-RM51AD 512MB (512MB-DIMM × 1)

Memory Module-1GB PG-RM1AD 1GB (1GB-DIMM × 1)

Memory Slot 1
Memory Slot 2
Memory Slot 3
Memory Slot 4
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7.3.3 How to Install/Remove Memory Modules

1 Turn off the power and remove the top cover.

�"7.2 Removing and Attaching the Top Cover" (pg.164)

2 Touch a metal part of the server to discharge static electricity. 

3 Install or remove memory modules.

• Installing

Insert a memory module properly into the memory slot. The levers close.

If the levers are not closed completely, push them with your fingers.

• Removing

Open the levers on both ends.

4 Check that the memory module is inserted all the way.

5 Attach the top cover. 

�"7.2 Removing and Attaching the Top Cover" (pg.164)

• Make sure not to open the clips outward too quickly because the memory            

module may pop up, which could cause damage.

• An improperly engaged memory module could cause a fire. Do not insert the            

memory module on the wrong side.

Lever
Align notch
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7.3.4 Defective Memory Disconnection Function

This server is equipped with the defective memory (RAM module) disconnection function.

This function disconnects the memory (one DIMM) judged to be defective (abnormal) during Power On 

Self Test (POST) to start the server. When POST is executed, if the memory capacity is discovered to be 

smaller than the capacity of the memory installed, there is a possibility of memory defect.

You can check the slot location whose memory is defective during POST or from the system event log.

If the defective memory is discovered, replace it, and then restart the server.

■ Removing the Defective Memory Module

Replace the defective memory with a new one according to "7.3.3 How to Install/Remove Memory 

Modules" (�pg.168). 

� After replacing memory, start the BIOS Setup Utility and set the [DIMM n] ("n" is a slot number of the 

replaced memory) to [Enabled] on the Memory Status submenu in the [Server] menu. 

�"8.2.14 Memory Status Submenu" (pg.213)
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7.4 Installing Expansion Cards

This section explains the types of expansion card, installation procedures, and notes 

on expansion cards.

7.4.1 Where to Install an Expansion Card

This server has two PCI slots. Up to two expansion cards can be installed.

The figure below shows the slot locations.

• Turn off the server and peripheral devices, and unplug the power cables from            

the outlet. Failure to do so can cause electric shock (�"1.4.3 Turning Off the             

Server" (pg.31)). 

• The circuit boards and soldered parts of internal options are exposed. They           

can be damaged by static electricity.

Before handling them, first touch a metal part of the server to discharge static             

electricity. 

• Do not touch the circuitry on boards or soldered parts. Hold the metallic areas             

or the edges of the circuit boards.

• Expansion cards are susceptible to static electricity. Place them on conductive          

pads or keep them in their packaging as long as they are not necessary.

PCI Slot 2

[Rear]

PCI Slot 1
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■ PCI Slot Specifications 

• PCI slots 1 and 2 are both 64-bit, 66MHz PCI slots.

• PCI slot 1 can be used for a LowProfile PCI card only.

• The PCI slots conform to the PCI local bus specifications (Rev. 2.2).

7.4.2 Installable Expansion Cards and Notes

This section explains expansion cards that can be installed and provides notes on installation.

■ Installable Expansion Cards

Up to two expansion cards listed on the following table can be installed in the server.

■ Location and Order of Expansion Card Installation

For expansion cards, use the PCI slots in accordance with the order indicated in the following table.

Follow the Installation order shown in the table when installing the cards and drivers. If you turn on the 

power after installing multiple expansion cards simultaneously or in a wrong order, they will not 

function properly. 

 -: Not installable.

table: List of Installable Expansion Cards

Installable expansion card 

(Model name)

Number of 

cards
Remarks

Eth. Ctrl 1000-BASE-T Cu (PG-1852) 1
1

2

1000BASE-T

Eth. Ctrl 2 x 1000-BASE-T Cu (PG-1862) 1 1000BASE-T, dual-port

RAID Ctrl 1-Channel 64MB  
(PG-141C1L)

1

2

For internal array systems 
 (Ultra 320 SCSI, 1-ch, LowProfile)

SCSI Ctrl U160 lp (PG-130L)
2

For an internal hard disk unit and an external 

SCSI option (Ultra 160 SCSI, LowProfile)

Eth. Ctrl 1000-BASE-SX Fibre LC lp  
(PG-1882L)

1

1

1000BASE-SX, LowProfile

Eth. Ctrl 1000-BASE-T Cu lp (PG-1892L) 1 1000BASE-T, LowProfile

table: Installation Order and Slots for Expansion Cards

Installable expansion card (Model name)
PCI slot

Installation Order
1 2

Eth. Ctrl 1000-BASE-T Cu (PG-1852)  - 1 1

Eth. Ctrl 2 x 1000-BASE-T Cu (PG-1862)  - 1 2

RAID Ctrl 1-Channel 64MB (PG-141C1L) 1  - 3

SCSI Ctrl U160 lp (PG-130L) 1 2 4

Eth. Ctrl 1000-BASE-SX Fibre LC lp (PG-1882L)  - 1 5

Eth. Ctrl 1000-BASE-T Cu lp (PG-1892L)  - 1 6
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■ Notes on Installation

● Drivers

For expansion card drivers, refer to "2.3.5 Expansion Cards Supported by ServerStart" (�pg.46).

● Notes on Each Card

For notes of specific expansion card, refer to the manuals supplied with the card and the notes provided 

with the server. Also, check the following for respective expansion cards.

● SCSI Card/RAID Card

• Connect a SCSI option supported by this server to the SCSI or RAID card.

Unsupported SCSI option are not guaranteed.

• Do not connect both an internal SCSI device and an external device together to the SCSI card.

• If an internal hard disk unit where an OS has been installed is not connected to the SCSI card, set the 

card BIOS to [Disabled]. 

For the BIOS setup of SCSI cards, refer to the manual supplied with the expansion card.

• Precautions before OS installation

In addition to the completion of RAID card/SCSI card configuration, the hard disk under the RAID 

card must be initialized before the OS is installed. 
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• Connecting the hard disk access LED cable

If you connect an internal hard disk unit to the optional SCSI Ctrl U160 lp (PG-130L) or RAID Ctrl 

1-Channel 64 MB (PG-141C1L), install the SCSI Ctrl U160 lp (PG-130L) or RAID Ctrl 1-Channel 

64 MB (PG-141C1L) first. Then, connect the hard disk access LED cable to the server as shown 

below.

● LAN card/Onboard LAN

A LAN card already used on another server cannot be installed on this server.

Rear

Parts installed side

Parts installed side

J5

R

R

R

B

B

B

R: Red
B: Black

[Connecting position on the baseboard]

[Connecting position on the SCSI card]

For SCSI card

[Connecting position on the RAID card]

*Check the direction of each connector by cable color.

Hard disk access display LED cable

For RAID card
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7.4.3 How to Install an Expansion Card

1 Turn off the power and remove the top cover.

�"7.2 Removing and Attaching the Top Cover" (pg.164)

2 Touch a metal part of the server to discharge static electricity. 

3 Unplug the cable from the SCSI or RAID card installed in Slot 1.

Unplug the SCSI cable and the hard disk access LED cable.

4 Loosen the screws on the rear side of the server, and remove the card locking 

frame.

Hard disk access LED cable

SCSI cable

Card locking frame

Screw

Screw
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5 Remove the expansion card and the slot cover from the card locking frame. 

� The slot cover for PCI slot 2 is composed of a LowProfile slot cover and an Extension slot                 

cover.

� Be sure to keep the removed slot cover for later use.

6 When installing a LowProfile card, fasten the expansion card and Extension 

slot cover.

Fasten the expansion card and the Extension slot cover with the screws.

Use the screw that comes with the Extension slot cover.

7 Insert the expansion card securely into slot 2.

Slot coverExpansion card

Extension slot cover
Lowprofile slot cover

Expansion card
(LowProfile)

Extension
slot cover

Expansion card



176

Chapter 7  Installing Internal Options

� When installing two expansion cards on PCI slot 1 and 2, insert a card into PCI slot 2 first, then                   

insert other the card into PCI slot 1.

If a card has already been inserted into slot 1, remove it. Insert a card into slot 2 first, then                   

insert another into slot 1.

8 Insert the expansion card removed in Step 5 into slot 1 again.

9 Securely install the card locking frame to the connector, and fix it by tightening 

the screws.

10 Connect the cables disconnected in Step 3.

11 Install the top cover and return the server back to its original position.

12 Set and confirm the system resource information.

On the [Advanced] menu of the BIOS Setup Utility, set and confirm the following items.

• Set [Reset Configuration Data] to [Yes].

�"8.2.5 Advanced Menu" (pg.199)

• Make sure that the [PCI IRQ Line n (n is 0 to 1)] is [Auto] on the PCI Configuration submenu.

�"8.2.7 PCI Configuration Submenu" (pg.202)

■ How to Remove an Expansion Card

To remove the expansion card, simply reverse the installation procedures.

Card locking frame connector 
Screw

Screw



177

PRIMERGY RX100 S2 User’s Guide    

7

In
s
ta
llin

g
 In
te
rn
a
l O

p
tio
n
s

7.5 Installing an Internal CD-ROM 
Drive Unit

This section explains the procedure for installing a CD-ROM drive (optional).

7.5.1 Installable CD-ROM Drive Units

The following CD-ROM drive units can be installed on this server.

Package

� Before installing the internal CD-ROM drive unit, refer to "Appendix B.2 Internal CD-ROM Drive Unit 

Specifications" (�pg.262) to check the contents of the package.

• Before installation or removal, turn off the server and all peripheral devices.            

Also unplug all power cables from the server. Failure to do so can cause             

electric shock (�"1.4.3 Turning Off the Server" (pg.31)).

• When installing a CD-ROM drive, hold it by the side. Applying force to the top              

can cause failures.

• The circuit boards and soldered parts of internal options are exposed. They           

can be damaged by static electricity.

Before handling them, first touch a metal part of the server to discharge static             

electricity. 

• Do not touch the circuitry on boards or soldered parts. Hold the metallic areas             

or the edges of the circuit boards.

table: Installable CD-ROM Drive Units

Product name Model name Remarks

CD-ROM ATAPI PG-CD320 IDE (ATAPI)
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7.5.2 How to Install the Internal CD-ROM Drive Unit

1 Turn off the power and remove the top cover.

�"7.2 Removing and Attaching the Top Cover" (pg.164)

2 Touch a metal part of the server to discharge static electricity. 

3 Loosen the screws of the dummy unit, and remove the dummy unit.

Slide the dummy unit backward and lift it up.

Be sure to keep the removed dummy units for later use. 

4 Install the CD-ROM drive unit and fasten it with the screws.

1. Insert the stopper latches of the CD-ROM drive into slots of the server.

Screw

Dummy unit

CD-ROM drive unit

Insert the stopper latches
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2. Slide the CR-ROM drive forward and tighten the screws.

5 Connect the IDE and power cables.

Use the IDE and power cables connected to the server.

Fix the connected cables between the pieces of the foam.

6 Attach the top cover. 

�"7.2 Removing and Attaching the Top Cover" (pg.164)

■ How to Remove the CD-ROM Drive Unit

To remove the CD-ROM drive unit, simply reverse the installation procedures.

Screw

Foam

Power cable

IDE cable

Fix the cables in between 
the pieces of the foamFront
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7.6 Installing an Internal Hard Disk 
Unit

This section explains how to install internal hard disk units. 

7.6.1 Installation Location of Internal Hard Disk Unit 

■ Order of Internal Hard Disk Unit Installation

Install the internal hard disk unit to bay 1 first, then bay 2.

• The circuit boards and soldered parts of internal options are exposed. They           

can be damaged by static electricity.

Before handling them, first touch a metal part of the server to discharge static             

electricity. 

• Do not touch the circuitry on boards or soldered parts. Hold the metallic areas             

or the edges of the circuit boards.

• Before removing the unit, turn the power off and wait for about 30 seconds until              

the disk stops completely.

• Rough handling of the hard disk unit can damage the stored data. To cope with              

any unexpected problems, always back up important data. When backing up          

data to another hard disk unit, you should make backups on a file or block              

basis.

• Use the unit in a dry place with low airborne dust levels.

• Take great care so that you do not hit the hard disk or bring it into contact with                 

metallic objects.

• Use the device on a shock-and-vibration free surface.

• Keep the device away from direct sunlight and from radiators or other heat            

sources. 

• Do not use the unit in a place where the temperature is extremely high or low,               

or experiences extreme temperature changes.

• Do not disassemble the hard disk unit.

Bay1 Bay2
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■ SCSI-ID Setting of Internal Hard Disk Unit 

The internal hard disk unit does not support hot-swapping. As the SCSI-ID is not set automatically, you 

must set it up in advance by referring to the followings.

● Jumper Pin Locations of the Internal Hard Disk Unit 

Set the SCSI-ID of the hard disk unit using the jumper pins on the rear side of the hard disk.

● SCSI-ID Setting

Set the jumper pins as follows, according to the bay locations.

table: SCSI-ID Set Value for Each Bay Location

Bay 1 Bay 2

SCSI-ID = 0 SCSI-ID = 1 

2 4 6 8 10 12 14

1 3 5 7 9 11 13

16 18 20 22 24

15 17 19 21 23

[Rear side of the hard disk]

Jumper pin setting (set at the time of purchase)

Short

2 4 6

1 3 5

2 4 6

1 3 5
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7.6.2 Installable Internal Hard Disk Units

■ Installable Internal Hard Disk Units

The following internal hard disk units can be installed on this server.

Package

� When an internal hard disk unit is connected to the SCSI card, it operates as the Ultra160 SCSI 

device.

� Before installing the internal hard disk unit, refer to "Appendix B.3 Internal Hard Disk Unit 

Specifications" (�pg.262) to check the contents of the package.

table: List of Installable Hard Disk Units 

Product name Model name Overview

HDD U320 10K 73GB non hot plug 1" PG-HD7G1T 73.4GB, 10,000rpm,  
1-inch, Ultra320 SCSI

HDD U320 10K 147GB non hot plug 1" PG-HD4G1T 146.8GB, 10,000rpm,  
1-inch, Ultra320 SCSI
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7.6.3 How to Install the Internal Hard Disk Unit

1 Turn off the power and remove the top cover.

�"7.2 Removing and Attaching the Top Cover" (pg.164)

2 Touch a metal part of the server to discharge static electricity. 

3 Disconnect the extension cables of the power cable from the server.

4 Connect the extension cable disconnected from the server in Step 3 to the 

internal hard disk unit.

[Front]

Extension cable

Extension cable
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5 Remove the bay to accommodate an internal hard disk unit.

Loosen the screws (1) and slid the bay toward you to remove it (2).

6 Install the internal hard disk unit to the hard disk bay.

Fasten the bay to the internal hard disk unit using the screws supplied with the disk unit.

1

2

Hard disk bay
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7 Install the hard disk bay to the server.

Insert the hard disk bay with the internal hard disk unit into the server (1), and tighten the screws 

(2).

8 Connect SCSI and power cables.

Connect the SCSI cable to the SCSI connector of the internal hard disk unit. Also, connect the 

power cable to the extension cable connector.

2

1

SCSI cable

Extension 
cable

Hard disk unitFront

Power 
cable
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If no SCSI card or RAID card is installed for the diskless type

� Install the optional SCSI Ctrl U160 lp (PG-130L) or RAID Ctrl 1-Channel 64 MB (PG-141C1L),              

and connect the internal hard disk unit to the SCSI Ctrl U160 lp (PG-130L) or RAID Ctrl 1-                 

Channel 64 MB (PG-141C1L) using the SCSI cable supplied with the server. For installing a              

SCSI card/ RAID card, refer to "7.4.3 How to Install an Expansion Card" (�pg.174). 
The following shows the connector destination for SCSI cables.

� Using the hard disk access LED cable supplied with the server, connect the LED connector on               

the baseboard to the SCSI Ctrl U160 lp (PG-130L) or RAID Ctrl 1-Channel 64 MB (PG-               

141C1L).

For the connection procedure for the hard disk access LED cable, refer to "7.4.2 Installable              

Expansion Cards and Notes" (�pg.171).

■ How to Remove the Internal Hard Disk Unit

To remove the internal hard disk unit, simply reverse the installation procedures.

Keep the extension power cables connected to the internal hard disk unit when removing the hard disk 

unit.

Connect SCSI Ctrl U160 lp (PG-130L) or 
RAID Ctrl 1-Channel 64MB (PG-141C1L) Connect the hard disk of bay1

Connect the hard disk of bay2 Terminator

Extension cable
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7.7 Connection of Optional Devices 

This section explains the connection of optional devices.

7.7.1 Connection Examples of Internal Option Devices

The following shows connection examples of internal option devices. Connection conditions vary 

depending on examples. See each example.

■ Hard Disk Connections

■ Connecting of a Hard Disk Unit to Configure an Array System

Server

Baseboard

Terminator

Bay2

Bay1

SCSI Ctrl U160 lp
(PG-130L)

Baseboard

Server

RAID Ctrl 1-Channel 
64MB (PG-141C1L)

Terminator

Bay2

Bay1
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7.7.2 Connecting an External SCSI Option

External SCSI options can be connected via the SCSI card as follows. 

■ Connection of a Backup Cabinet

Connect the backup cabinet as shown below.

Only a single backup cabinet can be connected to the server.

Baseboard

SCSI cable
(PG-CBLS007 / PG-CBLS008 : Optional)

Backup cabinet
(PRIMERGY SX10:
 PG-R1BC4)

SCSI Ctrl U160 lp
(PG-130L)

Internal hard disk unit(s)

SCSI Ctrl U160 lp (PG-130L) or 
RAID Ctrl 1-Channel 64MB (PG-141C1L)

Server
Terminator
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Hardware Configuration/ 
Utilities

This chapter explains how to make the 

environment settings necessary to operate the 

server.

8.1 Jumper Pin Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 190

8.2 BIOS Setup Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
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8.1 Jumper Pin Settings

This section explains the jumper pins.

8.1.1 Jumper Pin Setup Procedure

1 Turn off the power and remove the top cover.

�"7.2 Removing and Attaching the Top Cover" (pg.164)

2 Touch a metal part of the server to discharge static electricity. 

3 Remove the card locking frame.

�"7.4 Installing Expansion Cards" (pg.170)

4 Change the jumper pin settings. 

�"8.1.2 Jumper Pins" (pg.190)

5 Attach the top cover. 

�"7.2 Removing and Attaching the Top Cover" (pg.164)

8.1.2 Jumper Pins

The following explains how to set the jumper pins ("q" in "1.3.4 Baseboard" (�pg.26)) on the 

baseboard. 

• JP1 ("q" in "1.3.4 Baseboard" (�pg.26))

Sets whether or not to clear the CMOS.

table: Jumper Settings

The jumper settings (short settings) Description

1-2 (at the time of purchase) Does not clear the CMOS.

2-3 Clears the CMOS. 
After the CMOS has been cleared, return the jumper to the 

original setting.

2 31
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8.2 BIOS Setup Utility

This section explains settings for the BIOS Setup Utility and items regarding each 

setting.

8.2.1 Starting and Exiting the BIOS Setup Utility

The following explains how to start and exit the BIOS Setup Utility.

■ How to Start the BIOS Setup Utility 

1 Turn on the server.

�"1.4.2 Turning On the Server" (pg.30)

2 After memory counting in POST, press the [F2] key when the message "Press 

<F2> to enter SETUP <F12> to boot menu" is displayed on the screen.

The [Main] menu appears.

� While the message "Press <F2> to enter SETUP <F12> to boot menu" is displayed after mem-               

ory counting in POST, pressing the [F12] key causes the [Boot Menu] window to appear.

The [Boot Menu] window allows you to select the boot disk to be used next.

Advanced Security Server Exit

System Time:  [HH:MM:SS]
System Date:  [MM:DD:YYYY]

Diskette A:  [1.44/1.25 MB 31/2"]

Parallel ATA         [SR244W]
SATA Port 0          [Auto]
SATA Port 1          [Auto]

Boot Options

Base Memory:
  

640 KB
Extended Memory:

 
260608 KB

PhoenixBIOS Setup Utility

Item Specific Help

Main

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit

Boot Menu

1.   CD-ROM Drive
2.  +Removable Devices
3.   Hard Drive

<Enter Setup>
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● Key Operations in the BIOS Setup Utility

The roles of the keys used for using the BIOS Setup Utility are as follows: 

■ How to Exit the BIOS Setup Utility 

1 Use the [←] [→] keys to display the [Exit] menu. 

table: List of Key Operations on the BIOS Setup Utility Window

Key Description

[F1] Displays or hides detailed information.

[Esc] When a submenu window is displayed, exits it and returns to the previous menu. 

When a menu window is displayed, displays the [Exit] menu.

[← ] [→] Switches between menus.

[↑]  [↓] Scrolls through the menu option list.

[Enter] Selects a setting item or displays the submenu of that item.

When a submenu is displayed, pressing the [Esc] key returns to the menu window.

[-] [+] Changes the value of an item.

[F9] Sets the items to the initial values (initial values may be different from the setting 

values at the time of purchase).

[F10] Saves the settings and exits the BIOS Setup Utility.

Advanced Security Server

Save Changes & Exit
Get Default Values
Discard Changes & Exit
Load Previous Values
Save Changes

PhoenixBIOS Setup Utility

Item Specific Help

Main Exit

Execute Command
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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2 Use the [↑] [↓] keys to select the exit mode.
• To save configuration changes before exiting:

Move the cursor to [Save Changes & Exit] and press the [Enter] key. The message "Save 

configuration changes and exit now?" is displayed.

• To exit without saving configuration changes:

Move the cursor to [Discard Changes & Exit] and press the [Enter] key. The message 

"Configuration has not been saved! Save before exiting?" is displayed. 

3 Use the [←] [→] keys to move the cursor to [Yes] or [No], and press the [Enter] 

key. 

• If you selected [Save Changes & Exit] from the [Exit] menu:

Select [Yes] to exit. After saving changes to settings, the BIOS Setup Utility closes and the 

server restarts.

Select [No] to return to the BIOS Setup Utility.

• If you selected [Discard Changes & Exit] from the [Exit] menu:

Select [Yes] to save changes before exit. After saving changes to settings, the BIOS Setup 

Utility closes and the server restarts.

Select [No] to exit without saving changes. The BIOS Setup Utility closes and the OS starts.
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8.2.2 Main Menu

The [Main] menu window is initially displayed when you start the BIOS Setup Utility.

Settings for time and date and for the drives are configured in the [Main] menu window.

table: Items on the Main Menu

Item Setting Description

System Time Present time The system time is set in "hours:minutes:seconds" 

format. The hours should be based on a 24-hour 

clock.

For example, 6:30:00 P.M. is set as "18", "30", 

"00".

Note: 

� Repeat the procedure until the correct time 

is set. 
If a highly precise system time is necessary, 

install a network synchronized time system 

(NTP, etc.).

System Date Present date The system date is set in "month:day:year" format.

For example, August 20, 2005 is set as "08", "20", 

"2005".

Diskette A 1.44/1.25MB 3 1/2" 
(Fixed parameter)

Specifies the type of floppy disk drive A (recording 

density and drive size).

Parallel ATA [Enter] Sets the type and operating mode for the connected 

internal hard disk unit. 
�"8.2.3 Parallel ATA Submenu" (pg.195)

SATA Port 0 [Enter] This server does not use this port.

SATA Port 1 [Enter]

Boot Options [Enter] Sets system startup options.

�"8.2.4 Boot Options Submenu" (pg.197)

Base Memory  - Available base memory size of up to 1MB is 

displayed.

Extended Memory  - Memory size of 1MB or more is displayed.

Advanced Security Server Exit

System Time:  [HH:MM:SS]
System Date:  [MM:DD:YYYY]

Diskette A:  [1.44/1.25 MB 31/2"]

Parallel ATA         [SR244W]
SATA Port 0          [Auto]
SATA Port 1          [Auto]

Boot Options

Base Memory:
  

640 KB
Extended Memory:

 
260608 KB

PhoenixBIOS Setup Utility

Item Specific Help

Main

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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8.2.3 Parallel ATA Submenu

Appears when [Parallel ATA] is selected from the [Main] menu.  
Sets the type and operating mode for the connected internal hard disk unit.

table: Items on the Parallel ATA Submenu

Item Setting Description

Type Auto (Fixed parameter) Sets the type of the IDE device.

Note: 

� If the value is set to [None], the next menu is 

not displayed.

CHS Format, Cylinders, 

Heads, Sectors, Maximum 

Capacity

 - Displays or sets the number of cylinders, number of 

heads, number of sectors, and the maximum 

capacity detected by the server.

Those items are displayed if [Type] is set to [User].

LBA Format,  
Total Sectors,  
Maximum Capacity

 - Displays or sets the total number of sectors and the 

maximum capacity of the disk detected by the 

server.

Those items are displayed if [Type] is set to [User].

Transfers Mode  - (Fixed parameter) When [Type] is set to [Auto], displays the number 

of sectors to transfer at once detected by the server.

Sets the number of sectors to transfer at once if 

[Type] is set to [CD-ROM], [Other ATAPI], 

[ATAPI Removable], [IDE Removable] or [User].

The disk access speed increases if a larger number 

of sectors is specified to transfer simultaneously.

LBA Translation  - (Fixed parameter) Sets whether to enable or disable the Logical Block 

Addressing (LBA: access based on logical serial 

numbers).

When [Type] is set to [Auto], the current settings 

appear.

It can be set when [Type] is set to [CD-ROM], 

[Other ATAPI], [ATAPI Removable], [IDE 

Removable] or [User].

PhoenixBIOS Setup Utility

Item Specific Help

Main

Type:              [Auto]

Transfers mode:     [Disabled]
LBA Translation:    [Disabled]
PIO Mode:           [Standard]   
32 Bit I/O:         [Disabled]
Ultra DMA Mode      [Disabled]

Parallel ATA  [SR243T]

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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PIO Mode  - (Fixed parameter) Sets the Programmed I/O (PIO) data transfer mode.

When [Type] is set to [Auto], the current settings 

appear.

It can be set when [Type] is set to [CD-ROM], 

[Other ATAPI], [ATAPI Removable], [IDE 

Removable] or [User].

32 Bit I/O Disabled (Fixed parameter) Specifies the bus width for data transfer between 

the CPU and the IDE controller.

It can be set when [Type] is set to [CD-ROM], 

[Other ATAPI], [ATAPI Removable], [IDE 

Removable] or [User].

Ultra DMA Mode  - (Fixed parameter) Sets the Direct Memory Access (DMA) data 

transfer mode.

When [Type] is set to [Auto], the current settings 

appear.

It can be set when [Type] is set to [CD-ROM], 

[Other ATAPI], [ATAPI Removable], [IDE 

Removable] or [User].

table: Items on the Parallel ATA Submenu

Item Setting Description
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8.2.4 Boot Options Submenu

Appears when [Boot Options] is selected from the [Main] menu. 
 Sets system startup options.

table: Items on the Boot Options Submenu

Item Setting Description

POST Errors Enabled (Fixed parameter) Sets whether or not to stop the boot process and 

shut down the system, in case a POST (Power On 

Self Test) error is detected.

Keyboard Check • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to check keyboard connection 

during POST.

SM Error Halt Enabled (Fixed parameter) Sets whether or not to stop the boot process and 

shut down the system in case a fan error, a 

temperature sensor error, or a voltage error is 

detected.

Quick Boot Disabled (Fixed parameter) Sets whether or not to run POST in short mode.

Quiet Boot • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to display the logo screen 

instead of POST information.

Memory Testing Enabled (Fixed parameter) Sets whether or not to check the memory during 

POST.

Boot Menu • Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable the boot menu.

Boot Sequence  - Sets the order of selected drives to boot the OS. 

�"■ Boot Sequence Submenu" (pg.198)

MultiBoot for HDs Enabled (Fixed parameter) Sets whether to enable or not to specify the order of 

hard disks to boot the OS when multiple hard disk 

units are installed.

PhoenixBIOS Setup Utility

Item Specific Help

Main

POST Errors:  [Enabled]
Keyboard Check:      [Enabled]
SM Error Halt        [Enabled]
Quick Boot:          [Disabled]
Quiet Boot:          [Enabled]
Memory Testing:      [Enabled]
Boot Menu:           [Enabled]

Boot Sequence:
MultiBoot for HDs [Enabled]

Boot Options

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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■ Boot Sequence Submenu

Sets the order of selected drives to boot the OS. 

table: Items on the Boot Sequence Submenu

Item Description

(The boot order is described.)

• CD-ROM Drive

• Removable Devices

• Hard Drive

• IBA GE Slot 0208 v1217

• IBA GE Slot 0430 v1217

[IBA GE Slot 0208 v1217] and [IBA GE Slot 0430 v1217] can be displayed or 

changed when [Option ROM Scan] of [PCI Device, Embedded Ethernet A/B] on 

the "■ Ethernet on Board Submenu" (�pg.203) displayed from the [PCI 

Configuration] submenu of the [Advanced] menu is set to [Enabled].

• [+] [-] keys: Change the order of priority for the selected device.

• [Ctrl] + [Enter] keys: Display detailed information on all devices indicated 

with "+".

• [Shift] + [1] keys: Enable or disable booting from the selected device.

• [Enter] key: Displays detailed information on the selected device indicated 

with "+", or hides such information when the selected device is indicated with 

"-".

• [n] key: Switches the device to be recognized between [Removable Device] 

and [HDD].
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8.2.5 Advanced Menu

Configures peripheral and PCI devices.

table: Items on the Advanced Menu

Item Setting Description

Peripheral Configuration [Enter] Configures the serial port, parallel port, etc.

�"8.2.6 Peripheral Configuration Submenu" 

(pg.200)

PCI Configuration [Enter] Configures the PCI device.

�"8.2.7 PCI Configuration Submenu" (pg.202)

Advanced System 

Configuration

[Enter] Configures additional settings.

�"8.2.8 Advanced System Configuration 

Submenu" (pg.204)

Power On/Off [Enter] Configures power On/Off settings.

�"8.2.9 Power On/Off Submenu" (pg.206)

Reset Configuration Data • Yes

• No (at the time of 

purchase)

Sets the initialization of the Extended System 

Configuration Data (ESCD) where the system 

resources are recorded.

This setting is changed to [No] whenever the 

system is restarted.

Secured Setup 

Configurations

No (Fixed parameter) Sets whether or not to reject setting changes made 

by the Plug&Play OS.

Multiprocessor 

Specification

1.4 (Fixed parameter) Sets the version of the multiprocessor to use.

Windows 2003 EMS 

Function

• Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable the EMS 

functions. 

Large Disk Access Mode DOS (Fixed parameter) Sets the hard disk access type supporting large-

capacity hard disk drives.

Item Specific Help
Setup Warning

PhoenixBIOS Setup Utility

Main Advanced Security Server Exit

Setting items on this menu to incorrect 
values may cause your system to malfunction.

Peripheral Configuration
PCI Configuration
Advanced System Configuration

Power On/Off

Reset Configuration Data:          [No]
Secured Setup Configurations:      [No]
Multiprocessor Specification:      [1.4]
Windows 2003 EMS Function:         [Enabled]

Large Disk Access Mode:            [DOS]
S-ATA Interface:                   [Enabled]
S-ATA Mode:                        [Legacy IDE]
LSI SATA RAID:                     [Disabled]

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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8.2.6 Peripheral Configuration Submenu

Appears when [Peripheral Configuration] is selected from the [Advanced] menu. 
Configures the serial ports, parallel ports, etc.

S-ATA Interface Enabled (Fixed parameter) This option is not used by the server.

S-ATA Mode Legacy IDE (Fixed 

parameter)

It can be set when [S-ATA Interface] is set to 

[Enabled] and [LSI SATA RAID] is set to 

[Disabled]. This option is not used by the server.

LSI SATA RAID Disabled (Fixed parameter) It can be set when [S-ATA Interface] is set to 

[Enabled]. This option is not used by the server.

table: Items on the Peripheral Configuration Submenu

Item Setting Description

Serial • Disabled (at the time of 

purchase)

• Enabled

• Auto 

Sets whether to enable or disable the serial port.

Base I/O address • 3F8/IRQ 4 (at the time of 

purchase)

• 2F8/IRQ 3

• 3E8/IRQ 4

• 2E8/IRQ 3

Sets the I/O port address of a serial port.

It is displayed when [Serial] is set to [Enabled].

table: Items on the Advanced Menu

Item Setting Description

Item Specific Help

PhoenixBIOS Setup Utility

Advanced

Serial:                  [Disabled]
Serial Multiplexer:      [BMC]
Floppy Type:             [Local]
Diskette Controller:     [Enabled]
Mouse Controller:        [Auto Detect]

Peripheral Configuration

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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Serial Multiplexer • System

• BMC (at the time of 

purchase)

• Shared

Changes the function of the serial port.

• System

Used as a serial port.

• BMC

Enables the remote control function.

"Appendix C Remote Control Function and 

Console Redirection" (�pg.265)

• Shared

Switches between [System] and [BMC] 

automatically. The remote control function and 

console redirection can be used together.

Floppy Type  Local (Fixed parameter) When using the server's floppy disk unit, set to 

[Local]. 

When using a remote floppy disk drive or floppy 

disk image, set to [Remote] or [Remote Once]. 

Diskette Controller • Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable the floppy disk 

controller.

Mouse Controller • Disabled

• Enabled

• Auto Detect (at the time 

of purchase)

Sets whether or not to use the mouse connected to 

the mouse connector.

table: Items on the Peripheral Configuration Submenu

Item Setting Description
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8.2.7 PCI Configuration Submenu

Appears when [PCI Configuration] is selected from the [Advanced] menu. 
Configures the PCI devices.

table: Items on the PCI Configuration Submenu

Item Setting Description

Ethernet on Board [Enter] Configures the LAN controller on the baseboard.

�"■ Ethernet on Board Submenu" (pg.203)

PCI IRQ Configuration [Enter] Sets PCI IRQs for the PCI slots.

�"■ PCI IRQ Configuration Submenu" (pg.203)

PCI SLOTS Configuration [Enter] Configures the PCI slots.

�"■ PCI SLOTS Configuration Submenu" 

(pg.203)

Item Specific Help

PhoenixBIOS Setup Utility

Advanced

Ethernet on Board

PCI IRQ Configuration

PCI SLOTS Configuration

PCI Configuration

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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■ Ethernet on Board Submenu

Configures the LAN controller on the baseboard.

■ PCI IRQ Configuration Submenu

Sets PCI IRQs for the PCI slots.

■ PCI SLOTS Configuration Submenu

Configures the PCI slots.

table: Items on the Ethernet on Board Submenu

Item Setting Description

Device Enabled (Fixed parameter) Sets whether or not to use Ethernet controller A on 

the baseboard.

Option ROM Scan • Disabled (at the time of 

purchase)

• Enabled

Sets whether or not to initialize the extended ROM.

This value can be selected when [Device] is set to 

[Enabled].

Latency Timer 0040h (Fixed parameter) Sets the minimum guarantee time in the PCI bus 

clock unit for the PCI bus master method.

This value can be selected when [Device] is set to 

[Enabled].

table: Items on the PCI IRQ Configuration Submenu

Item Setting Description

PCI IRQ Line 0/VGA Auto (Fixed parameter) Sets a PCI IRQ for the VGA controller on the 

baseboard.

PCI IRQ Line 1/

ETHERNET B

Sets a PCI IRQ for the LAN controller on the 

baseboard.

table: Items on the PCI SLOTS Configuration Submenu

Item Setting Description

Option ROM Scan • Disabled (when PCI Slot 2 

is purchased)

• Enabled (fixed for PCI Slot 

1)

Sets whether or not to initialize the extended 

ROM. For notes on settings, refer to "7.4.2 

Installable Expansion Cards and Notes" 

(�pg.171).

Bus Master Enabled (Fixed parameter) Sets whether or not the PCI slot is operated as the 

bus master.

Latency Timer 0040h (Fixed parameter) Sets the minimum guarantee time in the PCI bus 

clock unit for the PCI bus master method.
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8.2.8 Advanced System Configuration Submenu

Appears when [Advanced System Configuration] is selected from the [Advanced] menu. 
The submenu configures additional settings.

table: Items on the Advanced System Configuration Submenu

Item Setting Description

CPU Settings [Enter] Configures the CPU clock frequency.

�"■ CPU Settings Submenu" (pg.205)

USB Host 1.1 Controller • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to use the USB host controller 

(2.0 or 1.1).
USB Host 2.0 Controller

USB BIOS Legacy Support • Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable a USB-compatible 

keyboard in an MS-DOS environment. This item 

can be set when [USB Host 1.1 Controller] is set to 

[Enabled].

BIOS Work Space Location Top of Base Memory 

(Fixed parameter)

Selects the BIOS work space.

Item Specific Help

PhoenixBIOS Setup Utility

Advanced

CPU Settings               [Auto]

USB 1.1 Host Controller:   [Enabled]
USB 2.0 Host Controller:   [Enabled]
USB BIOS Legacy Support:   [Enabled]
BIOS Work Space Location:  [Top of Base Memory]

Advanced System Configuration

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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■ CPU Settings Submenu

Sets the CPU clock frequency, etc.

table: Items on the CPU Settings Submenu

Item Setting Description

CPU Mismatch Detection Enabled (Fixed parameter) Sets whether to enable or disable the CPU clock 

frequency checking.

Hyper Threading • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to run one CPU as a dual-

processing CPU.

The setting [Enabled] may enhance processing 

performance by allowing maximum use of the CPU 

resources.

Note: 

� This item can be set only when using the 

optional 3EGHz CPU.

Some operating systems and applications 

do not support the Hyper-Threading 

function.

� For Windows 2000 Server, if this item is 

changed after installation of the OS, you 

need to change the OS setup. Refer to "9.8 

Changing OS Settings" (�pg.254).  
This change is performed automatically on 

Windows Server 2003.

L3 Cache Enabled (Fixed parameter) Sets whether to enable or disable the L3 cache of 

the processor.

Delay prior to Enabling the 

TCC

1 (Fixed parameter) Configures the CPU internal setting. 

Fast String operations Enabled (Fixed parameter)

Compatible FPU Code Disabled (Fixed parameter)

Split Lock operations Enabled (Fixed parameter)

Adjacent Sector Prefetch Enabled (Fixed parameter)

APIC Enabled (Fixed parameter) Sets an interrupt control for the CPU in a 

multiprocessor environment.
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8.2.9 Power On/Off Submenu

Appears when [Power On/Off] is selected from the [Advanced] menu. 
Configures power On/Off settings.

table: Items on the Power On/Off Submenu

Item Setting Description

Remote • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not the power can be turned on 

when the modem (connected to the serial port) 

receives a ring signal.

Resume On Time • Off (at the time of 

purchase)

• On

Sets whether or not to resume from suspend mode 

at the specified time.

Resume Time  - Specifies the time to resume in the 24-hour 

"hours:minutes:seconds" format.

LAN • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to enable the power to be turned 

on via LAN.

Power Failure Recovery • Always OFF

• Previous State (at the 

time of purchase)

• Always ON

Sets the server power status after system down due 

to power failure or after power recovery by the 

UPS.

Note: 

� If the server power is turned off 

automatically by the OS for Windows Serer 

2003 or others and if you use the scheduled 

operation using the UPS, set this item to 

[Always ON].

Item Specific Help

PhoenixBIOS Setup Utility

Advanced

Power On Source
 Remote:               [Enabled]
 Resume On Time:       [Off] 
 Resume Time:          [00:00:00]
 LAN:                  [Enabled]

Power Failure Recovery:[Previous State]

Power On/Off

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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8.2.10Security Menu

Configures the security features.

table: Items on the Security Menu

Item Setting Description

Setup Password/System 

Password

 - Displays whether each password is set.

[Not installed] appears when the password is not 

set, and [Installed] appears when it is set.

Set Setup Password [Enter] Sets a setup password.  The setup password 

prevents unauthorized startup of the BIOS Setup 

Utility.

For procedures for setting, changing, and deleting 

the password, refer to "9.4.2 Security against 

Unauthorized Use" (�pg.245).

Set System Password [Enter] Sets a system password. The system password 

prevents unauthorized access to the system.

A setup password must be specified. 

For procedures for setting, changing, and deleting 

the password, refer to "9.4.2 Security against 

Unauthorized Use" (�pg.245).

Setup Password Lock • Standard (at the time of 

purchase)

• Extended

Sets the scope protected by the setup password. 

A setup password must be specified. 

• Standard

You will be requested to enter the setup password 

while the BIOS Setup Utility is starting up.

• Extended

You will be requested to enter the setup password 

when the BIOS Setup Utility starts up. The BIOS 

for the expansion cards is locked during POST.

SETUP prompt • Disabled

• Enabled (at the time of 

purchase)

Sets whether or not to display the setup message 

"Press <F2> to enter SETUP." in the [POST] 

window during system restart. 

 

Item Specific Help

PhoenixBIOS Setup Utility

Main Advanced Security Server Exit

Setup Password         Not installed
System Password        Not installed

Set Setup Password:    [Enter]
Set System Password:   [Enter]
Setup Password Lock:   [Standard]

SETUP prompt:          [Enabled]
Virus Warning:         [Disabled]
System Load:           [Standard]

Diskette Write:        [Enabled]
Flash Write:           [Enabled]

Select  Sub-Menu

 F1
Esc

Select Item
 Select Menu

 Change Values

 
 -/+

Enter
Info
Exit

F9
F10

Setup Defaults
Save and Exit
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Virus Warning Disabled (Fixed parameter) Sets whether or not to check for changes in the boot 

sector of the hard disk drive after the previous 

system startup. If the boot sector is changed without 

a clear reason, it is necessary to scan the system for 

computer viruses with a virus detection program.

System Load • Standard (at the time of 

purchase)

• Diskette/CDROM Lock

Sets whether to enable or disable system startup 

from a floppy disk or CD-ROM.

This setting is possible when a setup password is 

specified.

Diskette Write • Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable write protect on a 

floppy disk.

Flash Write • Disabled

• Enabled (at the time of 

purchase)

Sets whether to enable or disable write protect in 

the system BIOS.

table: Items on the Security Menu

Item Setting Description
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8.2.11Server Menu

Configures server settings.

table: Items on the Server Menu

Item Setting Description

O/S Boot Timeout • Disabled (at the time of 

purchase)

• Enabled

Sets whether to enable or disable the OS Boot 

Monitoring function, when ServerView is installed 

to the OS. 

If for some reason booting the operating system is 

interrupted when this function is enabled, the 

system will automatically restart.

The OS Boot Monitoring function can also be 

enabled or disabled from ServerView. 

Note: 

� If ServerView is not installed to the OS, be 

sure to set to [Disabled]. 

If the setting is enabled, the server may 

automatically turn off or restart 

unexpectedly.

Even when ServerView is installed on the 

OS, if starting the system while the Server 

Management Tools disk is inserted, be sure 

to disable the OS Boot Monitoring function.

If the system is started with this function 

enabled, the server may automatically turn 

off or restart improperly.

If the OS Boot Monitoring function is 

needed, it should be reset to enabled before 

resuming normal server operation. 

When setting this function, refer to 

"ServerView User's Guide" to fully learn 

about its specifications, in order to use it 

properly with the correct settings.

Item Specific Help

PhoenixBIOS Setup Utility

Main Advanced Security Server Exit

O/S Boot Timeout:               [Disabled]
  Mode                          [Continue]
  Timeout value                 [  0]
ASR&R Boot Delay(min):          [ 2]
Power Cycle Delay:              [10]
Boot Retry Counter:             [3]
Diagnostic System:              [Disabled]
Next Boot uses:                 [Boot Option]
Diagnostic PXE boot device      [ 0]
Critical Temperature Monitoring:[Disabled]
Clear Screen Delay(sec):        [ 5]

IPMI

CPU Status
Memory Status

Console Redirection

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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Mode • Continue (at the time of 

purchase)

• Reset 

• Power Cycle

Sets the operation to be performed when a timeout 

occurs during OS boot monitoring.

• Continue: The boot sequence is continued.

• Reset: The server restarts automatically and 

starts POST.

• Power Cycle: The server turns off automatically. 

The server turns on automatically after the time 

specified in [Power cycle Delay].

Timeout Value •  0 (at the time of 

purchase)

•  1–100

When [O/S Boot Timeout] is set to [Enabled], the 

system restarts automatically if the OS fails to start 

up within the time set for this item.

ASR&R Boot Delay (min) • 2 (at the time of 

purchase)

• 1–30

Sets the standby time for startup after shutdown due 

to trouble (such as overheating) in minutes. The 

system restarts after the set standby time.

Power Cycle Delay 10 (Fixed parameter) Sets the time until the server is turned on after it is 

turned off.

Boot Retry Counter • 0

• 1

• 2

• 3 (at the time of 

purchase)

• 4

• 5

• 6

• 7

Sets the maximum number of attempts to boot the 

OS within the range of 0 to 7.

Diagnostic System Disabled (Fixed parameter) Sets the operation to be performed when the 

number of system boot retries exceeds the number 

specified in [Boot Retry Counter].

Next Boot uses Boot Option (Fixed 

parameter) 

Specifies how to boot the system at the next startup.

This value can be selected when [Diagnostic 

System] is set to [LAN] or [Remote Image Disk].

Diagnostic PXE boot 

device

0 (Fixed parameter) The server does not support this.

Critical Temperature 

Monitoring

• Disabled (at the time of 

purchase)

• Enabled

Sets whether or not to turn the power off in the 

event of abnormal temperature.

Clear Screen Delay (sec) • 5 (at the time of 

purchase)

• 0–31

Sets the time (seconds) during which the last BIOS 

message screen is displayed before the OS starts up.

IPMI [Enter] Configures the Baseboard Management Controller 

(BMC).

�"8.2.12 IPMI Submenu" (pg.211)

CPU Status [Enter] Displays whether or not to allow the use of the 

installed CPU.

�"8.2.13 CPU Status Submenu" (pg.212)

Memory Status [Enter] Sets whether or not to allow the use of the installed 

memory.

�"8.2.14 Memory Status Submenu" (pg.213)

Console Redirection [Enter] Configures detailed settings for console redirection.

�"8.2.15 Console Redirection Submenu" (pg.214)

table: Items on the Server Menu

Item Setting Description
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8.2.12 IPMI Submenu

Appears when [IPMI] is selected from the [Server] menu. 
Configures the Baseboard Management Controller (BMC).

table: Items on the IPMI Submenu

Item Setting Description

IPMI Specification 

Version

 - Displays the IPMI Specification version.

BMC Firmware  - Displays the BMC Firmware version.

Clear System Event 

Log 

• Disabled (at the time 

of purchase)

• Enabled

Deletes the logs stored in the system event log.

Event Log Full Mode • Overwrite (at the 

time of purchase)

• Maintain

Configures the log when full System Event Log is 

indicated.

• Overwrite: Logs are overwritten in old to new order.

• Maintain: Existing logs are maintained. No new logs are 

recorded.

Note: 

� Before changing the setting for this item, be sure to 

use [Clear System Event Log] to delete the system 

event log.

Existing Event Log 

number

 - Displays the number of recorded logs.

Remaining Event Log 

number

 - Displays the number of remaining logs that can be 

recorded.

System Event Log [Enter] Displays the contents of the system event log.

For details on contents, refer to "9.3 System Event Log" 

(�pg.239).

PhoenixBIOS Setup Utility

Item Specific Help

IPMI Specification Version     n.n
  BMC Firmware                 n.nn.nnnnnnnn
Clear System Event Log        [Disabled] 
Event Log Full Mode           [Overwrite]
Existing Event Log number     nnn
Remaining Event Log number    nnn

System Event Log
System Event Log (list mode)
Realtime Sensor Data

LAN Settings

IPMI

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit

Server
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■ LAN Settings Submenu

These menu items are fixed on this server. If you need to configure the LAN setup including IP 

addresses, refer to "9.3.4 Before Using the Remote Control Service" (�pg.242) and use the Server 

Management Tools.

8.2.13CPU Status Submenu

Appears when [CPU Status] is selected from the [Server] menu. 
This submenu sets whether or not to allow the use of the installed CPU.

System Event Log 
 (List mode)

[Enter] Lists the contents of the system event log.

For details on contents, refer to "9.3 System Event Log" 

(�pg.239).

Realtime Sensor Data [Enter] Displays temperature and voltage sensor data.

LAN Settings [Enter] Performs LAN settings to enable remote operations using 

Remote Control Service.

�"■ LAN Settings Submenu" (pg.212)

table: Items on the CPU Status Submenu

Item Setting Description

CPU Status • Enabled (at the time of 

purchase)

• Disabled

• Failed 

Sets whether or not to allow the use of CPUs 

installed in the CPU sockets. This must not be set to 

[Disabled] or [Failed].

table: Items on the IPMI Submenu

Item Setting Description

Item Specific Help

PhoenixBIOS Setup Utility

Server

CPU Status  [Enabled]

CPU Status

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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8.2.14Memory Status Submenu

Appears when [Memory Status] is selected from the [Server] menu. 
This submenu sets whether or not to allow the use of the installed memory.

table: Items on the Memory Status Submenu

Item Setting Description

DIMM 0 • Enabled (at the time of 

purchase)

• Disabled

• Failed 

Sets whether or not to allow the use of memory in 

Memory Slots 1 to 4. 
This must not be set to [Disabled] or [Failed].

DIMM 1

DIMM 2

DIMM 3

Item Specific Help

PhoenixBIOS Setup Utility

Server

ChannelA
DIMM 0:            [Enabled]
DIMM 1:            [Enabled]
ChannelB
DIMM 2:            [Enabled]
DIMM 3:            [Enabled]

Memory Status

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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8.2.15Console Redirection Submenu

Appears when [Console Redirection] is selected from the [Server] menu. 
This submenu configures detailed settings for console redirection.

table: Items on the Console Redirection Submenu

Item Setting Description

Console Redirection Port • Disabled (at the time of 

purchase)

• Enabled

Sets whether to enable or disable console 

redirection. 

Port • Serial (Display only) Displays the serial port to be used for console 

redirection.

This item appears when [Console Redirection Port] 

is set to [Enabled].

Media Type • Serial (at the time of 

purchase)

• LAN

Sets the connection type for console redirection.

This item appears when [Console Redirection Port] 

is set to [Enabled].

• Serial 

Console redirection is performed via the serial 

port.

• LAN

Console redirection is performed via the LAN.

Console connection Direct (Fixed parameter) Specifies the method of connection with the 

console.

This item is displayed when [Console Redirection 

Port] is set to [Enabled] and [Media Type] is set to 

[Serial].

• Direct 

Direct connection

• Via modem

Connection via a modem

Item Specific Help

PhoenixBIOS Setup Utility

Server

Console Redirection Port:        [Disabled]

Console Redirection

Select  Sub-Menu
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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Baud Rate • 300

• 1200

• 2400

• 9600 (at the time of 

purchase)

• 19.2K

• 38.4K

• 57.6K

• 115.2K

Sets the baud rate for console redirection.

This item appears when [Console Redirection Port] 

is set to [Enabled].

Protocol • VT100

• VT100, 8bit

• PC-ANSI, 7bit

• PC ANSI

• VT100+ (at the time of 

purchase)

• VT-UTF8

Sets the console type for console redirection.

This item appears when [Console Redirection Port] 

is set to [Enabled].

Flow Control • None (at the time of 

purchase)

• XON/XOFF

• CTS/RTS

Sets the flow control.

This item appears when [Console Redirection Port] 

is set to [Enabled].

Mode • Standard

• Enhanced (at the time of 

purchase)

Sets the range of use for console redirection.

This item appears when [Console Redirection Port] 

is set to [Enabled].

table: Items on the Console Redirection Submenu

Item Setting Description
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8.2.16Exit Menu

Exits BIOS Setup.

table: Items on the Exit Menu

Item Description

Save Changes & Exit Saves the current settings on the CMOS and exits the BIOS Setup Utility. The 

server restarts at the same time.

Get Default Values Loads and displays the default settings for the server.

Note: 

� If you load the initial values and save the settings, the LAN settins for 

remote operation using Remote Control Service is initialized. If you load 

the initial values using this item and save them, configure the LAN setup 

including IP addresses again.

Refer to "■ LAN Settings Submenu" (�pg.212) on the [IPMI] submenu 

of [Server] menu.

�"9.3.4 Before Using the Remote Control Service" (pg.242)

Discard Changes & Exit Exits the BIOS Setup Utility without saving current settings. Previously saved 

settings remain valid.

Load Previous Values Loads and displays the settings that were enabled when the BIOS Setup Utility 

started up.

Save Changes Save the settings on the CMOS.

Advanced Security Server

Save Changes & Exit
Get Default Values
Discard Changes & Exit
Load Previous Values
Save Changes

PhoenixBIOS Setup Utility

Item Specific Help

Main Exit

Execute Command
F1
Esc

Select Item
Select Menu

Change Values-/+
Enter

Info
Exit

F9
F10

Setup Defaults
Save and Exit
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Chapter 9 

Operation and 
Maintenance

This chapter explains the operations necessary 

after starting to use this server as well as daily 

care and maintenance.

9.1 Daily Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218

9.2 Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 221

9.3 System Event Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

9.4 Securities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244

9.5 Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248

9.6 Restoring the System  . . . . . . . . . . . . . . . . . . . . . . . . . . . 251

9.7 Reinstalling the OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

9.8 Changing OS Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . 254

9.9 Maintenance Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
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9.1 Daily Maintenance

This section explains how to check the status of the operating server, as well as how 

to perform daily maintenance.

9.1.1 Checking the Server Condition

Use the status LED or server monitoring tool to check the server status.

■ Checking Each LED

This server is equipped with LEDs that display various hardware conditions.

Check the server status via each LED after starting the server. For positions and functions of each status 

LED, refer to "1.3 Component Names and Functions" (�pg.22).

■ Server Monitoring Tool (ServerView)

ServerView is software that monitors whether the server hardware is in a normal state to protect 

important server resources. When using ServerView, the server hardware is monitored all the time. If an 

error that could cause trouble is detected, the administrator is notified in real-time for early detection. 

This allows the server administrator to remove a system error early and avoid trouble.

For an overview and installation of ServerView and other high reliability tools, refer to "1.2.2 High 

Reliability Tools" (�pg.19) and "Chapter 6 High Reliability Tools" (�pg.155).

9.1.2 Cleaning

Clean the server at regular intervals.

Clean the server as follows.

■ Cleaning the Server

Wipe with a soft, dry cloth. For stains that do not come off with a dry cloth, wipe with a cloth lightly 

dampened with a mild detergent. Once the stain has been removed, wipe off any remaining detergent 

with a cloth dampened with water. When wiping the server, be sure that no moisture enters the server 

machine.  
Do not use solvents. Use a mild detergent only. Otherwise, the server may be damaged.  
Use a vacuum cleaner periodically to prevent dust buildup in ventilation holes.

• Before cleaning, turn off the server and unplug the power cables from the            

outlets. Also power off peripherals and disconnect them from the server.          

(�"1.4.3 Turning Off the Server" (pg.31))

Failure to do so can cause electric shock. 
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� In dusty environments, dust piles up on the front and rear panels of the server over short periods. 

Install the server in a different location to avoid failures.

■ Cleaning the Server Interior

In dusty environments, dust deposits on the server. Dust deposits may cause a server failure, fire, or 

electric shock. To keep the PRIMERGY server in good condition, use a vacuum cleaner periodically to 

remove dust deposits.

Cleaning components

� CPUs: Dust deposits must be removed because it will impair the cooling performance.

� Fans: Remove dust from and around the fans.

� Memory/expansion cards: Remove dust between memory modules and between expansion cards. 

Remove dust from the connector before adding a memory module or an expansion card.

� Internal hard disk units/CD-ROM drive units: Remove dust deposits from units and devices. Tape 

devices are particularly susceptible to dust and may cause failures. Install them in a clean 

environment.

� Be careful when removing components such as CPUs, memory modules, or hard disk units. Be sure to 

install parts and cables in the original position.

� Leaving dust brushed off or blown with air on the server can cause failure. Be sure to take it out of the 

server.

■ Cleaning the Keyboard

Wipe with a soft, dry cloth.

■ Cleaning the Mouse

Wipe the surface with a soft, dry cloth. If the tracking ball does not spin or roll smoothly, remove the ball 

and clean it. Clean the tracking ball as follows.

● Cleaning Method

1 Remove the cover from under the mouse.

Remove the cover under the mouse by rotating it in the direction of the arrow.

• Do not disassemble the PSU when cleaning the server interior. Doing so can            

cause failures or electric shock.
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2 Remove the ball and rinse it with water.

Flip the mouse over to remove the ball. Afterwards, wash it with water.

3 Clean the inside of the mouse.

Wipe the inside of the mouse, the roller, and the bottom cover with a damp cloth.

4 Insert the ball and apply the cover.

After the ball and inside of the mouse are dry, insert the ball and apply the cover.

■ Cleaning the Floppy Disk Drive

Prolonged use of the floppy disk drive accumulates dust on the device head (the part which reads/writes 

data). A dirty head can impair the ability to read/write data to/from a floppy disk correctly. Clean the 

head once every three months.

■  Optional Devices

"PRIMERGY ServerBooks" supplied with the server, and "Supplement" supplied with options. 

Roller
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9.2 Troubleshooting

This section explains the resolutions when the server is not running properly or when 

error messages are displayed.

For each situation, refer to the following. If the problem is not resolved after performing the following 

troubleshooting, contact an office listed in the "Contact Information" of "Start Guide".

When contacting an office listed in the "Contact Information" of "Start Guide", refer to "9.9.2 

Contacting Maintenance Support" (�pg.258) and collect the required information.

• Hardware problems: 

�"9.2.1 Hardware Troubleshooting" (pg.221)

• Error messages: 

�"9.2.2 Error Messages" (pg.226)

• Software problems: 

�"9.2.3 Software Troubleshooting" (pg.230)

9.2.1 Hardware Troubleshooting

This section explains hardware related troubleshooting. When the server does not operate properly or 

error messages appear and a failure is suspected, check the following.

For optional devices, refer to the manual included with the optional device.

■ Server

● The server does not power on, or the power LED on the front of the server 
does not light up.

Check to see whether the power cable is properly connected to the outlet.

For instructions on connecting the power cable, refer to "Start Guide".

● The access LED does not light up.

The server may be damaged. Contact an office listed in the "Contact Information" of "Start Guide".

Before contacting an office listed in the "Contact Information" of "Start Guide", refer to "9.9.2 

Contacting Maintenance Support" (�pg.258).

● An error message is displayed.

Refer to "9.2.2 Error Messages" (�pg.226).

● When an expansion card is added, other expansion cards or onboard 
devices are not recognized.

Reinstall the drivers for the expansion cards or onboard devices that are not recognized.
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■ Display (or Monitor)

● The display does not power on.

Check to see whether the power cable of the display is properly connected to the outlet. For details, refer 

to "Start Guide" or the manual of the display.

● The screen display is distorted when the Linux system is shut down. 

When the system is shut down in the Linux environment, the screen display may be distorted. However, 

the system is shut down normally. It does not affect the system operation.

● Nothing is displayed on the screen.

• Check to see whether the display cable is connected properly.

If it is not connected, turn the server off and then connect the cable. For the connection location, refer 

to "Start Guide".

• Check that the brightness volume and contrast volume of the display are adjusted correctly. If they 

need to be adjusted, perform the necessary adjustments.

For details, refer to the manual of the display.

• There may be an error in the system area of the memory. Contact an office listed in the "Contact 

Information" of "Start Guide".

● Typing the keyboard does not display any characters, or the mouse cursor 
does not move.

Check to see whether the keyboard and mouse are connected properly. If they are not connected, turn the 

server off and then connect the cables to the server. 
For the connection location, refer to "Start Guide".

● The screen shakes.

If a device that produces a strong magnetic field such as a television or speaker is near the display, place 

them further away from the display.

The display may also shake if a nearby cell-phone receives a call. Do not use a cell-phone near the 

display.

● The screen display is distorted.

If a 3D program is executed on Windows Server 2003 or Windows 2000 Server, the screen display may 

be distorted or the 3D program may terminate abnormally. If this occurs, set Color quality in screen 

properties to anything other than True Color (32 bits). 

■ Floppy Disk Drive

● Cannot read or write to the floppy disk.

The head may be dirty.

For cleaning, refer to "9.1.2 Cleaning" (�pg.218). 
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● Cannot write to the floppy disk.

The write protection of the floppy disk may be applied. Flip the switch on the disk to allow writing.

■ CD-ROM Drive Unit

● Cannot read data.

• Check to see whether the CD-ROM is inserted properly.

If it is not inserted, correctly insert the CD-ROM so that the label is facing up.

• Check to see whether the CD-ROM is not dirty.

If it is dirty, wipe it with a soft, dry cloth.

• Check to see whether the CD-ROM is not scratched or bent.

If scratched or damaged, replace the CD-ROM.

● The unit does not operate properly.

Check to see whether the internal cable is connected properly.

If it is not connected, correctly connect the internal cable. For the connection location, refer to "7.7 

Connection of Optional Devices" (�pg.187).

■ Internal Hard Disk Units 

● The unit does not operate properly.

Refer to "7.6 Installing an Internal Hard Disk Unit" (�pg.180).

• Check to see whether the internal cable is connected properly. If it is not connected, correctly connect 

the internal cable.

• Check to see whether the jumper pins are set properly. If they are not set, correctly set the jumper 

pins.

■ System Fan

The server has six system fans. Contact an office listed in the "Contact Information" of "Start Guide" 

when a system fan fails.

● The system fan cable has been disconnected.

Connect the cable as follows.

• If the fan cable is disconnected from the extension cable

Correctly connect a pair of cables of fans 1 and 2, a pair of cables of fans 3 and 4, and a pair of cables 

of fans 6 and 7. Connect them according to the fan numbers indicated on the extension cable 

connectors.
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• If the extension cable is unplugged from the baseboard connector 

Connect the cable by referring to the following table.

■ SCSI Devices

● The unit does not operate properly.

Refer to "Connection via the SCSI Card" of "7.7 Connection of Optional Devices" (�pg.187).

• Check to see whether the cable is connected properly. If it is not connected, correctly connect the 

cable.

• Check to see whether the jumper pins are set correctly. If not, correctly set the jumper pins.

• Check to see whether the SCSI-ID and terminator are set correctly. If not, correctly set the SCSI-ID 

and terminator.

■ Others

● Notes on Operations in RAID1 Configuration

When disks of the server are used in RAID1 redundancy configuration, the disk data is protected even if 

a single hard disk unit has failed. However, if both hard disks have failed, the disk data will be 

permanently lost. Also, if the user repeatedly powers on/off or repeatedly reboots while a single disk unit 

has failed, data reliability may be lost.

If a disk failure is detected, replace the failed disk unit as soon as possible to safeguard customer data.

table: Fan Connector List

Fan number
Fan connector 

number

Fans 1 and 2 CN6 

Fans 3 and 4 CN7 

Fans 6 and 7 CN9 

[Inside the server]

CN9

CN7

CN6 Extension cable

Extension cable

Baseboard

Fan 1 Fan 2 Fan 3

Fan 6 Fan 7

Fan 4
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● Notes on AC Power-Off

If you turn the AC power off when the system is on, the PSU Supply Failure log may be stored.

If the AC Lost log is stored simultaneously as shown below, this will not affect server operation. You 

can continue to use the server without taking any action.

● Notes on Connection to Console Switch 4ch

If you connect the server to port 1 of the Console Switch 4ch (PG-SB104) (called the "switch" hereafter) 

and if the switch has firmware version 1.11, the "KB Error" message may appear and the OS may not 

start up when you reboot the server. 

Check the firmware version of the switch in the following procedures. If it is version 1.11, it is 

recommended to connect the server to a port other than port 1 (that is, any of ports 2 to 4).

Check the firmware version of the switch as follows.

1 Press the [Ctrl] + [Alt] + [Shift] keys simultaneously on the keyboard connected 

to the switch, or press the [Scroll Lock] key twice in succession on the 

keyboard.

The "On-Screen Display" is appears.

2 Press the [n] key to check the firmware version at the right lower end position of 

the window.

● Memory Bank Display by ServerView

ServerView allows you to view the memory module information by selecting [Baseboard (B)] → 

[Memory Module (M)]. However, incorrect bank information may be displayed in a specific system 

configuration. Ignore the bank information if it is displayed as follows.

Power Supply21:58:28 Feb 04, 2003

PSU1, Power Supply Failure Detected, Assertion

Power Unit21:58:28 Feb 04, 2003

Power Unit, AC lost Assertion

Ignore items in the frame.
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9.2.2  Error Messages

This section explains the error messages for this server.

■ POST Error Messages

This section explains error messages of POST (Power On Self Test: a device check performed during the 

server startup). 

If an error occurs during POST, the following messages are displayed.

table: List of POST Errors

Message Contents

Failure Fixed Disk Check the [Parallel ATA] settings on the "8.2.2 Main Menu" 

(�pg.194) of the BIOS Setup Utility. If the message still 

appears, the baseboard must be replaced. Contact an office listed 

in the "Contact Information" of "Start Guide".

Stuck Key Remove objects, if any, that are pressing against any keys on the 

keyboard. Check to see whether the keyboard is connected 

properly. If the message still appears even though the server has 

been restarted, replace the keyboard. If the message still 

appears, the baseboard must be replaced. Contact an office listed 

in the "Contact Information" of "Start Guide".

Keyboard error

Keyboard controller error Remove objects, if any, that are pressing against any keys on the 

keyboard. Check to see whether the keyboard is connected 

properly. If the message still appears, replace the keyboard. If 

the message still appears after keyboard replacement, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

System RAM Failed at offset: nnnnnnnnh Turn the server off and check that the memory modules are 

installed properly. If the message appears after the server is 

turned on, check the system event log and replace the memory 

modules. If the message still appears, the baseboard must be 

replaced. Contact an office listed in the "Contact Information" 

of "Start Guide".

Shadow RAM Failed at offset: nnnnnnnnh

Extended RAM Failed at address line: nnnnh

Memory type mixing detected. The CPU is abnormal. Check that the correct CPUs are installed. 

If the message still appears, the baseboard must be replaced. 

Contact an office listed in the "Contact Information" of "Start 

Guide".

Memory decreased in Size The memory is abnormal. Refer to the system event log and 

replace the abnormal DIMM. If the message still appears, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

�"7.3 Installing Memory Modules" (pg.166)

Non Fujitsu Siemens Memory Module 

detected - Warranty restricted!

The memory is abnormal. Check to see that the jumper pin 

settings or BIOS Setup Utility settings are correct. If the 

message still appears, the baseboard must be replaced. Contact 

an office listed in the "Contact Information" of "Start Guide".

→"Chapter 8 Hardware Configuration/Utilities" (�pg.189)

System battery is dead - Replace and run 

SETUP

The battery is abnormal. Contact an office listed in the "Contact 

Information" of "Start Guide".

System CMOS checksum bad - Default 

configuration used

Correct the current settings with the BIOS Setup Utility or 

restore the settings at the time of purchase. If the message still 

appears, the baseboard must be replaced. Contact an office listed 

in the "Contact Information" of "Start Guide".
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System timer error Turn the server off and back on. If the message still appears, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

Real time clock error Check the date and time settings on the "8.2.2 Main Menu" 

(�pg.194) of the BIOS Setup Utility. If the message still 

appears, the baseboard must be replaced. Contact an office listed 

in the "Contact Information" of "Start Guide".

Check date and time settings

CPU had been changed - Run SETUP. Check that the correct CPUs are installed. If the message 

appears again, change [Reset Configuration Data] on the "8.2.5 

Advanced Menu" (�pg.199) to [Yes] in the BIOS Setup Utility. 

If the message still appears, contact an office listed in the 

"Contact Information" of "Start Guide".

CPU mismatch detected Check that the correct CPUs are installed. If so, update the 

BIOS. If the message appears again, change [Reset 

Configuration Data] on the "8.2.5 Advanced Menu" (�pg.199) 

to [Yes] in the BIOS Setup Utility. If the message still appears, 

contact an office listed in the "Contact Information" of "Start 

Guide".

Baseboard Management Controller Error Turn the server off and unplug the power cables from the server. 

Turn the server back on. If the message still appears, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

Diskette drive A error Check the settings on the "8.2.2 Main Menu" (�pg.194) of the 

BIOS Setup Utility. Check to see whether the floppy disk drive 

cable is connected properly. If the message still appears, contact 

an office listed in the "Contact Information" of "Start Guide".

Incorrect Drive A type - run SETUP

CPU runtime error(IERR#) detected Check the system event logs. If the message still appears, 

contact an office listed in the "Contact Information" of "Start 

Guide".

Memory configuration has changed - Run 

SETUP

The memory is abnormal. Refer to the system event log and 

replace the abnormal DIMM. If the message still appears, 

contact an office listed in the "Contact Information" of "Start 

Guide".

No usable system memory. The memory is abnormal. Refer to the system event log and 

replace the abnormal DIMM. If the message still appears, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

�"7.3 Installing Memory Modules" (pg.166)

Memory module failed! This module is no 

longer available for the operating system.

Turn the server off and check that the memory modules are 

installed properly. If the message appears after the server is 

turned on, check the system event log and replace the memory 

modules. If the message still appears, the baseboard must be 

replaced. Contact an office listed in the "Contact Information" 

of "Start Guide".

No usable CPU The CPU is abnormal. Contact an office listed in the "Contact 

Information" of "Start Guide".

Patch for installed CPU not loaded. Please run 

the bios flash update diskette.

Check that the correct CPUs are installed. If so, update the 

BIOS. If the message appears again, change [Reset 

Configuration Data] on the "8.2.5 Advanced Menu" (�pg.199) 

to [Yes] in the BIOS Setup Utility. If the message still appears, 

contact an office listed in the "Contact Information" of the "Start 

Guide".

table: List of POST Errors

Message Contents
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CPU disable! CPU is no longer available for 

the operating system.

The CPU is abnormal. Contact an office listed in the "Contact 

Information" of "Start Guide".

Invalid System Configuration Data Change [Reset Configuration Data] on "8.2.5 Advanced Menu" 

(�pg.199) to [Yes] in the BIOS Setup Utility. If the message 

still appears, contact an office listed in the "Contact 

Information" of "Start Guide".

Resource Conflict System resources (IRQs, DMA channels, or I/O port addresses) 

conflict.

Start up the BIOS Setup Utility again and check the system 

resource settings.

�"8.2 BIOS Setup Utility" (pg.191)

If the message still appears, contact an office listed in the 

"Contact Information" of "Start Guide".

IRQ not configured Check the settings on the BIOS Setup Utility. If the message still 

appears, replace the expansion card. If the message still appears, 

contact an office listed in the "Contact Information" of "Start 

Guide".

Expansion ROM not initialized On the screen, check the expansion card or device being 

initialized. Replace the card. If the message still appears, contact 

an office listed in the "Contact Information" of "Start Guide".

Allocation error static node # An onboard device or expansion card is abnormal. Replace the 

device or expansion card. If the message still appears, contact an 

office listed in the "Contact Information" of "Start Guide".

Baseboard Management Controller has 

detected an error

Check the system event log and replace the abnormal option.

A temperature has exceeded the warning 

threshold

Temperature is abnormal.

Check and improve the environment. If the message still 

appears, contact an office listed in the "Contact Information" of  

"Start Guide".
A temperature has exceeded the critical 

threshold

CPU fan speed has exceeded the warning 

threshold

A CPU fan is abnormal.

Check for objects hindering CPU fan rotation. If the message 

still appears, contact an office listed in the "Contact 

Information" of "Start Guide".
CPU fan speed has exceeded the critical 

threshold

System fan speed has exceeded the warning 

threshold

A system fan is abnormal.

Check for objects hindering system fan rotation. If the message 

still appears, contact an office listed in the "Contact 

Information" of "Start Guide".
System fan speed has exceeded the critical 

threshold.

Power supply fan speed has exceeded the 

warning threshold.

A power supply unit fan is abnormal.

Check for objects hindering power supply unit fan rotation. If 

the message still appears, contact an office listed in the "Contact 

Information" of "Start Guide".
Power supply fan speed has exceeded the 

critical threshold.

System board voltage has exceeded the critical 

threshold.

Turn the server off and unplug the power cables from the server. 

Turn the server back on. If the message still appears, the 

baseboard must be replaced. Contact an office listed in the 

"Contact Information" of "Start Guide".

System Event Log utilization has exceeded the 

warning threshold. Please save the System 

Event Log to a different media and clear it 

afterwards.

There is no space for system event logs.

Swap or delete logs as necessary.

�"9.3 System Event Log" (pg.239)

table: List of POST Errors

Message Contents
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■ Server Management Tools Error Messages

The following error messages may appear while executing Server Management Tools. Perform the 

corresponding resolution listed in the table. If messages other than the following are displayed, contact 

an office listed in the "Contact Information" of "Start Guide".

table: List of Server Management Tools Error Messages

Message Description

Write protect error writing drive A. 
Abort, Retry, Fail?

The inserted floppy disk is write-protected. Disable the 

write-protect, and then press the [R] key.

Not ready writing drive A. 
Abort, Retry, Fail?

The floppy disk is not inserted into the floppy disk drive. 

Insert the proper floppy disk ("Server Management Tools" 

disk), and then press the [R] key.

ERROR:Fail to create data file. The following are possible causes. Check the floppy disk 

status again.

• The floppy disk is not inserted into the floppy disk drive. 

Insert the proper floppy disk, and then retry.

• The floppy disk is write-protected. Disable the write-

protect and retry.

• The floppy disk contains abnormal contents. Create the 

"Server Management Tools" disk again. If this occurred 

while recovering BIOS information, configure the 

information using the BIOS Setup Utility. Then store the 

BIOS information.

ERROR:Fail to write 1st CMOS data into data 

file. nn

ERROR:Fail to write 2nd CMOS data into data 

file. nn

ERROR:Fail to write ESCD data into the data 

file. nn

ERROR:Fail to write SEEPROM data into the 

data file. nn

ERROR:Fail to open data file. The file for recovering the BIOS information does not exist 

on this floppy disk. Insert the floppy disk on which the BIOS 

information was stored, and then retry.

ERROR:Fail to write 1st CMOS data into system. 

nn

The following are possible causes. Check the floppy disk 

status again.

• The floppy disk is not inserted into the floppy disk drive. 

Insert the proper floppy disk, and then retry.

• A different model or an unsupported version of BIOS 

information. Insert the proper floppy disk, and then retry.

• The floppy disk contains abnormal contents. Create the 

"Server Management Tools" disk again. If this occurred 

while recovering BIOS information, configure the 

information using the BIOS Setup Utility. Then store the 

BIOS information.

ERROR:Fail to write 2nd CMOS data into system 

file. nn

ERROR:Fail to write ESCD data into system file. 

nn

ERROR:Fail to write SEEPROM data into 

system. nn

Other messages Contact an office listed in the "Contact Information" of  

"Start Guide".
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9.2.3 Software Troubleshooting

This section explains software related troubleshooting. For troubles during OS installation or system 

operation, refer to the following contents.

■ Trouble at a ServerStart Startup

● After a boot from the ServerStart CD-ROM, nothing is displayed on the 
screen. 

This problem may occur if the hard disk drive still contains previous information. In that case, this 

problem will occur when the Windows Server 2003 Installation CD-ROM is inserted.

To eliminate this problem, physically format the hard disk drive to delete the previous information and 

start up ServerStart. For physical formatting, refer to "PRIMERGY ServerBooks" supplied with the 

server, or "Supplement" supplied with the RAID card. 

■ Trouble during OS Installation

● Automatic logon fails during Windows 2000 setup.

During OS installation, ServerStart installs applications and hardware utilities supplied with the OS. 

Installation and subsequent restart and logon are performed automatically as necessary. In rare cases, 

however, automatic logon is not performed and the logon window appears. In this widow, use the user 

name and password you have set before starting installation. After logon, the setup procedures are 

continued.

● Automatic installation has stopped at an entry screen during Active 
Directory configuration. 

If automatic installation has stopped during Active Directory configuration, check the error message 

first. Automatic installation can stop when the password is required, such as when registration in DNS 

fails. Check the environment and continue the installation manually. If the problem is not solved, click 

[Cancel] and after the OS installation, manually configure Active Directory.

If you have continued the Active Directory installation wizard manually, the following message appears 

when the installation wizard closes. 

If this message appears, click [Restart] to continue the installation. 

IPMI BMC Not Exist "You must restart Windows to 

make the settings in the Active Directory instal-

lation wizard effective." 
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■ Error Window Appearing after Installation or Uninstallation of 
ServerView or RAID Management Tool (Global Array Manager) on 
Windows Server 2003

Systems with Windows Server 2003 Service Pack 1 may display the following popup message at the 

next startup after installation or uninstallation of ServerView or RAID Management Tool (Global Array 

Manager). This is not a problem. Click [Close message] to close the message.

■ Error Messages during Installation

The following error messages may appear during installation using ServerStart. Check the corrective 

action against the relevant error. 

● "WzDiskAdmin: System Error! ......................... , Last Error: The device is not 
ready." 

Optional SCSI devices (e.g., hard disk cabinet or DAT unit) may be connected. Disconnect the optional 

SCSI devices and perform installation again. Connect the optional devices after the installation 

completes. 

● "WzDiskAdmin: Partition detected! Please delete all partition before starting 
Configuration"

Run the guide or preconfiguration mode again. Check [Delete all partitions on the displayed disk] in the 

disk wizard. 

● "WzRaid: RAID arrays detected! Please delete all RAID arrays before starting 
Configuration"

Use the ServerStart floppy disk you have created. Check [Delete existing RAID array] or select [Use 

existing array] in the RAID wizard. 

● "Operating System not found" appears when the system restarts after file 
copy from the CD-ROM.

The following are possible causes. 

• The array controller card comes later than the onboard SCSI in order of device startup. 

• The Active flag is specified. 

● "Missing Operating System" appears during installation. 

The installation partition size may be too large. Specify the installation partition size correctly. 

For details on the installation partition size, refer to "2.3.1 Installation Partition Size" (�pg.44). 

Windows has terminated the following program to prevent 

damage to your computer. Name:     SNMP Service
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● The "Windows - Too small virtual memory size" message appears after 
completion of "Create ServerStart Floppy Disk". 

This message may be displayed when no disk array is configured and ServerStart is started during 

256MB memory OS installation on the hard disk connected to the RAID card. If the server has 256MB 

memory and install the OS on the hard disk connected to the RAID card, make sure to configure a disk 

array using WebBIOS before starting ServerStart. For details on the WebBIOS, refer to "PRIMERGY 

ServerBooks" supplied with the server, or "Supplement" supplied with the RAID card.  If the disk array 

is already configured, you do not need to reconfigure it.

● The "Windows - Too small virtual memory size" message appears in the 
automatic installation mode.

If you install an OS on the server having 256MB memory and create a 100,000MB or a larger partition, 

this error occurs and installation of the OS will not be successful. 
When creating a 100,000MB or larger partition, use one of the following options.

• Install 512MB or larger memory and reinstall the OS.

• Create partitions less than 100,000MB and reinstall the OS. Then, create the desired size of partition 

using the OS's disk administrative functions.

● "Error 1920. Service (PXE Services) failed to start" appears during 
preconfigured installation. 

The system installed with the preconfigured settings (PXE server) may not be connected to the network. 

Check the LAN cable connection and click [Rerun]. 

■ Error Window Appears after LAN Driver Installation (on Windows 
Server 2003)

The following window may appear when the installation of the LAN driver to the [Ethernet controller] 

under [Other devices] starts.

This is because the LAN driver for the network adapter recognized immediately after the OS installation 

is not updated.
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Clicking [Finish] in this window displays the [Help and Support Center] window. Click [X] to close this 

window.  
The "!" mark is displayed at the LAN device name in Device Manager. Device names are displayed 

properly when all LAN drivers are installed and the system is restarted.  
For details on LAN driver installation, refer to "4.3.1 Installing the LAN Driver (Windows Server 

2003)" (�pg.120). 

■ Application Error in the OS Installation Wizard in ServerStart 
Preconfiguration Mode

Executing the preconfiguration mode on a client computer installed with Microsoft Visual Studio 6.0 

Service Pack 5 will cause an application error. 
Install ServerStart in a client computer in a different environment or use the guided mode on this server. 
This problem does not occur in Windows 2000 Server since it is corrected by Windows 2000 Service 

Pack 4.

■ LAN Operation Fails or Error Message Appears during LAN Driver 
Installation

A conflict may have occurred between system resources including the LAN and other expansion cards. 

Delete all LAN drivers and check that conflicts between system resources do not exist. Then, restart the 

system and install the LAN driver again. For the LAN driver installation procedure, refer to "4.3 

Installing the LAN Driver" (�pg.120). 
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■ Event Log Errors after Installation

After Windows Server 2003 or Windows 2000 Server has been installed, the following events may be 

displayed in Event Viewer. Check and perform the corrective action against the relevant event. 

table: Error events at installation

ID Description Cause and corrective action

9 The device ****, did not respond 

during the timeout time.

This message may appear when an expansion card such as a 

RAID card or a SCSI card is installed. However, this is not a 

problem.
15 The device, ****, is not ready for 

access yet.

62 This computer is a domain PDC at the 

root of forest. Use the net command 

"net time /setsntp:<server name>" to 

configure it for synchronization from 

an external time source. 

Cause:

An NTP was selected as a component.

Corrective action:

ServerStart cannot configure the NTP server automatically due 

to the absence of items for specifying it. After OS installation, 

perform the following procedure to specify the time server. 

1. Start SNTP server operation on another machine. 

Assume that the SNTP server address is 

<172.22.78.246>. 

2. Enter the following at a command prompt. 

net time /setsntp:172.22.78.246

w32tm -s 172.22.78.246

1000 The user or computer name cannot be 

identified. The return value is "1722." 

Cause:

The primary DNS server address may be invalid or the server 

cannot be connected.

Corrective action:

Perform the following procedures to correct the DNS address 

in Internet protocol (TCP/IP) properties.

Right-click [My Network] and click [Properties]. 

1. Right-click [Local Area Connection] and click 

[Properties]. 

2. Click [Internet Protocol (TCP/IP)] and click 

[Properties]. 

3. Enter the correct DNS address in the [Primary DNS 

server] box. 
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■ Cannot Collect the Memory Dump

If the memory dump file cannot be created, perform the following procedures.

● Correct the settings

If the memory dump cannot be collected, check the settings of the paging file and memory dump file.

For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" (�pg.126).

● Collect memory dump to other than the system drive

If the memory dump was set to be collected to the system drive (C:\), change the settings so that the 

memory dump can be saved to a drive other than the system drive.

For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" (�pg.126).

If only the system drive exists, or if there is no free space in any of the drives, perform one of the 

following:

• Adding a hard disk

• Replacing with a larger hard disk

● Reduce the installed memory to collect the memory dump

To obtain memory dump regardless of the installed memory size, reduce the installed memory to an 

obtainable size.

Check the memory dump settings when changing the installed memory size.

For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" (�pg.126).

● Change the write type of the debugging information 
(For Windows Server 2003 or Windows 2000 Server) 

If the memory dump cannot be collected, select a write type of debugging information within the range 

of free space of the volume size.

If the above does not provide a solution, try increasing the size of the hard disk or adding an additional 

hard disk.

■ Restore the System

In the unfortunate event where the system file, system configuration, or environment changes during 

startup are corrupted, use the repair information stored on the recovery disk created at the installation to 

restore the system.

For restoration procedures, refer to the following:

• "9.6.1 For Windows Server 2003" (�pg.251)

• "9.6.2 For Windows 2000 Server" (�pg.252)
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■ Fails in Remote Installation

If remote installation fails, check the following.

● Checking Services

Check that the DHCP, PXE Service, and TFTP Service are running.

For checking procedures, refer to "3.4 Remote Installation" (�pg.85).

● Setting TFTP

To access TFTP Service, add a Guest account to the TFTP folder and set appropriate access rights.

For setting procedures, refer to "3.4 Remote Installation" (�pg.85).

● Checking Network Function Settings

The server must support network startup (PXE). 

For the setting procedures, refer to "●  Performing Remote Installation" (�pg.41) in "2.1.2 Hardware 

Settings" (�pg.41).

● Checking the MAC Address

Check that the current MAC address is the correct MAC address of the server.

For the MAC address checking procedure, refer to "●  Performing Remote Installation" (�pg.41) in 

"2.1.2 Hardware Settings" (�pg.41).

● Checking LAN Cable Connection

Check that the LAN cable is connected to the LAN card corresponding to the specified MAC address 

and that the LAN card is connected to the network.

■ An Error Occurs during Backup on Windows Server 2003

The following error messages may appear during backup by the OS's standard backup software on 

Windows Server 2003.

This error message may appear if you specify an onboard SCSI device as the destination of the backup 

file and if you make a backup copy using the OS's standard backup software on Windows Server 2003. 
If the message is displayed, get the Service Pack 1 or Hotfix (817688) from web site of Microsoft, and 

apply one of them.

The device reported an error on a request to write 

data to media.

Error reported: Invalid command. There may be a hard-

ware or media problem. 

Please check the system event log for relevant fail-

ures.
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■ SNMP Service Startup Fails

Regardless of whether the Simple Network Management Protocol (SNMP) is installed, if the SNMP 

service is not started, perform the following procedure to start the SNMP service.

● For Windows Server 2003

1 Click [Start] → [Administrative Tools] → [Computer Management].

2 Select [Services] from the [Services and Applications] menu.

3 From the details, select [SNMP Service].

4 Select [Start] from the [Action] menu.

● For Windows 2000 Server 

1 Right-click the [My Computer] icon on the desktop and click [Manage] from the 

displayed menu.

2 Select [Services] from the [Services and Applications] menu.

3 From the details, select [SNMP Service].

4 Select [Start] from the [Action] menu.

� To have the service automatically started each time the OS starts, double-click [SNMP Service] from 

the details, and select [Automatic] for the [Startup type] setting on the displayed window.

■ Time Display in Linux OS Environment

● Difference in Time between the OS and the Hardware Clock

During OS operation in a Linux environment, the software clock on the OS, rather than the hardware 

clock in the server, is used to display the time.

This may cause a difference in time between the OS and the hardware clock.

When you want to see the accurate time on the OS, it is recommended to use the NTP service to 

periodically correct the time displayed on the OS.
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● Changing the Time Settings for the OS and Hardware Clock

In a Linux environment, the time displayed on the OS (the software clock value on the OS) is written to 

the hardware clock on the server when the OS is shut down.

• Procedure for prohibiting the time on the OS from being written to the hardware clock

When you do not want the time on the OS to be written to the hardware clock at an OS shutdown, 

comment the following line out in /etc/rc0.d/S01halt.

runcmd $"Syncing hardware clock to system time" /sbin/hwclock $CLOCKFLAGS

→#runcmd $"Syncing hardware clock to system time" /sbin/hwclock $CLOCKFLAGS

• Procedure for reflecting the hardware clock value to the time on the OS

To reflect the hardware clock value to the software clock value on the OS, run the following 

command.

>hwclock --hctosys
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9.3  System Event Log

To operate system event log, use the [IPMI] submenu of the [Server] menu in BIOS 

Setup Utility and the Server Management Tools. 

� When the area for writing to the system event log is full, the server is set to automatically overwrite 

older event logs. For details on this setting, refer to "8.2.12 IPMI Submenu" (�pg.211) under the 

[Advanced] menu of the BIOS Setup Utility.

9.3.1  How to Use Server Management Tools

This section explains how to use Server Management Tools.

Server Management Tools can operate event logs stored in the Baseboard Management Controller 

(BMC: a micro-controller on the baseboard that manages temperature and voltage sensors).

Server Management Tools has the following functions.

• Viewing the system event log

• Displaying the system event log.

• Saving the system event log.

When a system event log occurs, save the log using Server Management Tools and contact an office 

listed in the "Contact Information" of "Start Guide".

� "Server Management Tools" disk is for this server only. Do not use those tools on other systems. If it is 

used, the system can be damaged.

� Run Server Management Tools when the server is operating in the procedure given in "■ Starting 

Server Management Tools" (�pg.239). Do not run Server Management Tools on the server started 

from the hard disk drive or by the other floppy disks. Otherwise, the system may be corrupted.

� Do not eject the floppy disk when the floppy disk access LED is on. Doing so may destroy the data on 

the floppy disk.

■ Starting Server Management Tools

� Before starting the system from the "Server Management Tools" disk, check to see that the "OS Boot 

Monitoring" function of ServerView is disabled (default setting). 

If the system is started with this function enabled, the server may automatically turn off or restart 

improperly.

If the "OS Boot Monitoring" function is needed, it should be reset to enabled before resuming normal 

server operation. For details of ServerView, refer to "ServerView User's Guide".
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1 Insert the "Server Management Tools" disk supplied with this server into the 

floppy disk drive.

The system will boot from the floppy disk and the DOS prompt is displayed.

2 Enter the following command and press the [Enter] key.

A:\SMT>IPMIVIEW.EXE

The menu window of Server Management Tools appears.

� Only the following functions are supported by Server Management Tools:

• System Event Log (SEL)

• User Management

• LAN Configuration

■ Exiting Server Management Tools

1 Press the [Esc] key once in the menu window of Server Management Tools.

The power can be turned off when the DOS prompt is displayed.

9.3.2 Viewing the System Event Log

Viewing the system event log is performed from System Event Log (SEL) of Server Management Tools.

1 Start Server Management Tools.

The menu window of Server Management Tools appears.

MS-DOS 6.2 Startup Menu
_______________________

1.Server Management Tool

3.Basic(RAIDUTIL)

4.Basic(Japanese Environment)

5.HDD firmware update

7.Server Management Tools for BX300

6.System Setup Utility(SSU) for N800

2.Basic(BIOS Environment Support Tools)
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2 Use the [↑] and [↓] keys to select [System Event Log (SEL)], and press the 
[Enter] key. 

The [SYSTEM EVENT LOG (SEL)] window appears. 

3 Use the following key operations to scroll the window and check the contents.

[↑], [↓], [←], [→], [PageUp], [PageDown], [Ctrl] + [Home], [Ctrl] + [End]

4 To exit the system event log, press the [Esc] key.

9.3.3 Saving/Deleting the System Event Log

When the system event log is full, the oldest log is overwritten with the newest log. Periodically check 

the system event log and save/delete as necessary.

■ Saving the System Event Log 

1 Start Server Management Tools.

The menu window of Server Management Tools appears.

2 Use the [↑] and [↓] keys to select [System Event Log (SEL)], and press the 
[Enter] key. 

The [SYSTEM EVENT LOG (SEL)] window appears. 

3 Press the [F2] key.

4 Enter the name of the file to save the system event log to, and press the [Enter] 

key.

The system event log is saved to the floppy disk under the specified file name.

004 MMM-DD-YYYY HH:MM:SS [*****] ****************************************
003 MMM-DD-YYYY HH:MM:SS [*****] ****************************************
002 MMM-DD-YYYY HH:MM:SS [*****] ****************************************
001 MMM-DD-YYYY HH:MM:SS [*****] ****************************************
000 MMM-DD-YYYY HH:MM:SS [*****] ****************************************

FUJITSU
 SIEMENS
  COMPUTERS

SYSTEM EVENT LOG (SEL)

<    ,PgUp/Dn,(Ctrl-)Home/End> Move  <F2> SaveToFile  <F3> Clear  <ESC> Exit
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■ Deleting the System Event Log

1 Start Server Management Tools.

The menu window of Server Management Tools appears.

2 Use the [↑] and [↓] keys to select [System Event Log (SEL)], and press the 
[Enter] key. 

The [SYSTEM EVENT LOG (SEL)] window appears. 

3 Press the [F3] key.

The confirmation window appears.

4 Press the [Enter] key.

This deletes the system event log.

� Selecting [System Event Log (SEL)] right after deleting the system event log will result in an error. 

Allow approximately 10 seconds to select it normally.

9.3.4 Before Using the Remote Control Service 

Perform the following procedures before using the Remote Control Service.

1 Check the following settings by starting the BIOS Setup Utility, and correct them 

if incorrect. 

• The [Peripheral Configuration] submenu of the [Advanced] menu

�"8.2.6 Peripheral Configuration Submenu" (pg.200)

• The [Console Redirection] submenu of the [Server] menu 

�"8.2.15 Console Redirection Submenu" (pg.214)

table: Setup on the Peripheral Configuration Submenu

Item Setting

Serial Enabled

Base I/O address 3F8/IRQ 4

Serial Multiplexer Shared

table: Setup on the Console Redirection submenu 

Item Setting

Console Redirection 

Port

Enabled

Baud Rate 115.2K

Media Type LAN

Protocol VT100+

Flow Control None

Mode Enhanced
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2 Start Server Management Tools.

3 Select [User Management] and press the [Enter] key.

The [USER MANAGEMENT] window appears. 

4 Set the password in [Administrator] for ID 3.

1. Select an [ID] and press the [Enter] key.

2. Specify the [User Name] and [Password] and set the [Operation] to [1] (Enable 

User).

3. Press the [F1] key to save the current settings.

5 Press the [Esc] key to return to the Server Management Tools [menu] window. 

6 Select [Channel Configuration].

7 Select [#2 802.3_LAN] and press the [Enter] key.

The [CHANNEL CONFIGURATION] window appears.

8 Press the [F1] key and set the followings in the [LAN CONFIGURATION] 

window.

9 Press the [F1] key to save the current settings.

table: LAN Setup in Channel Configuration Window

Item Setting

BMC-NIC Enter the IP address and MAC address of BMC-NIC. 
 The IP address must be the one assigned to LAN port 1 

by the OS on the server.

Subnet Mask Enter the subnet mask of the network. 

Default Gateway Enter the IP address and MAC address of the default 

gateway on the network.

ID --- USER NAME --- 
 1
 2 Operator
 3 Administrator
 4 OEM
 5 Remote
 6 admin

FUJITSU
 SIEMENS
  COMPUTERS

USER MANAGEMENT

<ENTER> Configure User   <F2> Configure User Access   <ESC> Exit
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9.4 Securities 

Security features are provided in order to protect the server hardware and software 

from theft. Additional security functions, which prevent unauthorized use, provided by 

the BIOS Setup Utility are also available to help maintain a highly reliable data 

security system.

9.4.1 Hardware Security

This section explains the hardware security features. 

Lock the rack door to protect the hardware in the rack from theft or tampering.

To close the rack door, shut the door and return the rack handle, and turn the rack key.

� Do not lose the rack key. If the key is lost, contact an office listed in the "Contact Information" of "Start 

Guide".

� For instructions on opening the rack door, refer to "1.4.1 Opening the Rack Door" (�pg.28).

� The above explanation is based on the 40U standard rack. For details on other rack systems, refer to 

their respective manuals.

Key hole

Rack key

Rack handle



245

PRIMERGY RX100 S2 User’s Guide    

9

O
p
e
ra
tio
n
 a
n
d
 M
a
in
te
n
a
n
c
e

9.4.2 Security against Unauthorized Use

A password can be set to prevent unauthorized use of the server.

When a password is set, the server is accessible only to the users who know the password.

The password is set in the BIOS Setup Utility. For details on the BIOS Setup Utility, refer to "8.2.10 

Security Menu" (�pg.207). 

■ Password Types 

The following two types of password can be set in this server.

The password types define the privileges of server operations.

● Setup Password (administrator password)

This is the password that allows specific people to access the BIOS setup. Unless the set password is 

entered, the BIOS Setup Utility and the OS cannot be started up.

● System Password (user password)

This is the password that allows specific people to use the server. Unless the set password is entered, part 

of the BIOS Setup Utility and the OS cannot be started up.

■ Setting a Password

1 Start the BIOS Setup Utility.

�"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.191)

2 Use the [←] [→] keys to select [Security] from the [Main] menu.

The [Security] menu appears.

3 Use the [↑] [↓] keys to move the cursor to [Set System Password] or [Set Setup 
Password], and press the [Enter] key.

The password entry window appears.

4 Enter the password (up to 6 characters) in the [Enter New Password] field.

5 In the [Confirm New Password] field, enter the password you have entered in 

Step 4 and press the [Enter] key.

[System Password] or [Setup Password] on the [Security] menu shows [Installed].

Set Setup(System) Password

Enter New Password   [    ]
Confirm New Password   [    ]
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� When only the user or administrator password is set, the same setting items are accessible to both 

users and administrators.

� When both passwords are set, users can set dates and user passwords only.

■ Changing/Deleting a Password

1 Enter the current password in the [Enter Current Password] field in the 

password entry window.

2 Enter a new password in the [Enter New Password] field.

To delete the password, enter nothing and perform Step 4.

3 In the [Confirm New Password] field, enter the password you have entered in 

Step 2.

To delete the password, enter nothing and perform Step 4.

4 Press the [Enter] key.

When you delete the password, [System Password] or [Setup Password] on the [Security] menu 

shows [Not installed].

� The system shuts down after three invalid password entries. If this happens, power off the server, turn 

it back on, and then enter the correct password.

� If you forget your password and cannot start the server, change the jumper pin setting on the 

baseboard to clear the CMOS and delete the password. After the CMOS has been cleared, return the 

BIOS Setup Utility to the original setting. Then, return the jumper pins to the original setting, and set 

the password using the utility.

�"8.1 Jumper Pin Settings" (pg.190)

Set Setup(System) Password

Enter Current Password   [     ]

Confirm New Password   [     ]

Enter New Password   [     ]
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9.4.3 Security When Disposing the Server

■ Notes regarding the Deletion of Data from the Hard Disk When 
Disposing or Transferring the Server

When disposing or transferring a server that has been used, the data in the hard disk may be read and 

used unscrupulously. To prevent confidential or important data from leaking out, the data on the hard 

disk must be wiped before disposing or transferring the server. 

However, wiping the hard disk is not an easy task. Simply initializing (formatting) the hard disk or 

deleting the files may give the pretense that the data no longer exists, but in reality the data is simply no 

longer accessible to the OS, and it is still accessible to malicious individuals that can restore the data. 

Therefore, if confidential or important data is saved to the hard disk, in addition to the operations 

mentioned above, it is recommended to use third-party tools or services to wipe the data completely 

from the disk to prevent its restoration. 

When disposing or transferring the server, it is the customers responsibility to wipe data contained in the 

hard disk in order to prevent such important data from leaking. 

Also, if software license agreements prohibit unauthorized distribution of software (OS or application 

software), transferring the server without removing the software may violate the license agreements. 

These issues must be taken into consideration.
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9.5 Backup

This server utilizes high reliability components and hard disks, however, as a 

precautionary measure, it is recommended that periodic backups be taken of the 

data.

9.5.1 Importance of Backups

If the data on the server is backed up, it can be restored from the backup data in the event of data 

corruption in hard disk units due to hardware failures or operational errors. If backups are not made, 

restoration is impossible and your important data will be lost permanently. For anxiety-free system 

operation, be sure to perform periodic backups of the system.

9.5.2 Backup Devices, Software and Their Operations 

A backup of data stored on the server is required for data restoration in the event of server trouble 

resulting in a system failure or accidental data loss due to operational errors. If the data on the server is 

backed up, it can be restored from the backup in the event of hardware failures or data corruption in hard 

disks due to operational errors. If backups are not made, restoration is impossible and data will be 

permanently lost. To prepare for unexpected problems, be sure to perform periodic backups of the 

system. 

• Backup device (e.g., DDS4 drive)

• Backup software

(Standard backup software supplied with the OS, e.g., ARCserve, Changer Option)

• Backup operations (schedules) 

Use our genuine backup devices and software. Observe the backup medium (tape) storage conditions.
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■ Notes on Operating Backups 

Notes on operating backups are as follows.

For details, refer to the device manuals.

● Head Cleaning

Airborne dust and dust from the magnetic media can collect on the head of the magnetic tape device. To 

remove this dust, head cleaning must be implemented. Implement head cleaning when the device 

displays a cleaning request. Particularly DDS devices require periodic head cleaning, otherwise dust can 

cling to the magnetic head, creating a situation that cannot be cleaned with standard head cleaning 

methods, and eventually render the device useless. 

Also note that the cleaning media has a limit on how many times it can be used. 

Using cleaning media that exceeded its lifespan will have no cleaning effect. Note these points 

especially when performing automatic backups with library devices.

● Managing Media Lifespans

Media is a consumable product that must be replaced regularly.

Continued use of media exceeding its lifespan can have negative effects on the device (e.g. increase the 

speed of dust accumulation). 

The lifespan of media varies depending on the environment and operation condition of the device, the 

type of backup software used, and other operation conditions, however, it is recommended that they be 

replaced sooner than later.

To manage the lifespan, write the use start date on the media. 

● Rotating Media

Rotate between several media for backups. 

When using a single media cartridge repeatedly, backup data can be temporarily lost in the event the 

backup fails. Or if the hard disk were to fail during a backup, the data will become unrecoverable.

● Avoid Leaving Media in Devices

Because the magnetic recording surface of the device is exposed, media can easily affected by airborne 

dust when left inserted for a long period of time. Insert the media before using it, and remove the media 

after use, and restore it in its case.

Also note that some tape devices write management information to the tape when ejecting the media. If 

the power were to go out when the media is still in the device, this writing process will not be performed 

and the media may become corrupted. 

To avoid this, remove the media from the device when turning off the server/device.

● Verifying Data after a Backup

Some backup software products provide data verification functions after a backup is completed. Such 

functions will read and verify the data written to the media after a backup is completed. This will 

increase the usage of the media, thus reducing the number of times it can be used for backups.

Depending on the hardware being used, some devices perform "read after write" operations on data; note 

the points of this section as necessary.
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● Ejecting Media after a Backup

Some backup software products provide functions for ejecting media after a backup is completed. Such 

functions will rewind the tape after a backup is completed and then eject the media from the drive.

Be sure to execute this function for autoloader/library devices. Depending on the structure of some 

servers, this function may cause the media to eject from an internal device of the server and hit the 

chassis door. If this is the case, open the door when ejecting, or do not eject the media. 

● Media Label Types and Positions

When writing information such as the name on media, use the label that came with the media. 

The area in which a label can be posted on the media of each device varies.

Failing to post labels in the designated area can damage the device.

● Data Storage

When storing data for long periods of time, store the media in a location least affected by temperature, 

humidity, and magnetic fields.
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9.6 Restoring the System

In the unfortunate event where the system file, system configuration, or environment 

changes during startup are corrupted, use the repair information stored on the 

recovery disk created at the installation to restore the system.

� Create a recovery disk when you have installed an OS or changed the system configuration. Refer to 

"5.2 Creating a Disk for System Recovery" (�pg.135).

9.6.1 For Windows Server 2003

● Items Required

• Windows Server 2003 CD-ROM

• Automated System Recovery (ASR) floppy disk (created beforehand)

• Backup media (created beforehand)

• Driver disk (for RAID cards or onboard SCSI)

For how to create driver disks, refer to "4.1 Creating Driver Disks" (�pg.108). 

• Windows Server 2003 First Step Guide

1 Follow "Windows Server 2003 First Step Guide" to start Windows Server 2003 

setup.

2 When a message prompting you to press the [F6] key appears immediately 

after the start of setup, press the [F6] key.

3 When a message prompting you to press the [F2] key appears, press the [F2] 

key.

A message prompting you to insert the ASR floppy disk appears.

4 Insert the ASR floppy disk and follow the window instructions.

5 The system restarts and a message appears. Press the [F6] key.

6 Follow the window instructions to restore the system.

Notes on Automated System Recovery 

� Automated System Recovery does not restore data files.
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9.6.2 For Windows 2000 Server 

● Items Required

• Windows 2000 Server CD-ROM

• Windows 2000 Server system recovery disk (created beforehand)

• Windows 2000 Server First Step Guide

1 Follow "Windows 2000 Server First Step Guide" to start Windows 2000 Server 

setup.

2 From the [Welcome to Setup] window of the Windows 2000 Server Setup 

program, press the [R] key to select restoration.

3 Follow the message on the setup window to restore the system.

Notes on system restoration 

� The system may return to the initial installation conditions depending on the restoration information 

used. In this case, the system must be configured after system restoration.

� Windows 2000 Server may have to be reinstalled if system files or system information are severely 

damaged. If this is the case, reinstall it. Refer to "9.7 Reinstalling the OS" (�pg.253).

� The message "The file ******.*** is not the original file copied when Windows 2000 was installed." 

appears during file restoration. Press the [Enter] or [A] key to restore the file.
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9.7 Reinstalling the OS

This section explains the procedure for reinstalling the OS.

9.7.1 Checking before OS Reinstallation

■ Removing the Optional Devices 

Remove the following optional devices before reinstallation. Install or connect them after OS 

installation.

• Optional SCSI devices (e.g., hard disk cabinet or DAT unit) connected via a SCSI card

• Internal hard disk units that do not contain the OS installation folder 

• USB devices

■ Deletion of Data from the Disc

Reinstallation deletes all disk contents. Save the necessary data and system configuration in a different 

location. 

■ Other Notes

Notes on initial installation also apply.

9.7.2 Reinstallation Using ServerStart

When the previous installation was performed in guide or preconfiguration mode, the ServerStart floppy 

disk used in that installation can be used again. When the reinstallation is performed with the same 

configuration as that for the previous installation, you do not have to edit the configuration file on the 

ServerStart floppy disk. You do not have to configure setting on wizards. After ServerStart starts up, 

click [Start (OS) Installation] to perform installation. 
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9.8 Changing OS Settings

When you have changed to enable or disable Hyper-Threading using the BIOS 

setting after starting operation, change the OS to the uni-processor kernel or multi-

processor kernel. 

� Customers using the Linux distribution OS are advised to refer to the Fujitsu PRIMERGY website 

(http://primergy.fujitsu.com). 

� For functions and settings of Hyper-Threading, refer to "8.2.8 Advanced System Configuration 

Submenu" (�pg.204).

9.8.1 For Windows Server 2003

After adding a CPU or changing the Hyper-Threading setting, starting up the OS changes OS settings. 

A pop-up message appears. Follow the window instructions. 

9.8.2 For Windows 2000 Server 

Change the OS settings according to the following procedures: If you have changed the OS settings from 

enable to disable, change the OS to the uni-processor kernel. If you have changed it from disable to 

enable, change the OS to the multi-processor kernel. 

1 Startup Windows 2000 Server. 

2 Start up Device Manager. 

1. Click [Start] → [Settings] → [Control Panel].

2. Double-click the [System] icon. 

3. Select the [Hardware] tab and click [Device Manager (D)...] of the [Device 

Manager].

The Device Manager starts.

3 Display computer properties. 

1. Select [Devices (by type)] from the [View] menu. 

2. Select [Computer] in the tree view and click [+] to expand it. 

3. Double-click the following item. 

• [ACPI uni-processor] to change the OS to the multi-processor kernel

• [ACPI multi-processor] to change the OS to the uni-processor kernel

4 Click the [Driver] tab and click [Update Driver (P)...]. 

The device driver upgrade wizard starts up. 

http://primergy.fujitsu.com
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5 Update drivers.

1. Click [Next] in the [Start Device Driver Upgrade Wizard] window.

The [Install Hardware Device Driver] window appears.

2. In search method selection, select [Display known drivers for this device and select 

a driver from the list.] and click [Next].

The [Select a Device Driver] window appears.

3. Select [Show all hardware of this device class]. From the [Manufacturers] list, 

select [(Standard computers)]. Select either of the following from [Models].

• [ACPI multi-processor PC] to change the OS to the multi-processor kernel

• [ACPI uni-processor PC] to change the OS to the uni-processor kernel

� If the wrong model is selected, the system does not operate properly. You must reinstall the OS                

in some cases. Take great care of changing the OS.

4. Click [Next].

The [Start Device Driver Installation] window appears. 

5. Click [Next].

Driver update starts. The [Finish] window appears when it completes. 

6. Click [Finish].

The [ACPI Multiprocessor PC Properties] window or [ACPI Uniprocessor PC Properties] 

window appears.
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6 Shut down and turn off the server.

1. Click [Close].

The [System Settings Change] window appears.

2. Click [Yes].

The computer shuts down and restarts automatically. 

7 Add an optional CPU or change the Hyper-Threading setting in the BIOS Setup 

Utility. 

�"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.191)

�"8.2.8 Advanced System Configuration Submenu" (pg.204)

8 Restart the system.

When the OS starts up, check that the item under [Computer] is changed in Device Manager of 

Control Panel.
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9.9 Maintenance Service

This section explains the details of the maintenance service. 
If the cause of the failure is uncertain or if the original condition cannot be restored,  
contact the seller or an office listed in the "Contact Information" of "Start Guide".

9.9.1 Maintenance Services

■ Maintenance Support Period

The maintenance support period is for five years after the purchase of the server.

■ Non-durable Components

Depending on the environment and usage of the customer, non-durable components of the server may 

need to be replaced during the maintenance support period.

Customers who have signed up to hardware maintenance contact will be provided with replacement 

parts free of charge and will have higher priority for replacement. Customers not signed up to hardware 

maintenance contact will be charged for operation cost (including the maintenance parts) separately.

Replacing non-durable components

� To ensure stable operation of the server system, it is recommended that a maintenance service 

agreement be purchased.

� Lifetime of Non-durable Components

The lifetime of such components is calculated based on appropriate usage environments.

Although the guaranteed range for operation is set between 10°C and 35°C, the lifetime is assumed at 

a constant average temperature of 25°C.

� Lifetime of Non-durable Components

With RAS Assist Service, a message reminding to replace certain parts can be set to appear in the 

panel or console of the server. Non-durable components are supposed to be replaced in the periodical 

maintenance performed after these messages appear.

They can be continuously used for approximately 1 year after the messages. However, note that it is 

necessary to immediately contact maintenance support if the messages appear prompting you to 

change UPS batteries.
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9.9.2 Contacting Maintenance Support

For "Contact Information", refer to "Start Guide". Before contacting maintenance support, check the 

following.

• Model name and product ID of the server

They are described on the label on the server. For the label location, refer to "Start Guide" 

• Hardware configuration (Types and locations of internal options) 

• Configuration information (BIOS Setup Utility, SCSI Setup Utility settings)

• OS

• LAN/WAN system configuration

• Phenomena (what happened when doing what, what was displayed, etc.)

• Date/time of occurrence

• Environmental settings of the server

• LED statuses

� Print and fill in the "Configuration Sheet" of "Configuration Sheets" and the "Accident Sheet".
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This section explains the specifications for the 

server and internal options. It also covers how to 
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A Server Specifications

This section explains the server and internal option specifications. 

A.1 Diskless type

*1: A low profile PCI card can be inserted into the standard PCI slot if the extension slot cover is installed.

The specifications for the server are subject to change for the purpose of improvement without prior notice. 

table: Server Specifications

Item Functions and Specifications

Model PGUR1023A

CPU

Frequency/

Cache

Intel® Celeron® D Processor 330 (2.66GHz/256KB)

(If the basic CPU conversion kit is used: Intel® Pentium® 4 Processor 3EGHz/1MB)

Number of 

multiplication
1 (Max. 1)

Memory

Standard 256MB (256MB DIMM × 1)
Adding size 256MB, 512MB, 1GB

Maximum 

capacity
4GB (4-slot, 1GB DIMM ×  4)

Video RAM capacity 8MB

Graphics

VGA chip: ATI Rage XL

648 × 480, 800 × 600, 1024 × 768, 1280 × 1024 
Display colors: Differ depending on resolution and OS.

Internal CD-ROM Bay 1 bay (optional); Type: 24x IDE CD-ROM unit (IDE) 

3.5-inch storage bay 2 bays

Standard Optional 

Adding size
73GB/147GB

 (10,000rpm, Ultra320 SCSI)

Maximum 293.6GB (146.8GB × 2)
Disk array Optional 

Expansion slots PCI × 2 (64bit/66MHz) One slot is for a LowProfile PCI card only. *1

Floppy disk drive 3.5-inch (2-mode, 1.44MB/720KB) (Standard)

Network 

LAN (1000BASE-T/100BASE-TX/10BASE-T) × 1 (CSA)
LAN (1000BASE-T/100BASE-TX/10BASE-T) × 1 (PCI)

(With a standard baseboard)

Interface Serial port × 1, keyboard, mouse, monitor, USB × 3 
Keyboard and Mouse Optional 

Dimension (mm) 
Width 429 (482) × Depth 562 (596) × Height 42 (1U unit) 
The dimensions with a protrusion is shown in parentheses.

Weight Max. 13kg

Internal clock precision ±2 to 3 minutes/month

Power consumption Max. 260W (Max. 936kJ/h)

Power 100–240V AC (50/60Hz) / bipolar ground type

Power supply Standard: 1; Max.: 1 (without redundant power supply)

Fan 8 (system fan × 6, power supply fan × 2: without redundant fans)

OS
Windows Server 2003, Standard Edition / Windows 2000 Server /

 Red Hat Enterprise Linux ES (v.3 for x86)
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B Specifications for Internal 
Options

This section explains the specifications for internal options for the server.  
When you have bought an internal option as a standard option, check the contents of 

the optional package before use. Should it happen that items are missing, contact an 

office listed in the "Contact Information" of "Start Guide".

B.1 Memory Specifications

■ Package

• RAM module (1)

■ Specifications

table: Memory Specifications

Item Functions and Specifications

Product name Memory Module-256MB Memory Module-512MB Memory Module-1GB

Model PG-RM25AD PG-RM51AD PG-RM1AD

Modules 256MB DIMM × 1 512MB DIMM × 1 1GB-DIMM × 1
Capacity 256MB 512MB 1GB

Clock 
Frequency

400 MHz

Number of pins 184 pins
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B.2 Internal CD-ROM Drive Unit Specifications

■ Package

• Internal CD-ROM Drive Unit (1)

■ Specifications

B.3 Internal Hard Disk Unit Specifications

■ Package

• Internal hard disk unit (1)

• 4 setscrews

■ Specifications

*1: Switched automatically according to the SCSI environment.

*2: The value indicates memory capacity of the formatted hard disk (1GB = 10003 bytes).

table: CD-ROM Drive Unit Specifications

Item Functions and Specifications

Model PG-CD320

Interface IDE (ATAPI)

Supported Media CD-ROM disk (12 cm)

Applicable Standards CD-ROM

Reading mechanism Optical pickup using a laser diode

Data transfer speed Max. 3,600KB/sec (24× on the outside to 10× on the inside)
Access Time 115msec (average)

Disk loading mechanism Manual tray loading

Disk clamp mechanism Ball clamp

Dimension (drive only) 128.4 × 129.9 × 13.2mm (W × D × H)
Weight (excluding a medium) About 170g

table: Internal Hard Disk Unit Specifications

Item Functions and Specifications

Model PG-HD7G1T PG-HD4G1T

Interface Ultra 320 SCSI *1

Storage media 3.5-inch hard disk

Memory capacity *2 73.4GB 146.8GB

Maximum data transfer rate 320MB/s (Ultra320)

Average latency speed 2.99ms

Rpm 10,000rpm

Dimensions 101.6 × 146.0 × 25.4 (mm)

Weight 0.75 kg
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B.4 Power Cord Selection

The power cord for this unit has been packed separately and has been selected according to the country 

of destination. It must be used to prevent electric shock. Use the following guidelines if it is necessary to 

replace the original cord set.

The female receptacle of the cord set must meet CEE-22 requirements (see Figure).

■ For the United States and Canada

Use a UL listed and CSA labeled cord set consisting of a three conductor cord with a maximum length 

of 15 feet. 
For units which stand on a desk or table, type SVT or SJT cord sets should be used. 
For units which stand on the floor, only SJT type cord sets should be used. 
The cord set must be selected according to the current rating for your unit. 
Please consult the table below for the selection criteria for power cords used in the United States and 

Canada.

● For units set at 230 V (outside of the United States and Canada):

Use a cord set consisting of a minimum AWG according to the table above and a grounding type 

attachment plug rated 15 A, 250 V. The cord set should have the appropriate safety approvals for the 

country in which the equipment will be installed and should be marked HAR.

table: Selection Criteria for Power Cords Used in the United States and Canada

Cord Type Size of Conductors in Cord Maximum Current Rating of Unit

SJT 18 AWG

16 AWG

14 AWG

10 Amps

12 Amps

12 Amps

SVT 18 AWG

17 AWG

10 Amps

12 Amps

• Parallel

For units set at 115 V: 
use a parallel blade, grounding type  
attachment plug rated 15 A, 125 V.

• Tandem

For units set at 230 V: 
use a tandem blade, grounding type  
attachment plug rated 15 A, 250 V.
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■ For the United Kingdom

Should the plug on the flexible cord not be of the type for your socket outlets, do not use an adapter but 

remove the plug from the cord and discard. Carefully prepare the end of the supply cord and fit a suitable 

plug.

� The wires in this mains lead are colored in accordance with the following code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live

As the colors of the wires in the mains lead of this appliance may not correspond with the colored 

markings identifying the terminals in your plug, proceed as follows.

• The wire which is colored Green and Yellow must be connected to the terminal in the plug which is 

marked with the letter E or by the earth symbol or colored Green or Green and Yellow.

• The wire which is colored Blue must be connected to the terminal which is marked with the letter N 

or colored Black.

• The wire which is colored Brown must be connected to the terminal which is marked with the letter L 

or colored Red.

• This appliance must be earthed. 
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C Remote Control Function and 

Console Redirection

When a personal computer (PC) is connected to the serial port of this server with a 

cross cable, the server can be turned on/off or reset from the PC via RS-232C 

(remote control function). Console redirection can be performed in the same manner.

The remote control and console redirection functions can be switched between each other.

Perform the following procedures to use these two functions.

• Connecting the Server to a PC

• Setting the server using the Remote Control Utility

� To use the reset function via RS-232C, the terminal software on the PC must have the same 

communication speed and flow control mode settings as those on the Remote Control Utility.

� When both remote control function and BIOS console redirection are used, perform the following 

procedures in the BIOS Setup Utility.

• On the [Peripheral Configuration] submenu of the [Advanced] menu, change [Serial Multiplexer] to 

[Shared].

�"8.2.6 Peripheral Configuration Submenu" (pg.200)

• On the [Console Redirection] submenu of the [Server] menu, change [Console Redirection Port] to 

[Enabled].

�"8.2.15 Console Redirection Submenu" (pg.214)

C.1 Key Operations for Console Redirection 

During POST, the following keys can be used for console redirection on the server.

table: Key Operations for Console Redirection 

Key Function 

[F1] Start up the server via the network. 

[F3] Displays the Boot menu.

[F4] Start the BIOS Setup Utility.

[Esc] Skips memory tests during POST.
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C.2 Connecting the Server to a PC

Connect the server to a PC using a cross cable.

� In the BIOS Setup Utility, perform the following setting.

• On the [Peripheral Configuration] submenu of the [Advanced] menu, change [Serial Multiplexer] to 

[BMC].

�"8.2.6 Peripheral Configuration Submenu" (pg.200)

C.3 Operating the Remote Control Utility

The following explains how to operate the Remote Control Utility.

■ Connection

1 Connect the serial port connector 1 to the management terminal using an RS-

232C cross cable.

2 Establish connection using the terminal software.

■ Operation on the Server

Perform the following operation in the terminal software on the management terminal.

1 Establish connection using the terminal software and press the [Enter] key.

The following message appears.

Login>

Serial portServer (Rear)

Personal computer
Cross cable

Serial port
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2 Enter the following command.

Remote [Enter]

The following message appears.

3 Enter the following command.

Remote [Enter]

The following menu appears.

The "State" line in the message will show either of the following.

4 Use numeric keys to enter the desired menu number.

The table below shows the menu items and corresponding operations. Unavailable menu items 

are indicated with "na" in parentheses to the left of the items.

Password>

table: Messages in the Main Menu Window

Message Status 

On The server is turned on.

Off The server is turned off.

table: Menu Items and Operations

Menu Operation Operation after selecting the item

(1) Immediate 

Power Down

The server will be turned off. When the "Do you really want to do this? [y/n]" 

appears, enter the following command.

y [Enter] 
(2) Immediate Reset The server will be restarted.

(3) Graceful Power 

Down

The server will be turned off.

When Windows is running, 

the server is turned off after 

the OS is shut down.

When the "Do you really want to do this? [y/n]" 

appears, enter the following command.

 y [Enter] 

When Windows is running, "System shutdown 

due to <software command> in 60 second! Press 

Cancel to abort!" appears in the popup window. 

Select [OK].

(4) Power Cycle The server will be restarted.

When Windows is running, 

the server is restarted after the 

OS is shut down.

REMOTE MAINTENANCE MENU
(1) Immediate Power Down
(2) Immediate Reset
(3) Graceful Power Down
(4) Power Cycle
(5) Power On
(6) View System Eventlog (SEL)

Enter selection or (0) to quit:

*******************************************
Welcome to System RX100 S2
BMC FW: *.**    SDRR: *.**
State: Off (na = Currently not available)
*******************************************
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C.4 Switching between Functions

This section explains how to switching between functions.

■ Switching from Console Redirection to the Remote Control Function

1 In the terminal software executing console redirection, press the [Esc] key and 

press the [Shift] + [8] keys.

Console redirection switches to the remote control function.

For operation of the Remote Control Utility, refer to "C.3 Operating the Remote Control Utility" 

(�pg.266).

■ Switching from the Remote Control Function to Console Redirection

1 Exit the Remote Control Utility.

Select [0] from the menu of the Remote Control Utility.

The following message appears.

2 Press the [Enter] key, then the [Shift] + [Q] keys.

The terminal software window changes to the console redirection window.

(5) Power On The server will be turned on.  -

(6) View System 

Event log (SEL)

The event log will be 

displayed.

 -

(0)  - The menu closes.

Login>

table: Menu Items and Operations

Menu Operation Operation after selecting the item
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D Recycling

This section explains how to recycle this server.

■ Disposing of the Server

When scrapping this server, contact an office listed in the "Contact Information" of the "Start Guide". 

This server must be disposed of as industrial waste. 

Furthermore, if the server is disposed of as it is, someone else may gain access to the information 

contained on the hard disks. It is therefore recommended that all drives be formatted before disposal. 

However, just formatting or deleting files may not avoid the risk that the data is restored and used for 

wrongful purposes. If confidential or private information is saved, in order to make it impossible to be 

restored, it is recommended to use third-party data wiping tools. 

■ Disposing of Used-up Batteries

Used-up batteries must be disposed of as industrial waste and therefore require special processing. Let a 

licensed industrial waste disposal company take care of disposing them.

■ Disposing of Liquid Crystal Displays

Liquid crystal displays must be disposed of as industrial waste and therefore require special processing. 

Let a licensed industrial waste disposal company take care of disposing them.
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